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Preface

This document provides design and deployment guidelines for the deployment of secure enterprise, campus,
and metropolitan Wi-Fi networks within the Cisco wireless mesh networking solution, a component of the
Cisco Unified Wireless Network (CUWN).

Mesh networking employs Cisco Aironet 1500 Series outdoor mesh access points and indoor mesh access
points (Cisco Aironet 1700, 2600, 2700, 3500, 3600 and 3700 series access points) along with the Cisco
Wireless LAN Controller, and Cisco Prime Infrastructure to provide scalable, central management, and mobility
between indoor and outdoor deployments. Control and Provisioning of Wireless Access Points (CAPWAP)
protocol manages the connection of mesh access points to the network.

End-to-end security within the mesh network is- supported by employing Advanced Encryption Standard
(AES) encryption between the wireless mesh access points and Wi-Fi Protected Access 2 (WPA2) clients.
This document also outlines radio frequency (RF) components to consider when designing an outdoor network.

The features described in this document are for the following products:

* Cisco Aironet 1570 (1572) series outdoor mesh access points

* Cisco Aironet 1560 (1562) series outdoor mesh access points

* Cisco Aironet 1540 (1542) Series outdoor mesh access points

* Cisco Aironet 1550 (1552) series outdoor mesh access points

* Cisco Aironet 1530 series outdoor mesh access points

* Cisco Aironet 1600, 2600, 3600, 3500, 1700, 2700 and 3700 series indoor mesh access points
* Mesh features in Cisco Wireless LAN Controller

* Mesh features in Cisco Prime Infrastructure

This chapter contains the following sections:

* Audience, on page xii

* Organization, on page Xii

 Conventions, on page Xii

* Related Documentation, on page xv

* Obtaining Documentation and Submitting a Service Request, on page xv
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Audience

Organization

Preface |

This document is for experienced network administrators who design and deploy mesh networks and configure
and maintain Cisco mesh access points and Cisco wireless LAN controllers.

This guide is organized into these chapters:

Chapter Title

Description

Mesh Network Components

This chapter describes the components of a mesh network.

Mesh Deployment Modes

This chapter describes the various deployment modes of mesh access points.

Design Considerations

This chapter describes the design considerations involved in a mesh network.

Air Time Fairness in Mesh
Deployments rel 8.4

This chapter describes the air time fairness in mesh deployments.

Site Preparation and Planning

This chapter describes the implementation details and configuration
examples.

Connecting the Cisco 1500
Series Mesh Access Points to
the Network

This chapter describes the procedures involved in connecting mesh access
points to a network and configuring the mesh access points.

Checking the Health of the
Network

This chapter describes the commands to enter to check the health of a mesh
network.

Troubleshooting

This chapter describes the troubleshooting information.

Managing Mesh Access Points
with Cisco Prime Infrastructure

This chapter describes information about managing access points with Cisco
Prime Infrastructure.

Conventions

This document uses the following conventions:

Convention

Indication

bold font

Commands and keywords and user-entered text appear in bold font.

italic font

Document titles, new or emphasized terms, and arguments for which you supply
values are in italic font.

[] Elements in square brackets are optional.

xlylz}

Required alternative keywords are grouped in braces and separated by vertical
bars.

[x|ylz]

Optional alternative keywords are grouped in brackets and separated by vertical
bars.

. Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8
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Convention

Indication

string

A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.

courier font

Terminal sessions and information the system displays appear in courier font.

<> Nonprinting characters such as passwords are in angle brackets.
[ Default responses to system prompts are in square brackets.
L# An exclamation point (!) or a pound sign (#) at the beginning of a line of code

indicates a comment line.

Note Means reader take note.
Tip Means the following information will help you solve a problem.
Caution Means reader be careful. In this situation, you might perform an action that could result in equipment damage

A

or loss of data.

Warning

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you work
on any equipment, be aware of the hazards involved with electrical circuitry and be familiar with standard

practices for preventing accidents. (To see translations of the warnings that appear in this publication, refer
to the appendix "Translated Safety Warnings.")

Warning Title

Description

Waarschuwing

Dit waarschuwingssymbool betekent gevaar. U verkeert in een situatie die
lichamelijk letsel kan veroorzaken. Voordat u aan enige apparatuur gaat werken,
dient u zich bewust te zijn van de bij elektrische schakelingen betrokken risico's
en dient u op de hoogte te zijn van standaard maatregelen om ongelukken te
voorkomen. (Voor vertalingen van de waarschuwingen die in deze publicatie
verschijnen, kunt u het aanhangsel "Translated Safety Warnings" (Vertalingen
van veiligheidsvoorschriften) raadplegen.)

Varoitus

Tama varoitusmerkki merkitsee vaaraa. Olet tilanteessa, joka voi johtaa
ruumiinvammaan. Ennen kuin ty6skentelet mink&én laitteiston parissa, ota selvda
sdahkokytkentoihin liittyvistd vaaroista ja tavanomaisista onnettomuuksien
ehkaisykeinoista. (Téssé julkaisussa esiintyvien varoitusten kdannokset 16ydét
liitteestd "Translated Safety Warnings" (kddnnetyt turvallisuutta koskevat
varoitukset).)

Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8 .
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Warning Title

Description

Attention

Ce symbole d'avertissement indique un danger. Vous vous trouvez dans une
situation pouvant entrainer des blessures. Avant d'accéder a cet équipement, soyez
conscient des dangers posés par les circuits électriques et familiarisez-vous avec
les procédures courantes de prévention des accidents. Pour obtenir les traductions
des mises en garde figurant dans cette publication, veuillez consulter I'annexe
intitulée « Translated Safety Warnings » (Traduction des avis de sécurité).

Warnung

Dieses Warnsymbol bedeutet Gefahr. Sie befinden sich in einer Situation, die zu
einer Korperverletzung fiihren konnte. Bevor Sie mit der Arbeit an irgendeinem
Gerit beginnen, seien Sie sich der mit elektrischen Stromkreisen verbundenen
Gefahren und der Standardpraktiken zur Vermeidung von Unfillen bewult.
(Ubersetzungen der in dieser Verdffentlichung enthaltenen Warnhinweise finden
Sie im Anhang mit dem Titel "Translated Safety Warnings" (Ubersetzung der
Warnhinweise).)

Avvertenza

Questo simbolo di avvertenza indica un pericolo. Si ¢ in una situazione che puo
causare infortuni. Prima di lavorare su qualsiasi apparecchiatura, occorre conoscere
i pericoli relativi ai circuiti elettrici ed essere al corrente delle pratiche standard
per la prevenzione di incidenti. La traduzione delle avvertenze riportate in questa
pubblicazione si trova nell'appendice, "Translated Safety Warnings" (Traduzione
delle avvertenze di sicurezza).

Advarsel

Dette varselsymbolet betyr fare. Du befinner deg i en situasjon som kan fore til
personskade. For du utferer arbeid pé utstyr, ma du vaere oppmerksom pa de
faremomentene som elektriske kretser innebzrer, samt gjore deg kjent med vanlig
praksis nar det gjelder & unngé ulykker. (Hvis du vil se oversettelser av de
advarslene som finnes i denne publikasjonen, kan du se 1 vedlegget "Translated
Safety Warnings" [Oversatte sikkerhetsadvarsler].)

Aviso

Este simbolo de aviso indica perigo. Encontra-se numa situagdo que lhe podera
causar danos fisicos. Antes de comecar a trabalhar com qualquer equipamento,
familiarize-se com os perigos relacionados com circuitos eléctricos, e com
quaisquer praticas comuns que possam prevenir possiveis acidentes. (Para ver as
tradugdes dos avisos que constam desta publicag@o, consulte o apéndice
"Translated Safety Warnings" - "Tradug¢des dos Avisos de Seguranga").

jAdvertencia!

Este simbolo de aviso significa peligro. Existe riesgo para su integridad fisica.
Antes de manipular cualquier equipo, considerar los riesgos que entrafia la
corriente eléctrica y familiarizarse con los procedimientos estandar de prevencion
de accidentes. (Para ver traducciones de las advertencias que aparecen en esta
publicacion, consultar el apéndice titulado "Translated Safety Warnings.")

Varning

Denna varningssymbol signalerar fara. Du befinner dig i en situation som kan
leda till personskada. Innan du utfor arbete pa ndgon utrustning méste du vara
medveten om farorna med elkretsar och kénna till vanligt forfarande for att
forebygga skador. (Se forklaringar av de varningar som férekommer i denna
publikation i appendix "Translated Safety Warnings" [Oversatta
sdkerhetsvarningar].)
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Related Documentation

These documents provide complete information about the Cisco Unified Wireless Network solution:
* Cisco Wireless LAN Controller Configuration Guide
* Cisco Wireless LAN Controller Command Reference
* Cisco Prime Infrastructure Configuration Guide

* Release Notes for Cisco Wireless LAN Controllers and Lightweight Access Points

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information,
see the monthly What's New in Cisco Product Documentation, which also lists all new and revised Cisco
technical documentation, at:

Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS version 2.0.

Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8 .
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CHAPTER 1

Mesh Network Components

This chapter describes the mesh network components.
The Cisco wireless mesh network has four core components:

* Cisco Aironet series access points

A

Note Cisco Aironet 1520 series mesh access points are not supported because of their
End-of-Life status.

* Cisco Wireless LAN Controller (hereafter referred to as controller)
* Cisco Prime Infrastructure

» Mesh software architecture

This chapter contains the following sections:

* Mesh Access Points, on page 1

* Cisco Wireless LAN Controllers, on page 9
* Cisco Prime Infrastructure, on page 10

* Architecture, on page 10

Mesh Access Points

Licensing for Mesh Access Points on a 5508, 3504 5520 and 8540 Series Cisco
Comptroller

To use both mesh and non-mesh access points with a Cisco 3504, 5500 and 8500 Series Controller, only the
base license is required from the 7.0 release and later releases. For more information about obtaining and
installing licenses, see the Cisco Wireless LAN Controller Configuration Guide at http://www.cisco.com/en/
US/products/ps10315/products_installation and configuration guides_list.html.
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Access Point Roles

N

Access points within a mesh network operate in one of the following two ways:

1. Root access point (RAP)
2. Mesh access point (MAP)
3. Mesh Leaf Node

In rel 8.6 Mesh Leaf Node Mode added

Support is added to configure IOS based mesh APs with lower performance to work only as a leaf node or
basically be the last one in the tree, to prevent the wireless backhaul performance from being downgraded.

CISCO MONITOR  WIANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Wireless All APs > Details for AP1542.F116.1CE8
il o | General | Credentials | Interfaces | High Availability | Inventory | Mesh | Advanced
+ Radios
e | o e
Dual-Band Radios Bridge Type Outdoor
Global Configuration Bridge Group Name tme
b Advanced Strict Matching BGN
Mesh Ethernet Bridging
¥ ATF Preferred Parent _.DD:Gb:fl:ls:ld:.bG
RF Profiles Backhaul Interface 802.11a/nfac
FlexConnect Groups Bridge Data Rate (Mbps) | auto v
FEexConnect ACLs Ethernet Link Status up
FlexConnect VLAN
Templates PSK Key TimeStamp Tue Aug 2 16:33:42 2016 Delete PSK | 2
OEAP ACLs

et Bt | Block Child o

¥ an?.1l1a/n/ac

Note

All access points are configured and shipped as mesh access points. To use an access point as a root access
point, you must reconfigure the mesh access point to a root access point. In all mesh networks, ensure that
there is at least one root access point.

While the RAPs have wired connections to their controller, the MAPs have wireless connections to their
controller.

MAPs communicate among themselves and back to the RAP using wireless connections over the 802.11a/n
radio backhaul. MAPs use the Cisco Adaptive Wireless Path Protocol (AWPP) to determine the best path
through the other mesh access points to the controller.

Bridge mode access points support CleanAir in mesh backhaul at SGHz frequency and provides only the
interference device report (IDR) and Air Quality Index (AQI)reports.

Note

The RAP or MAP does not generate Bridge Protocol Data Unit (BPDU) itself. However, the RAP or MAP
forwards the BPDU to upstream devices if the RAP or MAP received the BPDU from its connected wired or
wireless interface across the network.
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A

Caution We recommend that you do not deploy RAPs and MAPs belonging to different domains on the same mesh
tree.

Figure 1: Simple Mesh Network Hierarchy

This figure shows the relationship between RAPs and MAPs in a mesh network.

AT b
oo0oD | ARG GeE nonn "‘..f‘. g
MAP 7 MAP & MAPS =

Network Access

Wireless mesh networks can simultaneously carry two different traffic types. They are as follows:

* Wireless LAN client traffic

* MAP Ethernet port traffic
Wireless LAN client traffic terminates on the controller, and the Ethernet traffic terminates on the Ethernet
ports of the mesh access points.
Access to the wireless LAN mesh for mesh access points is managed by the following authentication methods:

* MAC authentication—Mesh access points are added to a database that can be referenced to ensure they
are provided access to a given controller and mesh network.

» External RADIUS Authentication—Mesh access points can be externally authorized using a RADIUS
server such as Cisco ACS (4.1 and later) and ISE that supports the client authentication type of Extensible
Authentication Protocol-FAST (EAP-FAST) with certificates and and WPA2/PSK on the WLCs.

Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8 .
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Network Segmentation

Membership to the wireless LAN mesh network for mesh access points is controlled by the bridge group
names (BGNs). Mesh access points can be placed in similar bridge groups to manage membership or provide
network segmentation.

Cisco Indoor Mesh Access Points
The following access point platforms are supported in this release:
* Cisco Aironet 1600 Series Access Points
* Cisco Aironet 1700 Series Access Points
* Cisco Aironet 2600 Series Access Points
* Cisco Aironet 2700 Series Access Points
* Cisco Aironet 3500 Series Access Points
* Cisco Aironet 3600 Series Access Points
* Cisco Aironet 3700 Series Access Points
* Cisco Aironet 1530 Series Access Points
* Cisco Aironet 1540 Series Access Points
* Cisco Aironet 1550 Series Access Points
* Cisco Aironet 1560 Series Access Points
* Cisco Aironet 1570 Series Access Points

* Cisco Industrial Wireless 3700 Series Access Points

N

Note In 8.5 release the following AP s will be supported.

\)

Note For more information about controller software support for access points, see the Cisco Wireless Solutions
Software Compatibility Matrix at http://www.cisco.com/en/US/docs/wireless/controller/5500/tech_notes/
Wireless Software Compatibility Matrix.html.

Enterprise 11n/ac mesh is an enhancement added to the CUWN feature to work with the 802.11n/ac access
points. Enterprise 11ac mesh features are compatible with non-802.11ac mesh but adds higher backhaul and
client access speeds. The 802.11ac indoor access points are two-radio Wi-Fi infrastructure devices for select
indoor deployments. One radio can be used for local (client) access for the access point and the other radio
can be configured for wireless backhaul. If Universal Backhaul Access is enabled, the 5-GHz and 2.4-GHz
radios in rel 8.2 can be used for local (client) access as well as a backhaul. Enterprise 11ac mesh supports
P2P, P2MP, and mesh types of architectures.
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You have a choice of ordering indoor access points directly into the bridge mode, so that these access points
can be used directly as mesh access points. If you have these access points in a local mode (non-mesh), then
you have to connect these access points to the controller and change the AP mode to the bridge mode (mesh).
This scenario can become cumbersome particularly if the volume of the access points being deployed is large
and if the access points are already deployed in the local mode for a traditional non-mesh wireless coverage.

The Cisco indoor mesh access points are equipped with the following two simultaneously operating radios:

* From rel 8.2 2.4 GHz radio used for data backhaul and client access if UBA is enable

* 5-GHz radio used for data backhaul and client access if Universal Backhaul Access is enabled

The 5-GHz radio supports the 5.15 GHz, 5.25 GHz, 5.47 GHz, and 5.8 GHz bands.

Cisco OQutdoor Mesh Access Points

Cisco outdoor mesh access points comprise of the Cisco Aironet 1500 series access points. The 1500 series
includes 1572 11ac outdoor access points, 1552 and 1532 11n outdoor mesh access points, and the newer
1540 and 1560 11ac wave 2 series..

Cisco 1500 series mesh access points are the core components of the wireless mesh deployment. AP1500s
are configured by both the controller (GUI and CLI) and Cisco Prime Infrastructure. Communication between
outdoor mesh access points (MAPs and RAPs) is over the 802.11a/n/ac radio backhaul. Client traffic is
generally transmitted over the 802.11b/g/n radio (802.11a/n/ac can also be configured to accept client traffic).

The mesh access point can also operate as a relay node for other access points not directly connected to a
wired network. Intelligent wireless routing is provided by the Adaptive Wireless Path Protocol (AWPP). This
Cisco protocol enables each mesh access point to identify its neighbors and intelligently choose the optimal
path to the wired network by calculating the cost of each path in terms9 of the signal strength and the number
of hops required to get to a controller.

Uplinks support includes Gigabit Ethernet (1000BASE-T) and a small form-factor (SFP) slot that can be
plugged for a fiber or cable modem interface. Both single mode and multimode SFPs up to 1000BASE-BX
are supported. The cable modem can be DOCSIS 2.0 or DOCSIS/EuroDOCSIS 3.0 depending upon the type
of mesh access point.

AP1550s are available in a hazardous location hardware enclosure. When configured, the AP1500 complies
with safety standards for Class I, Division 2, Zone 2 hazardous locations.

The mesh access points, can operate, apart from the mesh mode, in the following modes:

* Local mode—In this mode, the AP can handle clients on its assigned channel or while monitoring all
channels on the band over a 180-second period. During this time, the AP listens on each channel for 50
milliseconds for rogue client beacons, noise floor measurements, interference, and IDS events. The AP
also scans for CleanAir interference on the channel.

* FlexConnect mode—FlexConnect is a wireless solution for branch office and remote office deployments.
The FlexConnect mode enables you to configure and control access points in a branch or remote office
from the corporate office through a WAN link without having to deploy a controller in each office. The
FlexConnect mode can switch client data traffic locally and perform client authentication locally when
the connection to the controller is lost. When connected to the controller, the FlexConnect mode can also
tunnel traffic back to the controller.

* Flex+Bridge Mode—In this mode, both the Flexconnect and Bridge mode configuration options are
available on the access point.
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* Monitor mode—In this mode, the AP radios are in the receive state. The AP scans all the channels every
12 seconds for rogue client beacons, noise floor measurements, interference, IDS events, and CleanAir
intruders.

* Rogue Detector mode—In this mode, the AP radio is turned off, and the AP listens only to the wired
traffic. The controller passes the APs that are configured as rogue detectors as well as lists of suspected
rogue clients and AP MAC addresses. The rogue detector listens for ARP packets and can be connected
to all broadcast domains through a trunk link.

* Sniffer mode—In this mode, the AP captures and forwards all packets on a channel to a remote device
that decodes the packets with packet analyzer software such as Wireshark.

* Bridge mode—In this mode, the AP is configured to build a wireless mesh network where wired network
cabling is not available.

Note

You can configure these modes using both the GUI and CLI. For configuration instructions, see the Cisco
Wireless LAN Controller Configuration Guide.

MAPs can only be configured in Bridge / Flex+Bridge mode regardless of their wired or wireless backhaul.
If the MAPs have a wired backhaul, you must change their AP role to RAP before you change the AP Mode.

Note

For complete details and specification of all models of outdoor Mesh AP please visit this link below:

* https://www.cisco.com/c/en/us/products/wireless/outdoor-wireless/index.html?stickynav=1

Frequency Bands

Both the 2.4-GHz and 5-GHz frequency bands are supported on the indoor and outdoor access points.
Figure 2: Frequency Bands Supported By 802.11a Radios on AP1500s
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This band can now be used indoors and outdoors
Maximum power is increased to 30 dBm (1 Watt) assuming antenna is 6 dBi
Power should be reduced by 1 dB for every dB antenna gain exceeds 6 dBi

When used outdoors, EIRP power in the upwards direction above 30 degrees is limited to 125 mW (20.9
dBm)

U-NII-2A and U-NII2C
Must include Dynamic Frequency Selection (DFS) radar detection

Terminal Doppler Weather Radar (TWDR) bands (channels 120, 124 & 128) are now available with new
DFS test requirements

U-NII-3

Band extended from 5825 MHz to 5850 MHz
Europe

U-NII-1

23 dBm Maximum—Not permitted for outdoor usage
U-NII-2A

23 dBm Maximum—Not permitted for outdoor usage
U-NII-2C

30 dBm Maximum

U-NII-3

Only available in UK at 23 dBm for Indoor usage only

Dynamic Frequency Selection

Previously, devices employing radar operated in frequency subbands without other competing services.
However, controlling regulatory bodies are attempting to open and share these bands with new services like
wireless mesh LANs (IEEE 802.11).

To protect existing radar services, the regulatory bodies require that devices wishing to share the newly opened
frequency subband behave in accordance with the Dynamic Frequency Selection (DFS) protocol. DFS dictates
that to be compliant, a radio device must be capable of detecting the presence of radar signals. When a radio
detects a radar signal, it is required to stop transmitting to for at least 30 minutes to protect that service. The
radio then selects a different channel to transmit on but only after monitoring it. If no radar is detected on the
projected channel for at least one minute, then the new radio service device may begin transmissions on that
channel.

The AP performs a DFS scan on the new DFS channel for 60 seconds. However, if a neighboring AP is already
using that new DFS channel, the AP does not perform the DFS scan.

The process for a radio to detect and identify a radar signal is a complicated task that sometimes leads to
incorrect detects. Incorrect radar detections can occur due to a large number of factors, including due to
uncertainties of the RF environment and the ability of the access point to reliably detect actual on-channel
radar.

The 802.11h standard addresses DFS and Transmit Power Control (TPC) as it relates to the 5-GHz band. Use
DEFS to avoid interference with radar and TPC to avoid interference with satellite feeder links.
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Antennas

Figure 3: DFS and TPC Band Requirements

Frequency (MHz)

Overview

Antenna choice is a vital component of any wireless network deployment. There are two broad types of
antennas:

¢ Directional

¢ Omnidirectional

Each type of antenna has a specific use and is most beneficial in specific types of deployments. Because
antennas distribute RF signal in large lobed coverage areas determined by antenna design, successful coverage
is heavily reliant on antenna choice.

An antenna gives a mesh access point three fundamental properties: gain, directivity, and polarization:

» Gain—A measure of the increase in power. Gain is the amount of increase in energy that an antenna
adds to an RF signal.

* Directivity—The shape of the transmission pattern. If the gain of the antenna increases, the coverage
area decreases. The coverage area or radiation pattern is measured in degrees. These angles are measured
in degrees and are called beam-widths.

N

Note Beamwidth is defined as a measure of the ability of an antenna to focus radio
signal energy toward a particular direction in space. Beamwidth is usually
expressed in degrees HB ?(Horizontal Beamwidth); usually, the most important
one is expressed in a VB (Vertical Beamwidth) (up and down) radiation pattern.
When viewing an antenna plot or pattern, the angle is usually measured at
half-power (3 dB) points of the main lobe when referenced to the peak effective
radiated power of the main lobe.

. Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8



| Mesh Network Components
Client Access Certified Antennas (Third-Party Antennas) .

N

Note An 8-dBi antenna transmits with a horizontal beamwidth of 360 degrees, causing
the radio waves to disperse power in all directions. Therefore, radio waves from
an 8-dBi antenna do not go nearly as far as those radio waves sent from a 14-dBi
patch antenna (or a third-party dish) that has a more narrow beamwidth (less than
360 degrees).

* Polarization—The orientation of the electric field of the electromagnetic wave through space. Antennas
can be polarized either horizontally or vertically, though other kinds of polarization are available. Both
antennas in a link must have the same polarization to avoid an additional unwanted loss of signal. To
improve the performance, an antenna can sometimes be rotated to alter polarization, which reduces
interference. A vertical polarization is preferable for sending RF waves down concrete canyons, and
horizontal polarization is generally more preferable for wide area distribution. Polarization can also be
harnessed to optimize for RF bleed-over when reducing RF energy to adjacent structures is important.
Most omnidirectional antennas ship with vertical polarization as their default.

Antenna Options

A wide variety of antennas are available to provide flexibility when you deploy the mesh access points over
various terrains.Refer to the applicable accesspoint data sheet or ordering guide for a list of supported antennas.

See the Cisco Aironet Antenna and Accessories Reference Guide on Cisco antennas and accessories at
http://www.cisco.com/en/US/prod/collateral/wireless/ps7183/ps469/product data sheet09186a008008883b.html

The deployment and design, limitations and capabilities, and basic theories of antennas as well as installation
scenarios, regulatory information, and technical specifications are addressed in detail.http://wwwin.cisco.com/
c/cec/prods-industry/selling-en/products/wireless/ap/aironet-acc.html

Client Access Certified Antennas (Third-Party Antennas)

You can use third-party antennas with AP1500s. However, note the following:

* Cisco does not track or maintain information about the quality, performance, or reliability of the
noncertified antennas and cables.

* RF connectivity and compliance is the customer’s responsibility.

» Compliance is only guaranteed with Cisco antennas or antennas that are of the same design and gain as
Cisco antennas.

* Cisco Technical Assistance Center (TAC) has no training or customer history with regard to non Cisco
antennas and cables.

Cisco Wireless LAN Controllers

The wireless mesh solution is supported on Cisco 2500, 3500, 5508, 5520, WiSM-2 and 8500 Series Wireless
LAN Controllers.

For more information about the Cisco 2500, 3500, 5500, and 8500 Series Wireless LAN Controllers, see
http://www.cisco.com/en/US/products/ps6302/Products Sub_Category Home.html.
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Cisco Prime Infrastructure

The Cisco Prime Infrastructure provides a graphical platform for wireless mesh planning, configuration, and
management. Network managers can use the Prime Infrastructure to design, control, and monitor wireless
mesh networks from a central location.

With the Prime Infrastructure, network administrators have a solution for RF prediction, policy provisioning,
network optimization, troubleshooting, user tracking, security monitoring, and wireless LAN systems
management. Graphical interfaces make wireless LAN deployment and operations simple and cost-effective.
Detailed trending and analysis reports make the Prime Infrastructure vital to ongoing network operations.

The Prime Infrastructure runs on a server platform with an embedded database, which provides scalability
that allows hundreds of controllers and thousands of Cisco mesh access points to be managed. Controllers
can be located on the same LAN as the Prime Infrastructure, on separate routed subnets, or across a wide-area
connection.

Architecture

Control and Provisioning of Wireless Access Points

Control and provisioning of wireless access points (CAPWAP) is the provisioning and control protocol used
by the controller to manage access points (mesh and nonmesh) in the network.

CAPWAP Discovery on a Mesh Network

)

The process for CAPWAP discovery on a mesh network is as follows:

1. A mesh access point establishes a link before starting CAPWAP discovery, whereas a non mesh access
point starts CAPWAP discovery using a static IP for the mesh access point, if any.

2. The mesh access point initiates CAPWAP discovery using a static IP for the mesh access point on the
Layer 3 network or searches the network for its assigned primary, secondary, or tertiary controller. A
maximum of 10 attempts are made to connect.

Note

The mesh access point searches a list of controllers configured on the access point (primed) during setup.

3. [If Step 2 fails after 10 attempts, the mesh access point falls back to DHCP and attempts to connect in 10
tries.

4. If both Steps 2 and 3 fail and there is no successful CAPWAP connection to a controller.

5. If there is no discovery after attempting Steps 2, 3, and 4, the mesh access point tries the next link.

Dynamic MTU Detection

If the MTU is changed in the network, the access point detects the new MTU value and forwards that to the
controller to adjust to the new MTU. After both the access point and the controller are set at the new MTU,

. Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8



| Mesh Network Components

Adaptive Wireless Path Protocol .

all data within their path are fragmented into the new MTU. The new MTU size is used until it is changed.
The default MTU on switches and routers is 1500 bytes.

Adaptive Wireless Path Protocol

Traffic Flow

The Adaptive Wireless Path Protocol (AWPP) is designed specifically for wireless mesh networking to provide
ease of deployment, fast convergence, and minimal resource consumption.

AWPP takes advantage of the CAPWAP WLAN, where client traffic is tunneled to the controller and is
therefore hidden from the AWPP process. Also, the advance radio management features in the CAPWAP
WLAN solution are available to the wireless mesh network and do not have to be built into AWPP.

AWPP enables a remote access point to dynamically find the best path back to a RAP for each MAP that is
part of the RAP’s bridge group (BGN). Unlike traditional routing protocols, AWPP takes RF details into
account.

To optimize the route, a MAP actively solicits neighbor MAP. During the solicitation, the MAP learns all of
the available neighbors back to a RAP, determines which neighbor offers the best path, and then synchronizes
with that neighbor. The path decisions of AWPP are based on the link quality and the number of hops.

AWPP automatically determines the best path back to the CAPWAP controller by calculating the cost of each
path in terms of the signal strength and number of hops. After the path is established, AWPP continuously
monitors conditions and changes routes to reflect changes in conditions. AWPP also performs a smoothing
function to signal condition information to ensure that the ephemeral nature of RF environments does not
impact network stability.

The traffic flow within the wireless mesh can be divided into three components:

1. Overlay CAPWAP traffic that flows within a standard CAPWAP access point deployment; that is,
CAPWAP traffic between the CAPWAP access point and the CAPWAP controller.

2. Wireless mesh data frame flow.

3. AWPP exchanges.

As the CAPWAP model is well known and the AWPP is a proprietary protocol, only the wireless mesh data
flow is described. The key to the wireless mesh data flow is the address fields of the 802.11 frames being sent
between mesh access points.

An 802.11 data frame can use up to four address fields: receiver, transmitter, destination, and source. The
standard frame from a WLAN client to an AP uses only three of these address fields because the transmitter
address and the source address are the same. However, in a WLAN bridging network, all four address fields
are used because the source of the frame might not be the transmitter of the frame, because the frame might
have been generated by a device behind the transmitter.

Figure 4: Wireless Mesh Frame, on page 12 shows an example of this type of framing. The source address
of the frame is MAP:03:70, the destination address of this frame is the controller (the mesh network is operating
in Layer 2 mode), the transmitter address is MAP:D5:60, and the receiver address is RAP:03:40.
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Figure 4: Wireless Mesh Frame
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PAP:0370 PAP:D5:60 PAP:03:40 Controller: 23:a3

Frame Control: 0:0308 (Mormal)

Duration: 48

Receiver address: Airespac_53:03:40 (00:0b:85:53:03:40)
Transmitter address: Airspac_23:d5:60 (00:0b:85:23.d550)
Destination address: Airepac_40:23:a3 (00:0b85:40:23:23)
Fragment number: 0

Sequence number. 1410

Source address: Airspac_53:03:70 (00:0b:85:53:03:70)

14adda

As this frame is sent, the transmitter and receiver addresses change on a hop-by-hop basis. AWPP is used to
determine the receiver address at each hop. The transmitter address is known because it is the current mesh
access point. The source and destination addresses are the same over the entire path.

If the RAP’s controller connection is Layer 3, the destination address for the frame is the default gateway
MAC address, because the MAP has already encapsulated the CAPWARP in the IP packet to send it to the
controller, and is using the standard IP behavior of using ARP to find the MAC address of the default gateway.

Each mesh access point within the mesh forms an CAPWAP session with a controller. WLAN traffic is
encapsulated inside CAPWAP and is mapped to a VLAN interface on the controller. Bridged Ethernet traffic
can be passed from each Ethernet interface on the mesh network and does not have to be mapped to an interface
on the controller (see Figure 5: Logical Bridge and WLAN Mapping, on page 12).

Figure 5: Logical Bridge and WLAN Mapping

«wwow CAPWAP Tunnel
sessas Bridged Ethernet
= VAN mapped to WLAN

2omasd

Mesh Neighbors, Parents, and Children

Relationships among mesh access points are as a parent, child, or neighbor (see Figure 6: Parent, Child, and
Neighbor Access Points, on page 13).

* A parent access point offers the best route back to the RAP based on its ease values. A parent can be
either the RAP itself or another MAP.

* Ease is calculated using the SNR and link hop value of each neighbor. Given multiple choices,
generally an access point with a higher ease value is selected.

* A child access point selects the parent access point as its best route back to the RAP.

* A neighbor access point is within RF range of another access point but is not selected as its parent or a
child because its ease values are lower than that of the parent.
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Figure 6: Parent, Child, and Neighbor Access Points
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Criteria to Choose the Best Parent
AWPP follows this process in selecting parents for a RAP or MAP with a radio backhaul:

* A list of channels with neighbors is generated by passive scanning in the scan state, which is a subset of
all backhaul channels.

* The channels with neighbors are sought by actively scanning in the seek state and the backhaul channel
is changed to the channel with the best neighbor.

* The parent is set to the best neighbor and the parent-child handshake is completed in the seek state.

* Parent maintenance and optimization occurs in the maintain state.

This algorithm is run at startup and whenever a parent is lost and no other potential parent exists, and is usually
followed by CAPWAP network and controller discovery. All neighbor protocol frames carry the channel
information.

Parent maintenance occurs by the child node sending a directed NEIGHBOR REQUEST to the parent and
the parent responding with a NEIGHBOR RESPONSE.

Parent optimization and refresh occurs by the child node sending a NEIGHBOR REQUEST broadcast on
the same channel on which its parent resides, and by evaluating all responses from neighboring nodes on the
channel.

A parent mesh access point provides the best path back to a RAP. AWPP uses ease to determine the best path.
Ease can be considered the opposite of cost, and the preferred path is the path with the higher ease.
Ease Calculation

Ease is calculated using the SNR and hop value of each neighbor, and applying a multiplier based on various
SNR thresholds. The purpose of this multiplier is to apply a spreading function to the SNRs that reflects
various link qualities.

Figure 7: Parent Path Selection, on page 14 shows the parent path selection where MAP2 prefers the path
through MAP1 because the adjusted ease value (436906) though this path is greater then the ease value
(262144) of the direct path from MAP2 to RAP.
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Figure 7: Parent Path Selection
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A parent mesh access point is chosen by using the adjusted ease, which is the ease of each neighbor divided
by the number of hops to the RAP:

adjusted ease = min (ease at each hop) Hop count

One of the challenges in WLAN routing is the ephemeral nature of RF, which must be considered when
analyzing an optimal path and deciding when a change in path is required. The SNR on a given RF link can
change substantially from moment to moment, and changing route paths based on these fluctuations results
in an unstable network, with severely degraded performance. To effectively capture the underlying SNR but
remove moment-to-moment fluctuations, a smoothing function is applied that provides an adjusted SNR.

In evaluating potential neighbors against the current parent, the parent is given 20 percent of bonus-ease on
top of the parent's calculated ease, to reduce the ping-pong effect between parents. A potential parent must
be significantly better for a child to make a switch. Parent switching is transparent to CAPWAP and other
higher-layer functions.

To ensure that routing loops are not created, AWPP discards any route that contains its own MAC address.
That is, routing information apart from hop information contains the MAC address of each hop to the RAP;
therefore, a mesh access point can easily detect and discard routes that loop.
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CHAPTER 2

Mesh Deployment Modes

This chapter describes the mesh deployment modes and contains the following sections:

*» Wireless Mesh Network, on page 15

» Wireless Backhaul, on page 16

* Point-to-Multipoint Wireless Bridging, on page 16

* Point-to-Point Wireless Bridging, on page 17

* Introduction to Flex+Mesh in release 8.8 , on page 18

* Introduction to Additional Mesh Features in release 8.8, on page 25
» Whitelisting of specific URLs in Rel 8.8, on page 30

* Captive Portal Configuration in Rel 8.8, on page 31

* Policy Enforcement and Quota Management in rel 8.8, on page 33

Wireless Mesh Network

\}

In a Cisco wireless outdoor mesh network, multiple mesh access points comprise a network that provides
secure, scalable outdoor wireless LAN.

The three RAPs are connected to the wired network at each location and are located on the building roof. All
the downstream access points operate as MAPs and communicate using wireless links (not shown).

Both MAPs and RAPs can provide WLAN client access; however, the location of RAPs are often not suitable
for providing client access. All the three access points in are located on the building roofs and are functioning
as RAPs. These RAPs are connected to the network at each location.

Some of the buildings have onsite controllers to terminate CAPWAP sessions from the mesh access points
but it is not a mandatory requirement because CAPWAP sessions can be back hauled to a controller over a
wide-area network (WAN).

Note

CAPWAP over CAPWAP is not supported. AP in local mode connected on the RAP or MAP ethernet port
is not a supported configuration.
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Wireless Backhaul

In a Cisco wireless backhaul network, traffic can be bridged between MAPs and RAPs. This traffic can be
from wired devices that are being bridged by the wireless mesh or CAPWAP traffic from the mesh access
points. This traffic is always AES encrypted when it crosses a wireless mesh link such as a wireless backhaul.

AES encryption is established as part of the mesh access point neighbor relationship with other mesh access
points. The encryption keys used between mesh access points are derived during the EAP authentication
process.

Universal Access

You can configure the backhaul on mesh access points to accept client traffic over its 802.11a radio. This
feature is identified as Backhaul Client Access in the controller GUI (Monitor > Wireless). When this feature
is disabled, backhaul traffic is transmitted only over the 802.11a or 802.11a/n radio and client association is
allowed only over the 802.11b/g or 802.11b/g/n radio. For more information about the configuration, see the
Configuring Advanced Features.

\}

Note Inrel 8.2 and higher the backhaul is also supported on 2.4 GHz.

Point-to-Multipoint Wireless Bridging

In the point-to-multipoint bridging scenario, a RAP acting as a root bridge connects multiple MAPs as non-root
bridges with their associated wired LANs. By default, this feature is disabled for all MAPs. If Ethernet bridging
is used, you must enable it on the controller for the respective MAP and for the RAP.

Figure 8: Point-to-Multipoint Bridging Example

This figure shows a simple deployment with one RAP and two MAPs, but this configuration is fundamentally
a wireless mesh with no WLAN clients. Client access can still be provided with Ethernet bridging enabled,

. Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8



| Mesh Deployment Modes

Point-to-Point Wireless Bridging .

although if bridging between buildings, MAP coverage from a high rooftop might not be suitable for client

access.

Point-to-Point Wireless Bridging

In a point-to-point bridging scenario, a 1500 Series Mesh AP can be used to extend a remote network by using
the backhaul radio to bridge two segments of a switched network. This is fundamentally a wireless mesh
network with one MAP and no WLAN clients. Just as in point-to-multipoint networks, client access can still
be provided with Ethernet bridging enabled, although if bridging between buildings, MAP coverage from a
high rooftop might not be suitable for client access.

If you intend to use an Ethernet bridged application, we recommend that you enable the bridging feature on
the RAP and on all MAPs in that segment. You must verify that any attached switches to the Ethernet ports
of your MAPs are not using VLAN Trunking Protocol (VTP). VTP can reconfigure the trunked VLANS across
your mesh and possibly cause a loss in connection for your RAP to its primary WLC. An incorrect configuration
can take down your mesh deployment.

Figure 9: Point-to-Point Bridging Example
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For security reasons the Ethernet port on the MAPs is disabled by default. It can be enabled only by configuring
Ethernet bridging on the Root and the respective MAPs. To enable Ethernet bridging using the controller
GUI, choose Wireless > All APs > Details for the AP page, click the Mesh tab, and then select the Ethernet
Bridging check box.
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Note

The overall throughput of backhaul radio decreases by half for each hop of a mesh tree. When the
Ethernet-bridged clients are used in MAPs and heavy traffic is passed, it may result in a high throughput
consumption, which may cause the downlink MAPs to disassociate from the network due to throughput
starvation.

Ethernet bridging has to be enabled for the following two scenarios:
When you want to use the mesh nodes as bridges.
When you want to connect Ethernet devices such as a video camera on the MAP using its Ethernet port.

Ensure that you enable Ethernet bridging for every parent mesh AP taking the path from the mesh AP in
question to the controller. For example, if you enable Ethernet bridging on MAP2 in Hop 2, then you must
also enable Ethernet bridging on MAP1 (parent MAP), and on the RAP connecting to the controller.

To configure range parameters for longer links, choose Wireless > Mesh. Optimum distance (in feet) should
exist between the root access point (RAP) and the farthest mesh access point (MAP). Range from the RAP
bridge to the MAP bridge has to be mentioned in feet.

The following global parameter applies to all mesh access points when they join the controller and all existing
mesh access points in the network:

Range: 150 to 132,000 feet

Configuring Mesh Range (CLI)

Procedure
* To configure the distance between the nodes doing the bridging, enter the config mesh range command.

APs reboot after you specify the range.

Note

To estimate the range and the AP density, you can use range calculators that are available at:

Range Calculator for all access points: http://173.37.206.125/aspnet_client/system_web/2 0 50727/wng_
coverage capacity calculator v2.0 _html/wng_coverage capacity calculator v2.0.htm

* To view the mesh range, enter the show mesh config command.

Introduction to Flex+Mesh in release 8.8

Below is a general FlexMesh architecture. The CAPWAP AP is in Flex connect + Bridge mode with a wired
uplink to the core network in a 'Root' AP or RAP mode. The AP is still managed by a centralized controller
over CAPWAP. The AP however is capable of moving to a standalone mode where the AP will be able to
continue to serve the 802.11 clients depending on the data switching method of the WLAN configured on the
AP. The data can be centrally or locally switched. When data is centrally switched, all data is sent to the WLC
that does the switching further. In a local switch network, the data is sent to RAP where RAP switches locally
on the wired uplink. There is no difference to the central and local switched WLAN configurations and
functionality between a Flex-Connect and Flex+Mesh mode AP.
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Mesh COS AP that support new 8.8 Feature

1562 supported mesh in 8.4 release. 1542 AP (1542D and 1542I) models supported Mesh in 8.5 release. All
these Aps should be able to support Flex Mesh as Flex Mesh designed on 1542 should be applicable to 1562
as well since Flex Mesh is a platform independent feature.

Flex Mesh feature is supported on the IOS based Mesh AP even prior to release 8.8; however in rel 8.8 this
feature is officially supported on the COS based Mesh AP and supported by TAC starting with rel 8.8. In
addition, the IPv6 is now supported on the COS based Mesh APs.

There are two new SKUs of 1542 that are developed. The AP1540 Series released in 8.5 meets most of the
technical requirement, but does not have external antennas. AP1542E2 and AP1542E4 are hardware variants
of 1541D/I AP. The 1542E2 is a dual band mode AP with dual-radio dual-band 2.4GHz (802.11b/g/n, 20MHz)
& 5 GHz (802.11a/n/acW2, 20/40/80 MHz). The 1542E4 is a single band mode AP with antenna A and B to
support 2.4G and C and D to support 5G. The Aps support minimum 2 TX & 2 RX chains, 2 spatial streams.
AP expected to support minimum 22 dBm (2.4 GHz) and 24 dBm (5 GHz) conducted transmit output power
per TX. Basic new PID additions and power table changes for this new platform will be done on both AP and
WLC. New power tables for -D(INDIA) with external antennas.

Flexible Antenna port configuration

The above HW changes have requirements for SW changes as well. The AP needs to support a flexible antenna
port configuration. SW changes are done to let the user configure the antennas to support either in a single
band mode or dual band mode. Software configurable Single Band Vs Dual Band mode. This is similar to the
1532 AP configuration. The user can configure the antenna band modes using WLC CLI or GUI.

Flex Mesh AP Running Modes

Flex mesh COS AP can be running in connected or standalone mode. Standalone mode in flex connect will
undergo some changes to inherit standalone functionality for a mesh network. There is also another mode
called 'abandoned' mode discussed below in this section of the guide.
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Connected Mode

A COS Flex Mesh AP (Root AP or Child Mesh AP) is considered to be in connected mode when it can access
and join the WLC and can exchange periodic keep alive messages with WLC. In this mode, Flex Mesh AP
will be able support locally and centrally switched WLAN's. It shall allow regular client and Child mesh APs
to join.

Standalone Mode

A COS Flex Mesh AP, is considered to be in standalone mode if it loses connection to the controller but it
can access the local gateway. In this mode, the COS Flex+Mesh AP will disable all the centrally switched
WLANsS, and shall keep the locally switched WLANs up and running. It will also allow the new clients to
join on local switched WLANS using local authentication as long as the authentication server is reachable in
the local network. Child mesh APs will NOT be allowed to join in this mode.

Abandoned Mode or Persistent SSID Mode

A COS Flex+Mesh AP is in abandoned mode when it can no longer access the gateway IP and has no
connectivity to the local network. Possible scenarios are:

* AP is still not locked on to any uplink wired or wireless.
* A wireless uplink has been established but has not been authenticated.
* An uplink is established and authenticated, but IP address has the gateway IP has not been configured.

 An uplink is established, authenticated and also IP address and gateway IP has been configured, but the
gateway is not reachable for over a minute.

Neither Child Mesh APs nor the clients are allowed to join in this mode. Local as well as centrally switched
WLANSs will be disabled. AP may still be scanning for an uplink in this mode so no beacons will be transmitted
during this time.

)

Note For flex mesh COS APs, in abandoned mode, reboot timer shall be enabled so the AP will have rebooted after
40 minutes, if it does not transition to either standalone mode or connected mode.

Mode/State transitions in the Flex Mesh COS APs

* Flex Mesh mode COS AP will always boot up in abandoned mode, in which it would need to scan for
the uplink (wired or radio).

* Once a new uplink is selected either during initial stage or during inter gateway roaming scenario, it is
expected that the authentication should pass and the CAPWAP connection needs to be formed within 2
minutes, else the selected parent will be blacklisted. This function should be same as a regular Mesh
mode COS AP.

* Ifa Flex mesh AP has a valid CAPWAP connection and it loses the CAPWAP connection it will transition
to standalone mode, and will stay in standalone mode, as long as the gateway is reachable. A Flex Mesh
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AP will keep track of the IP mode (IPV6 or IPV4) used for the last successful CAPWAP connection and
with track the reachability of the GW for that IP mode.

* For Flex mesh AP in standalone mode, Mesh control will start a timer (20 second) to periodically refresh
the ARP entry for GW IP (IPV4 or IPV6) and to also query the GW reachability status from the Path
Control Protocol. PCP will maintain the gateway reachability status from that AP either reported by the
Root AP via PCP messages or if it is Root AP by doing an ARP lookup for the gateway IP address. If
the GW is unreachable for over a minute, the Flex Mesh AP will blacklist the parent and will transition
to abandoned mode and will re-scan for a new uplink.

» To come out of the abandoned mode, AP must connect to the WLC and transition to the connected mode.
Transition from abandoned mode directly to standalone mode is not supported and needs to be considered
in future design enhancements.

Design considerations for Flex AP in standalone mode:

» When the Flex AP is in standalone mode, it will stick to the same parent and will NOT try to discover
or roam to a better neighbor, even if it is a preferred parent. The reason is that there is no guarantee that
the security will pass with the new parent and the roaming will be successful. If the security fails, the
perspective parent may get blacklisted unnecessarily. It is best to consider standalone roaming once
standalone security is supported for Mesh APs in future design enhancements.

* BGN timer will be stopped in standalone mode. So, if the child mesh AP is in standalone mode and it
joins a parent with a different BGN and goes back into standalone mode after that, BGN timer will be
stopped so that the child Mesh AP does not go into re-scan mode after 15 minutes (BGN timer expiry).

* In standalone mode, reboot timer will be stopped so that the AP does not reboot after 40 minutes, in the
absence of a CAPWAP connection.

+ After moving back to connected mode, from standalone mode, best neighbor selection timer and BGN
timer will be restarted, so allow the child mesh AP to roam to the best possible neighbor.

Special standalone mode for COS Flex RAPs

In this mode the SSID will be broadcasted always (Persistent SSID). In addition, after reboot, when this special
Persistent mode is enabled, Flex Mesh RAP should be able to start broadcasting the SSID even if the gateway
is not reachable.

Existing Flex-connect AP mode design

* Locally switched WLANS are stored in config.flex file and Flex-connect AP broadcasts the local WLAN
SSIDs as long as it is standalone mode.

* On boot up Flex-connect AP would only start broadcasting the locally switched WLANSs if the gateway
provisioned.

« If for a COS Flex connect AP, gateway information is removed at some point, it moves out of the
standalone mode and stops broadcasting the locally switched SSIDs and waits for gateway to be
provisioned again.
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* Once the gateway is provisioned, Flex AP again transitions into the standalone mode and starts
broadcasting the locally switched SSIDs again.

» Without a valid gateway, flex-connect AP eventually stops broadcasting SSIDs, since the local network
is not reachable so no reason to connect the clients.

Parts of the existing Flex-connect AP mode design is used to retain WLAN configuration during reboot and
to be able to start broadcasting Local SSIDs etc. However, for Flex RAP we have a special standalone mode
requirement for NBN deployment as stated below:

* Flex RAP should be able to boot up directly into the standalone mode and start broadcasting SSIDs, even
if the gateway is not reachable.

* Flex RAP will continue to be in standalone mode and keep broadcasting SSIDs if the gateway was
reachable earlier and becomes unreachable at some point.

* Even if the Flex RAP cannot support any real clients, it still needs to broadcast SSID so that the operator
can check if the AP is UP and running.

Design considerations to support new requirement

* Flex RAP should join the controller at least once to download the WLAN configuration that gets stored
in the config.flex file. This WLAN is a local switched one.

* Once the configuration is stored in the config.flex file, it will become persistent across the reboots and
AP does not need to join WLC again as long as the configuration is not erased.

* A new configuration that is needed for the RAP to maintain the wired link is supported and will be stored
in mesh configuration file i.e. "strict_ wired uplink".

» If the following conditions are true, FLEX Mesh AP will broadcast the local WLANSs stored in flex
configuration file even if the gateway is not reachable.

« AP is a Flex Mesh Root AP

* AP is configured with strict wired uplink as true.

* A new AP CLI command will be supported to configure a Flex Mesh AP as a strict wired AP.
# CAPWAP ap mesh strict-wired-uplink <true/false>

» New configuration parameter "strict wired uplink" will be stored in config.mesh file in storage directory
so that it is persistent across the reboots. Default value of this parameter will be false.

» Strict wired uplink configuration is only valid if the AP is configured as Flex-Mesh Root AP. For all
other AP modes and for Mesh AP role, strict wired uplink configuration will not be effective, even if
configured.

» When strict wired uplink is true for Flex Mesh Root AP:

» Wired uplink will be immediately selected on mesh restart.
» Wired uplink will never be blacklisted
* CAPWAP up timer will not run

¢ Mesh Reboot timer will not run
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* Seek of the wired adjacency will always return true, even if the interface is down
» Wireless backhaul can never be selected as an uplink
» Wireless backhaul can still be used as downlink to provide connectivity to the Mesh child nodes
* To avoid issues due to gateway configuration checks, static IP and gateway must be configured on the
Flex RAP (even if it just a dummy IP or gateway).

» Having Static IP and Gateway configuration will allow the Flex RAP to transition into standalone
mode after reboot even when there is no connectivity to the local network (i.e. no DHCP server to
provision IP and gateway). Flex RAP will then continue broadcasting the locally switched SSIDs
even in absence of any network connectivity.

* [f the IP and gateway are not valid, and once AP has connectivity to DHCP server, DHCP IP
overwrites the static IP configuration and DHCP IP and gateway configuration takes over.

» A Simple WLC CLI to enable/disable the Persistent SSID' feature will be provided. The WLC and AP
should have communication for this configuration to take effect.

* The AP 'show mesh config' will also dump the current status of this feature.

Configuring Mesh Enhancements

Step 1 As indicated in the explanation above the RAP has to be configured to be in an Persistent Transmit of the SSI mode. This
configuration option is available from the CLI mode only.

NBNMAP1542_B2_g2#capwap ap mesh strict-wired-uplink |
rd_iiabj_e_;jiianmﬂ_:!ﬂ:@:m_ Tk

enable enable strict wired uplink |
NENMAP1542_BZ_EZ#capwap ap mesh strict-wired-uplink

Step 2 To verify that the mode is enabled execute a "show mesh config" command and the "strict wired uplink" should show as
Enabled.
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NBNMAP1542_B2_E2#show mesh conf
AP specific con
AP Role: Flex RoOT AP

Public safety:
slot Bias: Disabled

LSC Authentication: Disabled

Background Scanning: Disabled

strict Matching BGN: Disabled

Convergence Method: Standard c0nuer?ence, CCN mode: Disabled
Ethernet Bridging BPDU Allow: Disable

Daisy Chain Mode: Disabled

VLAN Transparent Bridging: Disabled

Trunk VLAN Id: O

Backhaul Rate: Auto

preferred Parent: O0C:75:BD:0C:A1:F1

CAPWAP Join Mode: IPv4

Bridge Group Name:

Mesh Statistics Push Interval(min): 3

Rangeffeet): 12000

Mesh Security Mode: EAP (PSK Provisioned:Tue Nov 21 15:37:59 2017)
Background Scanning: Disabled

universal client Access: Enabled

universal Client Access Ext: Enabled

Global Public safety: Disabled

Battery Backup: Enabled

Full Sector DFS: Enabled

IDS(Rogue,/Signature Reporting): Disabled

Backhaul a-mSpu: Enabled

Backhaul DCA Status: Disabled

Configured Parent: 0C:75:BD:0C:Al:F1

Multicast Mode:In-out

Step 3 As indicated above for the persistent SSID to function and to avoid issues due to gateway configuration checks, static IP
and gateway must be configured on the Flex RAP (even if it just a dummy IP or gateway). Having Static IP and Gateway
configuration will allow the Flex RAP to transition into standalone mode after reboot even when there is no connectivity
to the local network (i.e. no DHCP server to provision IP and gateway). Flex RAP will then continue broadcasting the
locally switched SSIDs even in absence of any network connectivity.

If the IP and gateway are not valid, and once AP has connectivity to DHCP server, DHCP IP overwrites the static IP
configuration and DHCP IP and gateway configuration takes over.
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Steps for testing RAP Persistent Mode in Rel 8.8

Introductio

In order to test the setup best is to configure one RAP with perrsistant SSID or in abandoned mode and one
in aregular RAP mode. Connect a client to both RAP and observe behavior when RAPs lose their connectivity
to the controller.

* Client with Persistent Mode enabled should maintain connectivity to the RAP, since RAP continues to
transmit the SSID.

* Client that connected to the regularly configured RAP will lose connectivity since SSID will stop being
transmitted.

n to Additional Mesh Features in release 8.8

This section of the deployment guide introduces the few new Mesh or Outdoor AP features in the release 8.8.
The purpose of this document is to provide configuration guidance of the following features:

1. “Lawful Intercept (LI)” and Monitoring
2. Whitelisting of specific URLs
3. Captive Portal Configuration

4. Policy Enforcement and Quota Management

Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8 .



Mesh Deployment Modes |

. “Lawful Intercept” (LI) and Monitoring in Rel 8.8

“Lawful Intercept” (LI) and Monitoring in Rel 8.8

\}

Certain Cisco customers have plans to deploy Cisco Wifi Mesh solution across very large geographical areas
with a Flex+Mesh (with local switching) tree. A RAP (Root Access Point) with a wired backhaul to the
centralized WLC shall forms a mesh tree serving wireless clients. Lawful Intercept feature is a process of
lawful interception and monitoring of mobile phones, landlines, and wireless internet traffic if administration
decides to set up a Centralized Monitoring System (CMS) .

There will be a mesh network in Flex+Mesh mode setup and as part of LI, export the client flow information
for each flow will be provided.

RAP will do the NAT/PAT as well as LI record generation and sending to LI server via WLC. For all flows,
a record will be created in the NAT/PAT. At that point, RAP will create the Syslog record for that flow. RAP
will send those Syslog packets through CAPWAP-DATA to the WLC.

Note

Any peer to peer client traffic within mesh tree which does not go via RAP (only MAP handles locally) will
not be considered to be reported to LI server.

WLC will update the syslog packet with its own MAC and IP and will forward the Syslog packets to the
Syslog server in the network. These packets will not be encrypted.

This will be the typical workflow:
1.  Admin has to configure Syslog server config.
Either IPv4 or IPv6 is only supported.
If IPv6 is configured then WLC should be IPv6 enabled.
The existing “config ap syslog global “ command will be functional.
2. LI will be enabled/disabled only Globally.
Prerequisite for this will be Syslog server config.
3. AP saves the syslog server configuration (IP address and enable/disable) received from WLC on RAP.
4.  IPv4 packets to be NAT/PAT(in case of internal DHCP) on the packets.
IPv6 packets and also IPv4 packets (in case of external DHCP) will:
1. Identify flows based on packet Source/dest IP/port.

2. Save the flows in a FlowTable entry.

5. LI Reporter element will:

1. Receive and save new flow records pushed by NAT element/FlowTable element.
2. It will run a periodic timer (typically 1 minute).

3. c.Onexpiry of this timer, all the flow records in its table are flushed and converted to syslog records
containing both v4 and v6 flows together. Syslog format is given in next section.

6.  Only at the beginning of the flow creation, it will be sent. Subsequently, no other flow records will be
sent.
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7. AP will form the syslog packet

8.  8) WLC will recognize whether it is LI packet or not.
Update the contents,
IP: Dst IP: LI IP (v4 or v6)
Source IP: Mgmt IP
Dst Mac: GW Mac
Source Mac: Mgmt Mac
UDP Source Port: 514
UDP Dest Port: 514

9.  Based on the Inner IP packet, WLC will update the Mgmt IP.
If it is [Pv4 then Mgmt IP will be updated.
If it is [Pv6 then Mgmt IPv6 will be updated

10. WLC will not store any records.

11.  Stats will be recorded for the incoming messages from AP.
Stats will also be recorded for the outgoing messages from WLC to syslog server.
Also, other stats if the packet is dropped.

12. Whenever show command is executed it will show the log.

Syslog Format for Netflow Collector

The syslog record is then encapsulated inside UDP/IP header from AP to LI server based on the config received
from WLC.

A Syslog record will be formatted as below:
“syslog header+’:’+ LI Header +’:’+ LI Record 1+°|’+ LI Record 2 +°|’+....”
Syslog Header

* Facility: Syslog facility code.

* Severity: Syslog Severity.

* Timestamp: Time at which the AP sends out the syslog message. This is sent in human readable date
format : mmm dd yyyy hh:mm:ss

* Hostname: Name of the AP (RAP Name)

» Tag: The Tag field is a string that signifies what type of message is carried in the payload.
(AP_LI V4 FLOW/ AP LI V6 FLOW)

LI Header:
“VVITTTTTTTMMMMMMMMMMMM”

* VV: Version, currently it is always “01”
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* TTTTTTTT: Time in seconds when this logging is created, Hex values
* MMMMMMMMMMMM: AP’s mac address. (RAP mac address)

LI record (for IPv4):

“MMMMMMMMMMMM
AAAAN A A’A’BBBBCCCCCCCCcCc’c’Cc’Cc’C’C’C’DDDDDDDDTTTTTTTTHHHHHHHH”

* MMMMMMMMMMMM : Client MAC Address (6 bytes)

* AAAA—source port in HEX (2 bytes)

* AA’A’A’ — NAT source port in HEX (2 bytes) (this will be same as above for no-nat case)
* BBBB—dest port in HEX (2 bytes)

* CCCCCCCC — source ip address in HEX (4 bytes)

+ C’C’C’C’C’C’C’C’ — NAT source ip address in HEX (4 bytes) (this will be same as above for no-nat
case)

« DDDDDDDD-dest ip address in HEX (4 bytes)
* TTTTTTTT-Time in seconds, time when flow was created (4 bytes)

* HHHHHHHH-RAP IP in HEX (4 bytes or 16 bytes)

LI record (for IPv6) (will not have NAT ip and ports):

“MMMMMMMMMMMM AAAABBBB
(OOCCCCCCCOOCCOOCCOOO0aCoCaaacbbbDDDDDDDDDDDDDDDDDDDDDDDDDDDDD

* F -0 for IPv4, 1 for IPv6

* MMMMMMMMMMMM : Client MAC Address (6 bytes)

* AAAA — source port in HEX (2 bytes)

* BBBB — dest port in HEX (2 bytes)

* CCCCCCCrrreeeeeceeeeeeeeeeceeceece—source ipvo address in HEX (16 bytes)

+ DDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDD — dest ipv6 address in HEX (16 bytes)
* TTTTTTTT - Time in seconds, time when flow was created (4 bytes)

« HHHHHHHH — RAP IP in HEX (4 bytes or 16 bytes)

CLI Configuration and Show Commands

New command will be added for LI enable and Disable.

(Cisco Controller) >config flexconnect lawful-interception ?

disable Disable Lawful-Interception.

enable Enable Lawful-Interception.

syslog Configure Lawful-Interception syslog.

timer Configure Lawful-Interception timer value. Timer is periodic interval [60sec
- 600sec]
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Pre-requisite: Ap Syslog should be configured else it will not allow.

1. Existing command is modified to reflect LI changes.
# config ap syslog host global <ipv4/ipv6>

Pre-requisite: If IPv6 is trying to configure we need to check whether IPv6 is enabled and Management
is configured with IPv6 address.

2. There is a new show command to show the stats.

(Cisco Controller) >show flexconnect lawful-interception ?
summary Display Lawful-Interception summary.

Example of the LI show command on the controller:

(Cisco Controller) >show flexconnect lawful-interception sum
Lawful Interception Status: Disabled

Lawful Interception Timer: 60

Lawful Interception IPv4 Addr: 192.201.1.1

Lawful Interception IPv6 Addr: Not Configured

\}

Note There will be show commands on AP to display the configured LI server IP and status.

Example of the show LI command on the AP.

AP-2802#show lawful-intercept
Enable: false

Interval (sec): 60

AP IPv4 Address: 1.5.39.108
AP IPv6 Address:

Max records: 15

syslog src ip: 192.201.1.2
syslog src ipv6: ::syslog

src mac: 00:01:02:03:04:09
extlog server ip: 0.0.0.0
extlog server ipvé6:

extlog server mac: 00:8E:73:56:24:C7
ap name: AP-2802

GUI Configuration of LI

To configure Lawful Intercept from the Controller GUI interface follow the steps below:

Step 1 On the controller Management tab configure Logs>Config the IP address of the Log Server.
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Step 2 On the Controller tab choose Lawful Intercept and then enable it with the Log Server IP address configured. Hit Apply.
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LI Server IP Address(Ipv4/IpvE) 10.70.0.2

LI Timer {Secs) 60

Whitelisting of specific URLs in Rel 8.8

The feature of Whitelist specific URLs on the controller / AP so that users can access those specific sites
without having connectivity to the internet. No authentication is mandated to access the whitelisted URLs.
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* Customer device associates to “XXXX” SSID
* A client gets the IP address and moves to "webauth" required state for HTTP and HTTPS sites

* A client is able to access the whitelist websites even without authentication; for example, Providing
location specific information and other details to the user

* Unique whitelist URL (based on flex group) for specific GP's based on the local rural policy

» When the user attempts to navigate to other websites not configured in the whitelist walled garden profile,
the user is redirected back to the login page.

* Once a user is authenticated, he has access to the internet (non-whitelist websites)

Above feature was addressed with DNS-PreAuth ACL feature implemented in 8.7 release (DNS-ACL). A
max of 20 domain names can be configured and snooped IP addresses (max 64) will be sent to WLC to assist
client roam across APs in webauth_reqd state. Clients shall use these URLs without any authentication as
data traffic to/from the snooped IPs (of preconfigured URLs) are allowed from AP.

As https encrypted packets do not give clear-text URL name to allow/deny access in client’s webauth reqd
state, [P address snooping is required to address this requirement.

Admin has to configure a preAuth ACL with a list of whitelisted URLs and map it to a FlexConnect Group
assigned to a specific location or users.

The above feature configuration is documented in the 8.7 and 8.8 Flex Connect Deployment Guide at the link
below: https://www.cisco.com/c/en/us/td/docs/wireless/controller/technotes/8-7/Flex_7500
DG .html#pgfld-167660

Captive Portal Configuration in Rel 8.8

This feature is to allow users to have multiple splash pages per SSID (Flex group/VLAN based). When users
at specific locations are segregated based on VLANs however, in the same SSID (XXXX) will be broadcasted
by the WLAN hence need the feature which can support multiple splash pages on single SSID.

Use-case :

* Customer device associates to “XXXX” SSID
* A client gets the IP address and moves to "webauth" required state for HTTP and HTTPS sites

* Customized Captive Portal through external Web-auth is presented to the user based on the AP group
configuration

Scaling is to be taken care of in this scenario. If there are many remote locations connected to one WLC and
each location will require its own captive portal. For example, WLC 8540 can support 6000 APs. One remote
location can have have ~ 5-6 APs so ~ 1000 locations can be connected to one WLC8540 hence WLC will
support 1000 splash pages in order to support one splash page for each remote location.

Presently WLC supports external redirect-URL configuration per SSID. This new feature will allow multiple
external re-direct URLSs for a single SSID, either FlexConnect group (OR) AP Group should be taking the
configuration input of external re-direct URL and apply to clients behind the APs mapped to the group.
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CLI Configuration and Show

(WLC) config wlan apgroup custom-web global enable/disable <apgroup name>
(WLC) config wlan apgroup custom-web ext-webauth-url add <ext-webauth-url> <apgroup name>

(WLC) config wlan apgroup custom-web ext-webauth-url delete <apgroup name>

Configured redirect-URL shall be listed in existing show dump:

(WLC) show wlan apgroups

GUI Configuration of Captive Portal

To configure a captive portal from the controller GUI follow the steps below:

Step 1 From the WLAN tab chose Advanced>AP Groups and then create a Flex Group and than select a Flex Connect group to

apply the Captive portal .
vl I (01} | LI
CISCO MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
WLANs AP Groups
w WLANs
WLANS AP Group Name AP Group Description
w Advanced Flex-group Flex EoGRE group
AP Groups MeshATE Mesh ATF group
Out-Of-Box

default-group

test test

Step 2 Enable “custom web override” and enter the “External WebAuth URL”

WLANSs Ap Groups > Edit 'Flex-group’
. WLL‘:':s General | WLANs | RFProfile | APs | 802.11u | Location | Ports/Module |
W s
« Advanced p— !
AP Groups
AP Group Name Flex-group
AP Group Description Flex EoGRE group
MNAS-ID 5520-MA1

Enable Client Traffic QinQ

Enable DHCPv4 QinQ 2

QinQ Service Vlan 1d 12 o
Fabric ACL Template None ¥
CAPWAP Preferred Mode MNot-Configured

Custom Web Override-Global 13 ¥ Enable

External Web auth URL company-abc.com
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Note In this feature, you can create multiple groups with different Captive Portal per the same WLAN and overwrites
External Webauth URL configured at Global WLAN level.

Policy Enforcement and Quota Management in rel 8.8

For Quota management - WLC should accept the Radius user authorization change request to allocate different
quota to the same user without disconnecting the user.

This feature is supported in:

* Local, Bridge (Central Switching)

* Flexconnect, Flex+Bridge (Local Switching)

Feature Use-case:
* A client has 2 GB plan to access the internet
* AP is monitoring the bandwidth usage and reporting the statistics to the controller (Bandwidth monitoring)
* The controller sends the Interim update to the radius server for IPv4 and/or IPv6 (Dual Stack clients)

* As soon as the given Quota is exhausted, Radius sends CoA to change the policy to a different default
plan - (CoA override)

* A client gets moved to a new plan without actually being disconnected from the network — (Applying
new policy on the fly)

Dynamic Policy from AAA
+» 802.11 clients are allotted QoS policy and data rate limits on authenticating with AAA Server

» WLC does not support ‘run-time' policy enforcement as the client gets new policies during full
authentication

* RFC-5176 allows dynamic rate limiting using Change-of-Authorization(CoA) request / response

* End clients get provisioned with maximum allotted quota by Service providers based on prepaid / postpaid
data plans

+ External billing servers notify AAA on reaching maximum data limit per client basis

Feature Implementation on the WLC
In order to get the new policy/quota enforcement, following enhancements are implemented in WLC:

1. WLC periodically sends Accounting-Interim to AAA with client statistics.

2. On reaching the maximum quota allotted per client, AAA will send a CoA-Request with service-type set
to “Authorize Only” along with a state parameter.
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WLC will respond with CoA-NAK with service-type set to “Authorize-Only” and with state parameter

unmodified.

WLC will also send an Access-Request to AAA with service-type set to “Authorize-Only” along with
state parameter as received in CoA-Request.

Access-Request shall have the same format of holding other session attributes / NAS as received in

CoA-Request.

AAA will respond with Access-Accept with the new policy on rate/bandwidth enforcement.

WLC will forward these new QoS parameters to AP using existing AP AAA QOS PARAMS PAYLOAD

AP will apply the new QoS values to the flex local switched client.

There will not be any Disassociation / De-Authentication message sent from WLC or AP to the end client.

Work Flow

Client AP

| High Data Rate

WLC

Periodic client’s stats

New QoS / Rate limit
payload

A ing-Interim

AAA

Col — Request

reached

Billing Server

quota limit

CoA - Response (NAK)

Access - Request

Access — Response

Low Data Rate

cisco

Configuration from GUI

Step 1
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Cisco

MONITOR ~ WLANs

CONTROLLER

Configuration from GUI .

WIRELESS  SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Security

w AAA

w RADIUS
Authentication

~ Accounting
Fallback
DNS
Downloaded AVP
» TACACS+
LDAP
Local Net Users
MAC Filtering
w Disabled Clients
User Login Policies
AP Policies
Password Policies

-

Local EAP
Advanced EAP
Priority Order

v w

Certificate

-

Access Control Lists

Wireless Protection
Policies

-

Web Auth

vy ¥

TrustSec

I ncal Policies

Server Index (Priority)

Server 1P Address{Ipvd/Ipvs)
Shared Secret Format

Shared Secret

Confirm Shared Secret

Apply Cisco ISE Default settings
Apply Cisco ACA Default settings
Key Wrap

Port Number

RADIUS Authentication Servers > New

2 ¥

|10.91.104.106

[ascu v]

I (Designed for FIPS customers and requires a key wrap compliant RADIUS server)

:£812

Server Status

Support for CoA

;:.E_nab_ied v

Enabled |

Server Timeout

Network User

Management

Management Retransmit Timeout
Tunnel Proxy

PAC Provisioning

1PSec

Cisco ACA

s | seconds
¥ Enable
¥ Enable
|s |seconds
] Enable

=) Enable

Enable
Enable

On the WLAN choose the AAA override option as shown below.

Cisco

MONITOR  WLANs

CONTROLLER

WIRELESS SECURITY MANAGEME

b Advanced

WLANSs > Edit 'Mobility’

g —Advanced :

Allow AAA Override

Aironet IE

Enable Session Timeout

Diagnostic Channel 18

| Enabled
W Enabled
lsoo |
Session Timeout (secs)
¥ Enabled

\Enabled
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CHAPTER 3

Design Considerations

This chapter describes important design considerations and provides an example of a wireless mesh design.

Each outdoor wireless mesh deployment is unique, and each environment has its own challenges with available
locations, obstructions, and available network infrastructure. Design requirements driven by expected users,
traffic, and availability needs are also major design criteria. This chapter contains the following sections:

» Wireless Mesh Constraints, on page 37
* Controller Planning, on page 41

Wireless Mesh Constraints

The following are a few system characteristics to consider when you design and build a wireless mesh network.
Some of these characteristics apply to the backhaul network design and others to the CAPWAP controller
design:

Wireless Backhaul Data Rate

Backhaul is used to create only the wireless connection between the access points. The backhaul interface is
802.11a/n/ac/g depending upon the access point. The rate selection is important for effective use of the available
RF spectrum. The rate can also affect the throughput of client devices, and throughput is an important metric
used by industry publications to evaluate vendor devices.

Dynamic Rate Adaptation (DRA) introduces a process to estimate optimal transmission rate for packet
transmissions. It is important to select rates correctly. If the rate is too high, packet transmissions fail resulting
in communication failure. If the rate is too low, the available channel bandwidth is not used, resulting in
inferior products, and the potential for catastrophic network congestion and collapse.

Data rates also affect the RF coverage and network performance. Lower data rates, for example 6 Mbps, can
extend farther from the access point than can higher data rates, for example 1300 Mbps. As a result, the data
rate affects cell coverage and consequently the number of access points required. Different data rates are
achieved by sending a more redundant signal on the wireless link, allowing data to be easily recovered from
noise. The number of symbols sent out for a packet at the 1-Mbps data rate is higher than the number of
symbols used for the same packet at 11 Mbps. Therefore, sending data at the lower bit rates takes more time
than sending the equivalent data at a higher bit rate, resulting in reduced throughput.

A lower bit rate might allow a greater distance between MAPs, but there are likely to be gaps in the WLAN
client coverage, and the capacity of the backhaul network is reduced. An increased bit rate for the backhaul
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network either requires more MAPs or results in a reduced SNR between MAPs, limiting mesh reliability and
interconnection.

Note The data rate can be set on the backhaul on a per AP basis. It is not a global command.

The required minimum LinkSNR for backhaul links per data rate is shown in Table 1: Backhaul Data Rates
and Minimum LinkSNR Requirements, on page 38.

Table 1: Backhaul Data Rates and Minimum LinkSNR Requirements

802.11a Data Rate (Mbps) Minimum Required LinkSNR (dB)
54 31
48 29
36 26
24 22
18 18
12 16
9 15
6 14

* The required minimum LinkSNR value is driven by the data rate and the following formula: Minimum
SNR + fade margin.

Table 2: Backhaul Data Rates and Minimum LinkSNR Requirements for 802.11n, on page 38 summarizes
the calculation by data rate.

* Minimum SNR refers to an ideal state of noninterference, nonnoise, and a system packet error rate
(PER) of no more than 10 percent.

* Typical fade margin is approximately 9 to 10 dB.
Minimum Required LinkSNR Calculations by Data Rate

Table 2: Backhaul Data Rates and Minimum LinkSNR Requirements for 802.11n

802.11n Date Rate (Mbps) Spatial Stream Minimum Required LinkSNR (dB)
15 1 9.3
30 1 11.3
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802.11n Date Rate (Mbps) Spatial Stream Minimum Required LinkSNR (dB)
45 1 133
60 1 17.3
90 1 213
120 1 243
135 1 26.3
157.5 1 273
30 2 12.3
60 2 14.3
90 2 16.3
120 2 20.3
180 2 243
240 2 27.3
270 2 293
300 2 30.3

* [f we take into account the effect of MRC for calculating Minimum Required Link SNR. Table 3: Required
LinkSNR Calculations for 802.11a/g, on page 39 shows the required LinkSNR for 802.11a/g (2.4 GHz

and 5 GHz) for AP1552 and 1522 with 3 Rx antennas (MRC gain).

LinkSNR = Minimum SNR - MRC + Fade Margin (9 dB)

Table 3: Required LinkSNR Calculations for 802.11a/g

802.11a/g MCS | Modulation Minimum SNR | MRC Gainfrom 3 | Fade Margin Required Link
(Mbps) (dB) RXs (dB) (dB) SNR (dB)

6 BPSK 1/2 5 4.7 9 9.3

9 BPSK 3/4 6 4.7 9 10.3

12 QPSK 1/2 7 4.7 9 11.3

18 QPSK 3/4 9 4.7 9 13.3

24 16QAM 1/2 13 4.7 9 17.3

36 16QAM 3/4 17 4.7 9 213

48 64QAM 2/3 20 4.7 9 243

54 64QAM 3/4 22 4.7 9 26.3
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If we consider only 802.11n rates, then Table 4: Requirements for LinkSNR with AP1552 for 2.4 and 5 GHz,
on page 40 shows LinkSNR requirements with AP1552 for 2.4 and 5 GHz.

Table 4: Requirements for LinkSNR with AP1552 for 2.4 and 5 GHz

No. of Spatial | 11n MCS Modulation | Minimum MRC Gain Fade Margin |Link SNR (dB)
Streams SNR (dB) from3RXs |(dB)

(dB)
1 MCS 0 BPSK 1/2 5 4.7 9 9.3
1 MCS 1 QPSK 1/2 7 4.7 9 11.3
1 MCS 2 QPSK 3/4 9 4.7 9 13.3
1 MCS 3 16QAM 1/2 |13 4.7 9 17.3
1 MCS 4 16QAM 3/4 |17 4.7 9 21.3
1 MCS 5 64QAM 2/3 |20 4.7 9 243
1 MCS 6 64QAM 3/4 |22 4.7 9 26.3
1 MCS 7 64QAM 5/6 |23 4.7 9 27.3
2 MCS 8 BPSK 1/2 5 1.7 9 12.3
2 MCS 9 QPSK 1/2 7 1.7 9 14.3
2 MCS 10 QPSK 3/4 9 1.7 9 16.3
2 MCS 11 16QAM 1/2 |13 1.7 9 20.3
2 MCS 12 16QAM 3/4 |17 1.7 9 24.3
2 MCS 13 64QAM 2/3 |20 1.7 9 27.3
2 MCS 14 64QAM 3/4 |22 1.7 9 29.3
2 MCS 15 64QAM 5/6 |23 1.7 9 30.3
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\}

Note  With two spatial streams, the MRC gain is halved, that is the MRC gain is reduced by 3 dB. This is because
the system has 10 log (3/2 SS) instead of 10 log (3/1 SS). If there were to have been 3 SS with 3 RX, then the
MRC gain would have been zero.

* Number of backhaul hops is limited to eight but we recommend three to four hops.

The number of hops is recommended to be limited to three or four primarily to maintain sufficient
backhaul throughput, because each mesh access point uses the same radio for transmission and reception
of backhaul traffic, which means that throughput is approximately halved over every hop. For example,
the maximum throughput for 24 Mbps is approximately 14 Mbps for the first hop, 9 Mbps for the second
hop, and 4 Mbps for the third hop.

* Number of MAPs per RAP.

There is no current software limitation on how many MAPs per RAP you can configure. However, it is
suggested that you limit the number to 20 MAPs per RAP.

* Number of controllers

* The number of controllers per mobility group is limited to 72.

» Number of mesh access points supported per controller.

Controller Planning

The following items affect the number of controllers required in a mesh network:
* Mesh access points (RAPs and MAPs) in the network.

The wired network that connects the RAP and controllers can affect the total number of access points
supported in the network. If this network allows the controllers to be equally available to all access points
without any impact on WLAN performance, the access points can be evenly distributed across all
controllers for maximum efficiency. If this is not the case, and controllers are grouped into various clusters
or PoPs, the overall number of access points and coverage are reduced.

» Number of mesh access points (RAPs and MAPs) supported per controller. See Table 5: Mesh Access
Point Support by Controller Model , on page 41.

For clarity, nonmesh access points are referred to as local access points in this document.

Table 5: Mesh Access Point Support by Controller Model

Controller Model Local AP Support (nonmesh) Maximum Possible
Mesh AP Support

55082 500 500

2504° 75 75

3504 150 150
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Controller Model Local AP Support (nonmesh) Maximum Possible
Mesh AP Support

WiSM2 500 500

5520 1500 1500

8540 6000 6000

! Local AP support is the total number of nonmesh APs supported on the controller model.
2 For 5508, controllers, the number of MAPs is equal to (local AP support - number of RAPs).
3 For 2504, controllers, the number of MAPs is equal to (local AP support - number of RAPs).

N

Note Mesh is fully supported on Cisco 2500, 3504, 5508, 5520, 8540 and WiSM-2 Controllers. The Base License
(LIC-CT508-Base) is sufficient for indoor and outdoor APs. The WPlus License (LIC-WPLUS-SW) is merged
with the base license. The WPlus License is not required for indoor mesh APs.
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* Air Time Fairness in Mesh Deployments Rel 8.4, on page 43

Air Time Fairness in Mesh Deployments Rel 8.4

This section of the document introduces the ATF on Mesh APs and provides guidelines for its deployment.
The purpose of this section is to:

* Provide an overview of ATF on Mesh APs
* Highlight supported Key Features
* Provide details on deploying and managing the ATF on Mesh APs

Pre-requisite and Supported Features in 8.4 release

Mesh ATF is supported on AireOS 8.4 or higher release on a Wireless LAN Controller . Mesh ATF is supported
on 1550/128, 1570 and all other IOS based APs.

AP 1550 (64 1550 (128 1570 3700 1530 1540 1560
MB) MB)

Feature — — — — — — —

Basic Mesh | Yes Yes Yes Yes Yes Yes 8.4

Flex+Mesh | Yes Yes Yes Yes Yes No No

Fast No 8.3 8.3 Yes 8.3 No 8.4

Convergence

(background

scanning)

Wired Yes Yes Yes No Yes No No

Clients on

RAP

Wired Yes Yes Yes No Yes No 8.4

Clients on

MAP
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AP 1550 (64 1550 (128 1570 3700 1530 1540 1560
MB) MB)

Daisy 7.6 7.6 7.6 No 7.6 No No

Chain

LSC Yes Yes Yes Yes Yes No No

PSK 8.2 8.2 8.2 8.2 8.2 8.5 8.4

provisioning:

MAP-RAP

authentication

ATF on No 8.4 8.4 8.4 No No No

Mesh

Cisco Air Time Fairness (ATF) Use Cases

Public Hotspots (Stadium/Airport/Convention Center/Other)

In this instance a public network is sharing a WLAN between two (or more) service providers and the venue.
Subscribers to each service provider can be grouped and each group can be allocated a certain percentage of
airtime.

Education

In this instance, a university is sharing a WLAN between students, faculty, and guests. The guest network
can be further partitioned by service provider. Each group can be assigned a certain percentage of airtime.

Enterprise or Hospitality or Retail

In this instance, the venue is sharing a WLAN between employees and guests. The guest network can be
further partitioned by service provider. The guests could be sub-grouped by tier of service type with each
subgroup being assigned a certain percentage of airtime, for example a paid group is entitled to more airtime
than the free group.

Time Shared Managed Hotspot

In this instance, the business entity managing the hotspot, such as a service provider or an enterprise, can
allocate and subsequently lease airtime to other business entities.

ATF Functionality and Capabilities

ATF Functionality and Capabilities:

* ATF policies are applied only in the downlink direction (AP transmitting frames to client). Only airtime
in the downlink direction, that is AP to client, can be controlled accurately by the AP. Although airtime
in the uplink direction, that is client to AP, can be measured, it cannot be strictly controlled. Although
the AP can constrain airtime for packets that it sends to clients, the AP can only measure airtime for
packets that it 'hears' from clients because it cannot strictly limit their airtime

* ATF policies are applied only on wireless data frames; management and control frames gets ignored

* When ATF is configured per-SSID, each SSID is granted airtime according to the configured policy

» ATF can be configured to either drop or defer frames that exceed their airtime policies. If the frame is
deferred, it will be buffered and transmit at some point in the future when the offending SSID has a
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sufficient airtime budget. Of course, there is a limit as to how many frames can be buffered. If this limit
is crossed, frames will be dropped regardless

* ATF can be globally enabled or disabled
* ATF can be enabled or disabled on an individual access point, AP group or entire network
* Allocation is applied Per SSID and Per Client

* Applies to Downstream only

* Can be configured in WLC GUI/CLI and PI

* Can be applied to all APs on a Network to AP Group or one AP

* Supported on APs in Local mode: AP1260, 1550-128Mb,1570, 1700, 2600, 2700, 3500, 3600, 3700

Total “Air Time”
Total Air Quality Wi-Fi Interference
£ ssakleding) - -
‘ per AP Wi-Fi traﬁ'lc P _7—“\—__‘1__1
vL aggregrate (or individual) —=se -

Data Frames Management Frames Control
Baacons (down) Frames

Data (down) Proba Responses (up/down)

Zero, one, multiple retries, abandoned, dropped CTS (down)
RTS (up)
Data (up) ACKs.
Discarded, error, duplicate

| =" ——alal airtime (data) Total airtime (mamt) Total airtime (ctrl) )

SSID #1 SSID #2 ssiD#3 |
- ¥% allocats ) ion (2% allocati
/ 7¥%7_71‘i—1$

Client #1 Client #2 ‘ Client #3 ‘ Client #4
o allocati A% allocati A% allocati A% allocati

A%

ATF on Mesh Feature Overview

AirTime Fairness on Mesh Aps feature is very close conceptually to the ATF feature support release for Local
Aps in theprevious releases. We are strongly recommend to review that feature and deployment steps in the
guide at http://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Air Time Fairness Phasel
and Phase2 Deployment Guide.html

At the present time, enterprise class, high density stadium and other major Wi-Fi deployments with Cisco
IOS 11n, 11ac Indoor APs are benefited by "per SSID" based Airtime Fairness and "per Client within a SSID"
based Airtime Fairness through 8.1 MR1 and 8.2 releases.

In a same way, currently, there is a demand from the Customers with large scale Outdoor wireless mesh
deployments to serve their users by providing fairness among the Wi-Fi users across the Outdoor wireless
mesh network in utilizing the AP radio Airtime downstream and also provide administrators the key control
to enforce SLA (implied on multiple cellular operator through Wi-Fi hotspot) on the Wi-Fi users across the
Outdoor wireless mesh network. However, since all Wi-Fi users traffic is bridged between MAPs and RAPs
through the wireless backhaul radio and there is no SSID concept on wireless backhaul radio for backhaul
nodes to enforce policies through SSID's for each backhaul node, there is no easy solution for Wi-Fi users
across the Outdoor wireless mesh network to get treated fairly in terms of utilizing the Wi-Fi airtime through
their Outdoor Wireless Mesh Aps. As far as the clients on client access radios are concerned, it's fairly simple

Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8 .


http://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Air_Time_Fairness_Phase1_and_Phase2_Deployment_Guide.html
http://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Air_Time_Fairness_Phase1_and_Phase2_Deployment_Guide.html

Air Time Fairness in Mesh Deployments rel 8.4 |
. ATF on Mesh Feature Overview

to regulate the airtime fairness through SSIDs (w/ or w/o client fair sharing) in a similar way how it is done
for Cisco unified local mode APs.

Before the solution overview of supporting ATF on mesh, lets quickly recap ATF - Airtime Fairness (ATF)
is basically a concept which provides an ability to regulate/enforce the AP radio airtime in downstream
direction for the clients associated through the SSID's. As a result, the Wi-Fi users on wireless network are
fairly treated in terms of utilizing the radio WiFi radio airtime. This basically provides the key control either
to enforce SLA additionally or simply to avoid certain group or individual from occupying an unfair amount
of WiF1i airtime on a particular or on a given AP radio. A service level agreement (SLA) is a contract between
a service provider (either internal or external) and the end user that defines the level of service expected from
the service provider. SLAs are output-based in that their purpose is specifically to define what the customer
will receive.

In general, in the Mesh architecture, the Mesh Aps (Parents, child MAPs) in a Mesh Tree will be accessing
the same channel (let's forget about extended sub-backhaul radios for a minute) on backhaul radio for mesh
connectivity between Parents and child Maps. Whereas, the Root AP will be connected wired to the controller
and MAPs will be connected wireless to the controller. Hence all the CAPWAP, Wi-Fi traffic will be bridged
to the controller through the wireless backhaul radio and through RAP. In terms of the physical locations,
normally the RAPs will be placed at roof top and the MAPs in multiple hops will be placed some distance
apart within each other based on the Mesh network segmentation guidelines. Hence each MAP in a Mesh tree
can provide 100% of their own radio airtime downstream to their users though each MAP accessing the same
medium. To compare this in non-mesh scenario, where there can be neighboring local mode unified Aps in
the arena next to each other in different rooms serving to their respective clients on the same channel with
each providing 100% radio airtime downstream. Therefore, ATF has no control over enforcing clients in two
different neighboring AP's accessing the same medium. Similarly, it's applicable for MAPs in a Mesh tree.
For Outdoor/Indoor Mesh Aps, Airtime fairness must be supported on client access radios which serve regular
clients as same as how we currently support ATF on non-mesh unified local mode Aps to serve the clients
and additionally it must also be supported on backhaul radios which bridge the traffic to/from the clients on
client access radios to RAPs (one hop) or through MAPs to RAPs (multiple hops). Its bit tricky to support
ATF on backhaul radio's using the same SSID/Policy/Weight/Client fair sharing model. Since backhaul radio's
doesn't have SSIDs and it always bridges traffic through their hidden backhaul nodes. Henceforth, on the
backhaul radios either in RAP or MAP, the radio airtime downstream will be fair shared equally based on the
number of backhaul nodes. This approach eliminates the problem and provides fairness to users across wireless
mesh network in the case where the clients associated to 2™ hop MAP can stall the clients associated to 1%
hop MAP where nd hop MAP is connected wireless to 1% hop MAP through backhaul radio though the Wi-Fi
users in the MAPs are separated by a physical location. In the scenario, when a backhaul radio has an option
to serve normal clients through universal client access feature, ATF considers the regular clients into single
node and group them into it. It enforces the Airtime by equally fair sharing the radio airtime downstream
based on the number of nodes (backhaul nodes + single node for regular clients). We will see more details
how this solution is turned into design in the next sections.
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Mesh ATF Optimization on the Backhaul
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. ATF Modes of Operation

ATF Modes of Operation

The Framework behind the ATF monitor mode is to allow the user to view and get the stats of overall Air
Time being used i.e. to report the Air Time usage for all the AP transmissions. The ATF in monitor mode can
be enabled on following levels.

* Disable Mode: By default ATF is disabled on the WLC

* Monitor Mode: To monitor airtime usage on your network

» Enforce—Policy Mode: Assigning ATF policies on your network
* Strict Enforcement

* Optimized

Configuring ATF on Mesh

To configure, ATF on mesh, perform the following steps:

Step 1 Backhaul Client Access- enable/disable.

(5520-MA1)

CIsCO MONITOR  WILANs CONTROLLER  WIRELESS' SECURITY] MANAGEMENT

Wireless Mesh

+ Access Points

All APs General
= Radios
802.11a/nfac Range [RootAP to MeshAP) (12000 feet
B02.11bfg/n
Dual-Band Radios Eikﬁ:l\e ibidacke ™ Enabled
S SR Backhaul Client Access I Enabled
b Advanced
Extended Backhaul Client Access ™ Enabled
Mesh DCA Channels L I Enabled
b ATF
Global Public Safety I Enabled
RF Profiles
Mesh Backhaul RRM I Enabled
FlexConnect Groups Outdoor Ext, UNII B Domain -
FlexConnect ACLs Channels Enabled
FlexConnect VLAN
Templates

Mesh RAP Downlink Backhaul

AR AS -

Step 2 RAP Downlink Backhaul configure 5 or 2.4 GHz

=Erlilpc i - onfig mesh bac
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Step 3

Step 4

Configuring ATF on Mesh .

!".I'I.i
CISCO MONITOR  WILANs CONTROLLER WIRELESS SECURITY MANAGE
Wireless
General
+ Access Points
All APs Range (RootAP to MeshAP) 12000 feet
= Radios IDS(Rogue and Signature
802.11a/n/ac Detection) Enabied
802.11b/g/n Backhaul Client Access ¥ Enabled
Dual-Band Radios
Global Configuration Extended Backhaul Client Access Enabled
b Advanced Mesh DCA Channels 4 Enabled
Global Public Safety Enabled
P ATF Mesh Backhaul RRM ¥ Enabled
. Qutdoor Ext. UNIT B Domain
RF Profiles chanhals Enabled
FlexConnect Groups
FlexConnect ACLs Mesh RAP Downlink Backhaul
FlexConnect VLAN
Templates RAP Downlink Backhaul 2
DELY - ALLe ® 5GHz 2.4 GHz
MNetwork Lists

b BO2.11a/n/fac Enable

Create ATF Policy with Weight and Client Sharing

(5520-MA1}) >»>config atf 802.11a mode ?

di=able Disable=s ATF
enforce-policy Configure=s ATF in enforcement mode
monitor Configure=s ATF in monitor mode

(5520-MAn1})

(S520-MR1)
alia]e
cIsco ; WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS  HELP
Wireless ATF Policy Configuration
¥ Access Points
All APs 4 : % X
P s Id Name Weight  Client Fair Sharing
BloLinnin 0 v Default 10 v create|  Modify | Delete
802.11b/g/n
Dual-Band Radios
Global Configuration
» Advanced
Entries 1 -4 of 4
Mesh
* ATF ID Name Weight Client Fair sharing
Policy Configuration O Default 1y Enabled
- orcerment mode. 1 Mesh ATF 50 Enabled
Mesh Configuration
ATF Statistics 2 atf20 20 Enabled
3 atfan 80 Enabled

RF Profiles

Configure Enforcement mode per AP/AP Group/Network with Enforcement type and WLAN and Policy applied.
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Step 5

Figure 10:

(5520-MR1)

alialn
CISCOo

Wireless

* Access Points
All APs
w Radies
802.11a/nfac
802.11b/g/n
Dual-Band Radios
Global Configuration

» Advanced
Mesh

v ATF
Monitor Mode

N

Enforcement Mode

ATF Statistics
RF Profiles

FlexConnect Groups
FlexConnect ACLs
FlexConnect VLAN
Templates

OEAP ACLs

Network Lists
¥ 802.11a/n/ac
b 802.11b/g/n
b Media Stream

Application Visibility

And Control

Lync Server
Country

WIRELESS

MONITOR ~ WLANs CONTROLLER

ATF Enforcement Mode Configuration

C AP Name [ Mene -
¢ AP Group Name [None 1
C  Network

Radio Type

T soz2.11a T so02.11b

4

® optimized ©  Strict

Enforcement Type

Mode

Enable I Disable i

Policy Enforcement %

WLAN Id [None SSID Name |

Policy Id [None 5| Policy Name |

Add | Set to Default |

Configure Mesh Universal Access Client Airtime Allocation.

> config ap atf 802.1la client-access airtime-allocation <5 - 90> <ap-name> override enable

/disable

> config ap atf 802.11b client-access airtime-allocation <5 - 90> <ap-name> override enable/disable
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ONITOR WL

Configuring ATF on Mesh .

COMMANDS HELP FEED

Wireless

v Access Points
All APs
» Radios
802.11a/n/fac
802.11b/g/n
Dual-Band Radios
Global Configuration

b Advanced
Mesh

v ATF
Monitor Mode
Policy Configuration

RF Profiles

Mesh Universal Access Client Airtime Allocation

|vS1_mapl_ap1572

-[s02.11a 5

AP Name
v51_map_ap3700
wS1_map_ap3700
v51_maplc ap3700
v51_maplc_ap3700
vS1_maplb_ap370C
v51_maplb_ap370C
vS51_mapl_ap3700

e Default % Alloc Per Node No of Node:

10

h !

Radio Type No of Nodes

802.11b
802.11a
802.11b
802.11a
802.11b
802.11a
802.11b

0

o o o o o o

Default %
Alloc Per Node

100
100
100
100
100
100
100

o

Current %
e ¥

Override Override allocation on clie

30 (5% - 90%)

!

,TI

Current %
m "

Client Access Node
NA

NA

NA

NA

NA

5

NA

on
Backhaul Node
NA
NA
NA
NA
NA
95
NA
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CHAPTER 5

Site Preparation and Planning

This chapter describes the site preparation and planning for your mesh network and contains the following
sections:

» Site Survey, on page 53

» Wireless Mesh Network Coverage Considerations, on page 60
* Indoor Mesh Interoperability with Outdoor Mesh, on page 83

Site Survey

We recommend that you perform a radio site survey before installing the equipment. A site survey reveals
problems such as interference, Fresnel zone, or logistics problems. A proper site survey involves temporarily
setting up mesh links and taking measurements to determine whether your antenna calculations are accurate.
Determine the correct location and antenna before drilling holes, routing cables, and mounting equipment.

N

Note When power is not readily available, we recommend you to use an unrestricted power supply (UPS) to
temporarily power the mesh link.

Pre-Survey Checklist
Before attempting a site survey, determine the following:
* How long is your wireless link?
* Do you have a clear line of sight?
* What is the minimum acceptable data rate within which the link runs?
* [s this a point-to-point or point-to-multipoint link?
* Do you have the correct antenna?
* Can the access point installation area support the weight of the access point?
* Do you have access to both of the mesh site locations?

* Do you have the proper permits, if required?
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* Do you have a partner? Never attempt to survey or work alone on a roof or tower.

* Have you configured the 1500 series before you go onsite? It is always easier to resolve configuration
or device problems first.

* Do you have the proper tools and equipment to complete your task?

N

Note Cellular phones or handheld two-way radios can be helpful to do surveys.

Outdoor Site Survey

Deploying WLAN systems outdoors requires a different skill set to indoor wireless deployments. Considerations
such as weather extremes, lightning, physical security, and local regulations need to be taken into account.

When determining the suitability of a successful mesh link, define how far the mesh link is expected to transmit
and at what radio data rate. Remember that the data rate is not directly included in the wireless routing
calculation, and we recommend that the same data rate is used throughout the same mesh.

Design recommendations for mesh links are as follows:

* MAP deployment cannot exceed 35 feet in height above the street.

* MAPs are deployed with antennas pointed down toward the ground.

* Typical 5-GHz RAP-to-MAP distances are 1000 to 4000 feet.

* RAP locations are typically towers or tall buildings.

* Typical 5-GHz MAP-to-MAP distances are 500 to 1000 feet.

* MAP locations are typically short building tops or streetlights.

* Typical 2.4-GHz MAP-to-client distances are 500 to 1000 feet (depends upon the type of access point).

* Clients are typically laptops, Smart Phones, Tablets, and CPEs. Most of the clients operate in the 2.4-GHz
band.

* In release 8.2 and above 2.4GHz radios can be used for backhaul and slightly longer distances can be
achieved; howver at the same time lower throughput is expected.

Determining a Line of Sight

When you determine the suitability of a successful link, you must define how far the link is expected to
transmit and at what radio data rate. Very close links, one kilometer or less, are fairly easy to achieve assuming
there is a clear line of sight (LOS)—a path with no obstructions.

Because mesh radio waves have very high frequency in the 5-GHz band, the radio wavelength is small;
therefore, the radio waves do not travel as far as radio waves on lower frequencies, given the same amount
of power. This higher frequency range makes the mesh ideal for unlicensed use because the radio waves do
not travel far unless a high-gain antenna is used to tightly focus the radio waves in a given direction.

This high-gain antenna configuration is recommended only for connecting a RAP to the MAP. To optimize
mesh behavior, omnidirectional antennas are used because mesh links are limited to one mile (1.6 km). The
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Weather

Fresnel Zone

Weather .

curvature of the earth does not impact line-of-sight calculations because the curvature of the earth changes
every six miles (9.6 km).

In addition to free space path loss and line of sight, weather can also degrade a mesh link. Rain, snow, fog,
and any high humidity condition can slightly obstruct or affect the line of sight, introducing a small loss
(sometimes referred to as rain fade or fade margin), which has little effect on the mesh link. If you have
established a stable mesh link, the weather should not be a problem; however, if the link is poor to begin with,
bad weather can degrade performance or cause loss of link.

Ideally, you need a line of sight; a white-out snow storm does not allow a line of sight. Also, while storms
may make the rain or snow itself appear to be the problem, many times it might be additional conditions
caused by the adverse weather. For example, perhaps the antenna is on a mast pipe and the storm is blowing
the mast pipe or antenna structure and that movement is causing the link to come and go, or there might be a
large build-up of ice or snow on the antenna.

A Fresnel zone is an imaginary ellipse around the visual line of sight between the transmitter and receiver.
As radio signals travel through free space to their intended target, they could encounter an obstruction in the
Fresnel area, degrading the signal. Best performance and range are attained when there is no obstruction of
this Fresnel area. Fresnel zone, free space loss, antenna gain, cable loss, data rate, link distance, transmitter
power, receiver sensitivity, and other variables play a role in determining how far your mesh link goes. Links
can still occur as long as 60 percent to 70 percent of the Fresnel area is unobstructed, as illustrated in Figure
11: Point-to-Point Link Fresnel Zone, on page 55.

Figure 11: Point-to-Point Link Fresnel Zone

Figure 12: Typical Obstructions in a Fresnel Zone, on page 55 illustrates an obstructed Fresnel zone.

Figure 12: Typical Obstructions in a Fresnel Zone
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It is possible to calculate the radius of the Fresnel zone (in feet) at any particular distance along the path using
the following equation:

F1 =72.6 X square root (d/4 x f)

where

F1 = the first Fresnel zone radius in feet
D = total path length in miles

F = frequency (GHz)

Normally, 60 percent of the first Fresnel zone clearance is recommended, so the above formula for 60 percent
Fresnel zone clearance can be expressed as follows:

0.60 F1=43.3 x square root (d/4 x f)
These calculations are based on a flat terrain.

Figure 13: Removing Obstructions in a Fresnel Zone, on page 56 shows the removal of an obstruction in the
Fresnel zone of the wireless signal.

Figure 13: Removing Obstructions in a Fresnel Zone

14=dmd

Fresnel Zone Size in Wireless Mesh Deployments

To give an approximation of size of the maximum Fresnel zone to be considered, at a possible minimum
frequency of 4.9 GHz, the minimum value changes depending on the regulatory domain. The minimum figure
quoted is a possible band allocated for public safety in the USA, and a maximum distance of one mile gives
a Fresnel zone of clearance requirement of 9.78 ft = 43.3 x SQR(1/(4*4.9)). This clearance is relatively easy
to achieve in most situations. In most deployments, distances are expected to be less than one mile, and the
frequency greater than 4.9 GHz, making the Fresnel zone smaller. Every mesh deployment should consider
the Fresnel zone as part of its design, but in most cases, it is not expected that meeting the Fresnel clearance
requirement is an issue.

Hidden Nodes Interference

The mesh backhaul uses the same 802.11a channel for all nodes in that mesh, which can introduce hidden
nodes into the WLAN backhaul environment.
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Hidden Nodes Interference .

Figure 14: Hidden Nodes

.
1424351

Figure 14: Hidden Nodes, on page 57 shows the following three MAPs:
* MAP X

* MAPY
* MAP Z

If MAP X is the route back to the RAP for MAP Y and Z, both MAP X and MAP Z might be sending traffic
to MAP Y at the same time. MAP Y can see traffic from both MAP X and Z, but MAP X and Z cannot see
each other because of the RF environment, which means that the carrier sense multi-access (CSMA) mechanism
does not stop MAP X and Z from transmitting during the same time window; if either of these frames is
destined for a MAP, it is corrupted by the collision between frames and requires retransmission.

Although all WLANS at some time can expect some hidden node collisions, the fixed nature of the MAP

makes hidden node collisions a persistent feature of the mesh WLAN backhaul under some traffic conditions
such as heavy loads and large packet streams.

Both the hidden node problem and the exposed node problem are inherent to wireless mesh networks because
mesh access points share the same backhaul channel. Because these two problems can affect the overall
network performance, the Cisco mesh solution seeks to mitigate these two problems as much as possible. For
example, the AP1500s have at least two radios: one for backhaul access on a 5-GHz channel and the other
for 2.4-GHz client access. In addition, the radio resource management (RRM) feature, which operates on the
2.4-GHz radio, enables cell breathing and automatic channel change, which can effectively decrease the
collision domains in a mesh network.

There is an additional solution that can help to further mitigate these two problems. To reduce collisions and
to improve stability under high load conditions, the 802.11 MAC uses an exponential backoff algorithm,
where contending nodes back off exponentially and retransmit packets whenever a perceived collision occurs.
Theoretically, the more retries a node has, the smaller the collision probability will be. In practice, when there
are only two contending stations and they are not hidden stations, the collision probability becomes negligible
after just three retries. The collision probability increases when there are more contending stations. Therefore,
when there are many contending stations in the same collision domain, a higher retry limit and a larger
maximum contention window are necessary. Further, collision probability does not decrease exponentially

when there are hidden nodes in the network. In this case, an RTS/CTS exchange can be used to mitigate the
hidden node problem.
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Preferred Parent Selection

You can configure a preferred parent for a MAP. This feature gives more control to you and enables you to
enforce a linear topology in a mesh environment. You can skip AWPP and force a parent to go to a preferred
parent.

Preferred Parent Selection Criteria
The child AP selects the preferred parent based on the following criteria:

* The preferred parent is the best parent.
* The preferred parent has a link SNR of at least 20 dB (other parents, however good, are ignored).

* The preferred parent has a link SNR in the range of 12 dB and 20 dB, but no other parent is significantly
better (that is, the SNR is more than 20 percent better). For an SNR lower than 12 dB, the configuration
is ignored.

* The preferred parent is not blacklisted.
* The preferred parent is not in silent mode because of dynamic frequency selection (DFS).

* The preferred parent is in the same bridge group name (BGN). If the configured preferred parent is not
in the same BGN and no other parent is available, the child joins the parent AP using the default BGN.

Configuring a Preferred Parent

To configure a preferred parent, enter the following command:
(Cisco Controller) > config mesh parent preferred AP name MAC

where:
* AP name is the name of the child AP that you have to specify.

* MAC is the MAC address of the preferred parent that you have to specify.

N

Note When you configure a preferred parent, ensure that you specify the MAC address
of the actual mesh neighbor for the desired parent. This MAC address is the base
radio MAC address that has the letter f as the final character. For example, if the
base radio MAC address is 00:24:13:0£:92:00, then you must specify
00:24:13:01:92:0f as the preferred parent. This is the actual MAC address that is
used for mesh neighbor relationships.

The following example shows how to configure the preferred parent for the MAP1SB access point, where
00:24:13:0£:92:00 is the preferred parent’s MAC address:

(Cisco Controller) > config mesh parent preferred MAPISB 00:24:13:0£:92:0f
To configure a preferred parent using the controller GUI, follow these steps:

1. Choose Wireless > Access Points > AP_ NAME > Mesh.
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\}

Related Commands .

2. Enter the MAC address of the preferred parent in the Preferred Parent text box.

Note

\}

To clear the Preferred Parent value, enter none in the Preferred Parent Text box.

3. Click Apply.

Note

When the preferred parent is entered, no other mesh configurations can be made at the same time. You must
apply the changes and wait for 90 seconds before other mesh changes can be made.

Related Commands

The following commands are related to preferred parent selection:

* To clear a configured parent, enter the following command:

(Cisco Controller) > config mesh parent preferred AP name none

* To get information about the AP that is configured as the preferred parent of a child AP, enter the following
command:

(Cisco Controller) > show ap config general AP name

The following example shows how to get the configuration information for the MAP1SB access point, where
00:24:13:0£:92:00 is the MAC address of the preferred parent:

(Cisco Controller) > show ap config general mari

Cisco AP Identifier.....c.iiiiiiiiiiininninnennns 9

CiSCO AP NaM . sttt ittt ittt it it it it in e ennenennn MAP1

O35 o o € Y L US - United States
Regulatory Domain allowed by Country............. 802.11bg:-A 802.11la:-A
AP COUNLrY COAE. it ittt it ittt e ieinnneeeennnees US - United States
AP Regulatory DOmMain.......ueeiiiininnennenneenenn 802.11bg:-A 802.11la:-A
Switch Port Number ..........c.i.iiiuiiiiiininnnnnnn 1

MAC AdAreSS . it ii ittt ittt ittt 12:12:12:12:12:12
IP Address Configuration.........ceueeiieneenenn. DHCP

I =V T o = 209.165.200.225

IP NetMasK. o v o ittt ittt ittt it e i i 255.255.255.224
CAPWAP Path MTU. ...ttt ittt ittt 1485

12} 1= 5 o

I = ST L 4 S o

Telnet State..... ..ottt Disabled

Ssh State. ... i i e Disabled

Cisco AP Location......ooiiiiiiiiiiiiiinininnenn. default location
Cisco AP Group Name. ... vi it itn it nenneenns default-group
Primary Cisco Switch Name................o i 4404

Primary Cisco Switch IP Address.................. 209.165.200.230
Secondary Cisco Switch Name............ocvvin..

Secondary Cisco Switch IP Address................ Not Configured
Tertiary Cisco Switch Name............ ... 4404
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Tertiary Cisco Switch IP Address............c.... 3.3.3.3
Administrative State ...t i e ADMIN_ENABLED
Operation State . ...ttt ittt REGISTERED
Mirroring MOde . ...ttt ittt e Disabled
AP MOAE vttt ittt ittt ittt e e e i e e e Local
Public Safety ..ttt e e e Global: Disabled, Local: Disabled
AP SUDMOAE &t ittt ittt ettt i e e WIPS
RemOte AP DEDUG vttt ittt ittt ettt eieeeneennn Disabled
S/W  VerSION vttt ittt ittt et eeeeeeaenn 5.1.0.0
BOOt VersSion ...ttt ittt tiieieeen 12.4.10.0
Mini TOS VersSion ...ttt etnneeneenennenn 0.0.0.0
Stats Reporting Period ........ciuiiiiiiniinnennnn. 180
S = Enabled
PoE Pre-Standard Switch...........iiiiiiiiii.. Enabled
PoE Power Injector MAC Addr........viuiiiinenennn. Disabled
Power TypPe/MOde. vt v ittt ittt ettt et PoE/Low Power (degraded mode)
Number Of SI1OotS. ..ttt ittt ittt tienenns 2
N U (oY AIR-LAP1252AG-A-K9
IO 1S TV ot ST T o 12.4(10:0)
Reset BULLON. .. i i ittt ittt ittt i Enabled
AP Serial Number............iiiiiiinnennnnnnnnnnn serial number
AP Certificate TyPe .ttt i ittt tttieeenennenn Manufacture Installed
Management Frame Protection Validation........... Enabled (Global MFP Disabled)
AP USEr MOAE . i ittt it iittt ittt ettt CUSTOMIZED
AP USETNAME e « ¢ v vt v ettt et et e eeeeeeeeneeneeneenes maria
AP DOtlx User MO . . v ii it i iiiiittiennneeeennnnens Not Configured
AP DOLIX USEIrNAME. ¢ v vt vttt neeteeenneeeeenneenes Not Configured
Cisco AP system logging host.................c.... 255.255.255.255
AP UP TamMe . i ittt it ettt ettt et ettt e eeeeenenn 4 days, 06 h 17 m 22 s
AP LWAPP UPp TimMe . i vttt tt ittt it teeteeeeeeeneenens 4 days, 06 h 15 m 00 s
Join Date and Time. ...ttt i innennennenn Mon Mar 3 06:19:47 2008
Ethernet Port DupleX......o.iiiiiiiiiiinneeeennnns Auto
Ethernet Port Speed...... .t iiiiiiiiiiiiiiinnnns Auto
AP Link LatenCy . ettt n ittt et teneeneenennens Enabled
CUrrent Delay. .ttt ittt ettt eeeenennn 0 ms
Maximum Delay. v e ettt eeneeneeneeneeneenns 240 ms
Minimum Delay. v ettt nttneeeeeneenenneeneenns 0 ms
Last updated (based on AP Up Time) .......ovvuen.. 4 days, 06 h 17 m 20 s
Rogue Detection. .. vttt iiiinennen Enabled
AP TCP MSS AdJUSE .ttt ittt ittt eieeeeeenenn Disabled
Mesh preferred parent........c..oiiiiiiiininnennnnn. 00:24:13:0£:92:00

Co-Channel Interference

In addition to hidden node interference, co-channel interference can also impact performance. Co-channel
interference occurs when adjacent radios on the same channel interfere with the performance of the local mesh
network. This interference takes the form of collisions or excessive deferrals by CSMA. In both cases,
performance of the mesh network is degraded. With appropriate channel management, co-channel interference
on the wireless mesh network can be minimized.

Wireless Mesh Network Coverage Considerations

This section provides a summary of items that must be considered for maximum wireless LAN coverage in
an urban or suburban area, to adhere to compliance conditions for respective domains.

The following recommendations assume a flat terrain with no obstacles (green field deployment).
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We always recommend that you perform a site survey before taking any real estimations for the area and
creating a bill of materials.

Cell Planning and Distance

For the Cisco 1500 Series Access Points

The RAP-to-MAP ratio is the starting point. For general planning purposes, the current ratio is 20 MAPs per
RAP.

We recommend the following values for cell planning and distance in nonvoice networks:

* RAP-to-MAP ratio—Recommended maximum ratio is 20 MAPs per RAP.

» AP-to-AP distance—A spacing of no more than of 2000 feet (609.6 meters) between each mesh access
point is recommended. When you extend the mesh network on the backhaul (no client access), use a cell
radius of 1000 feet (304.8 meters).

* Hop count—Three to four hops.

* One square mile in feet (52802), is nine cells and you can cover one square mile with approximately
three or four hops (see Figure 15: Cell Radius of 1000 Feet and Access Point Placement for Nonvoice
Mesh Networks, on page 61 and Figure 16: Path Loss Exponent 2.3 to 2.7, on page 62.)

* For 2.4 GHz, the local access cell size radius is 600 feet (182.88 meters). One cell size is around 1.310
x 106, so there are 25 cells per square mile. (See Figure 17: Cell Radius of 600 Feet and Access Point
Placement for Nonvoice Mesh Networks, on page 62 and Figure 18: Path Loss Exponent 2.5 to 3.0, on
page 63.)

Figure 15: Cell Radius of 1000 Feet and Access Point Placement for Nonvoice Mesh Networks
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itypical distance)
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One square mile, 9 cells
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Figure 16: Path Loss Exponent 2.3 to 2.7
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Figure 17: Cell Radius of 600 Feet and Access Point Placement for Nonvoice Mesh Networks
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Cell Planning and Distance .

Figure 18: Path Loss Exponent 2.5 to 3.0
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For the Cisco 1550 Series Access Points

As seen in the previous section, we recommend a cell radius of 600 feet, and an AP to AP distance of 1200
feet. Normally, an AP to AP distance that is twice the AP to client distance is recommended. That is, if we
halve the AP to AP distance, we will get the approximate cell radius.

The AP1500 series offers comparatively better range and capacity as it has the 802.11n functionality. It has
advantages of ClientLink (Beamforming) in downstream, better receiver sensitivities because of MRC in
upstream, multiple transmitter streams and a few other advantages of 802.11n such as channel combining and
so on. The 1552 access points can provide comparatively larger and higher capacity cells.

Note

Link budgets are different for different country domains. The discussion in this section takes into account the
most widely distributed and large country domains: -A and -E.

Comparison of Link Budgets of AP1572 Series and AP1552 Series in 2.4- and 5-GHz Bands (-A Domain)
See Table 6: Link Budget Comparison for the 2.4-GHz band in -A/-B Domain, on page 63.

Table 6: Link Budget Comparison for the 2.4-GHz band in -A/-B Domain

Parameter Cisco 1552 (-A Cisco 1532 (-A Cisco 1562 (-A Cisco 1572 (-B
domain) Domain) Domain) Domain)
Frequency Band 2412 - 2462 MHz |2412 —-2462 MHz |2412-2462 MHz 2412 — 2462 MHz

Air Interface 802.11b/g/n 802.11a//b/g/n/acW2 | 802.11a/b/g/n/acW2 | 802.11 a/b/g/n

Channel Bandwidth | 20 MHz 20 MHz — 20 MHz
No. of Tx Spatial |2 3SS for 15621, 2SS | 3SS for 15621, 2SS |3SS
Streams for 1562E/D models | for 1562E/D models
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Parameter Cisco 1552 (-A Cisco 1532 (-A Cisco 1562 (-A Cisco 1572 (-B
domain) Domain) Domain) Domain)
PHY Data Rates Up to 144 Mbpsil Up to 216 Mbps Up to 216 Mbps Up to 216 Mbps
with 3SS 144 Mbps | with 3SS 144 Mbps
for 2SS for 2SS
Tx Power 28 dBm, Composite§ 29 dBm for 15621 |29 dBm for 15621 |30 dBm
Conducted 27 dBm for 27 dBm for
1562E/D 1562E/D
Rx Sensitivity —94 dBm at 6 Mbps |- 92 dBm at 6 Mbps |- 92 dBm at 6 Mbps | 93 dBm at 6 Mbps
—79 dBm at 54 - 76 dBm at 54 - 76 dBm at 54 —81 dBm at 54 Mbps
Mbps Mbps Mbps 76 dBm at 216
—73 dBm at 150 -71 dBm at 216 -71 dBm at 216 Mbps
Mbps Mbps Mbps
No. of Receive 3 3or2 3or2 4
Channels
Rx Diversity MRC MRC MRC MRC

Antenna Cable loss

0.5 dB, with external
antenna

0.5 dB external
antenna

0.5 dB external
antenna

0.5 dB external
antenna

* 40-MHz channel bonding in 2.4 GHz is not applicable. Therefore, the maximum data rate is 144 Mbps.
5 Composite power is the power when we have two Tx streams enabled in AP1552.

For the 5-GHz band, see Table 7: Link Budget Comparison for the 5-GHz band in -A/-B Domain, on page

64.

Table 7: Link Budget Comparison for the 5-GHz band in -A/-B Domain

Parameter Cisco 1552 (-A Cisco 1532 (-A Cisco 1562 (-A/B Cisco 1572 (-B
Domain) Domain) Domain) Domain)
Frequency Band 5745 - 5825 MHz |5.180 —5.240 GHz |5.180—-5.240 GHz |5.180 —5.240 GHz

5.260 - 5.320 GHz
5.500 - 5.560 GHz
5.680 —5.720 GHz
5.745 - 5.825 GHz

5.260 —5.320 GHz
5.500 - 5.560 GHz
5.680 —5.720 GHz
5.745 - 5.825 GHz

5.260 —5.320 GHz
5.500 - 5.560 GHz
5.680 —5.720 GHz
5.745 - 5.825 GHz

Air Interface 802.11a/n 802.11a/b/g/n/acW2 | 802.11a/b/g/n/acW2 | 802.11a/n/ac

Channel Bandwidth | 20 MHz, 40 MHz |20 MHz, 40 MHz, |20 MHz, 40 MHz, |20 MHz, 40 MHz,
80 MHz 80 MHz 80 MHz

No. of Tx Spatial |2 2 3or2 3

Streams

PHY Data Rates Up to 300 Mbps Up to 300 Mbps 1.300 /867 Mbps | Up to 1.3 Gbps
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Assumptions for the Cisco Range Calculator .

Parameter Cisco 1552 (-A Cisco 1532 (-A Cisco 1562 (-A/B Cisco 1572 (-B
Domain) Domain) Domain) Domain)

Tx Power 28 dBm, Composite | 27 dBm 29 or 27 dBm 30 dBm

Conducted

Rx Sensitivity —92 dBm at 6 Mbps |—94 dBm at 6 Mbps |—94 dBm at 6 Mbps | -92 dBm at 6 Mbps
—76 dBm at 54 —80 dBm at 54 —80 dBm at 54 —80 dBm at 54 Mbps
Mbps Mbps Mbps ~60 dBm at 1300
—72 dBm at 300 —65 dBm at 1300 |—65 dBm at 1300 | Mbps
Mbps Mbps Mbps

The 20-MHz channel bonding to form a 40-MHz channel is available in 5 GHz. Therefore, we can go up to
a data rate of 300 Mbps.

As discussed in the previous section, Path Loss Exponents (PLE) and Link Budget windows work together.

For a full clear path, PLE is 2.0. For AP to AP, there is comparatively more clearance than AP to client. For
AP to AP, PLE can be taken as 2.3 because it can be assumed that the height of both APs is about 10 meters,
which means a good line of sight (but without Fresnel zone clearance).

For AP to client, PLE should be greater than or equal to 2.5 because the client is only 1 meter high. Therefore,
there will be less Fresnel zone clearance. This applies to both the 2.4-GHz and 5-GHz bands.

Let us consider AP to AP link budget in 5 GHz for -A domain because 5 GHz is used as a backhaul for mesh.
We can take a legacy data rate of 9 Mbps to estimate the range.

Note

This is the lowest data rate for outdoor 802.11n APs, which carries the Cisco's ClientLink (Beamforming for
Legacy clients) advantage. It provides a gain of up to 4 dB in the downlink direction.

Assumptions for the Cisco Range Calculator

» The Range Calculator has been edited to stay within limitations for Tx power and EIRP under the listed
regulatory domains. There may be cases where it exceeds the limitations. You must verify that the
installation is within the laws of the location in which it is being installed.

+ All antenna ports must be used for external antenna models for effective performance. Otherwise, range
is significantly compromised.

» The Tx power is the total composite power of both Tx paths.
* Rx sensitivity is the composite sensitivity of all three Rx paths. That is, MRC is included.
» The Range Calculator assumes that ClientLink (Beamforming) is switched on.

* When you use the Range Calculator, available power levels change based upon the regulatory domain,
the antenna (or antenna gain) selected, and the data rate selected. You must verify all parameters after
making any parameter changes.

* You can select a different antenna than the two that are available by default. If you enter a high gain
antenna and choose a power that goes over the EIRP limit, then you get a warning and the range equals
0.
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. Assumptions for the Cisco Range Calculator

* You can choose only the channels that the access point is certified for.

* You can only select only valid power levels.

The RAPs shown in Figure 19: PoP with Multiple RAPs, on page 66 are simply a starting point. The goal is
to use the RAP location in combination with the RF antenna design to ensure that there is a good RF link to
the MAP within the core of the cell, which means that the physical location of the RAPs can be on the edge
of the cell, and a directional antenna is used to establish a link into the center of the cell. Therefore, the wired
network location of a RAP might play host to the RAP of multiple cells, as shown in Figure 19: PoP with
Multiple RAPs, on page 66.

Figure 19: PoP with Multiple RAPs
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When the basic cell composition is settled, the cell can be replicated to cover a greater area. When replicating
the cells, a decision needs to be made whether to use the same backhaul channel on all cells or to change
backhaul channels with each cell. In the example shown in Figure 20: Multiple RAP and MAP Cells, on page
66, various backhaul channels (B2, C2, and D2) per cell have been chosen to reduce the co-channel interference
between cells.

Figure 20: Multiple RAP and MAP Cells
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Collocating Mesh Access Points .

Choosing various channels reduces the co-channel interference at the cell boundaries, at the expense of faster
mesh convergence, because MAPs must fall back to seek mode to find neighbors in adjacent cells. In areas
of high-traffic density, co-channel interference has the highest impact, which is likely to be around the RAP.
If RAPs are clustered in one location, a different channel strategy is likely to give optimal performance; if
RAPs are dispersed among the cells, using the same channel is less likely to degrade performance.

When you lay out multiple cells, use channel planning similar to standard WLAN planning to avoid overlapping
channels, as shown in Figure 21: Laying out Various Cells, on page 67.

Figure 21: Laying out Various Cells

If possible, the channel planning should also minimize channel overlap in cases where the mesh has expanded
to cover the loss of a RAP connection, as shown in Figure 22: Failover Coverage, on page 67.

Figure 22: Failover Coverage

Collocating Mesh Access Points

The following recommendations provide guidelines to determine the required antenna separation when you
collocate AP1500s on the same tower. The recommended minimum separations for antennas, transmit powers,
and channel spacing are addressed.

The goal of proper spacing and antenna selection is to provide sufficient isolation by way of antenna radiation
pattern, free space path loss, and adjacent or alternate adjacent channel receiver rejection to provide independent
operation of the collocated units. The goal is to have negligible throughput degradation due to a CCA hold-off,
and negligible receive sensitivity degradation due to a receive noise floor increase.
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. Special Considerations for Indoor Mesh Networks

You must follow antenna proximity requirements, which depend upon the adjacent and alternate adjacent
channel usage.

Collocating AP1500s on Adjacent Channels

If two collocated AP1500s operate on adjacent channels such as channel 149 (5745 MHz) and channel 152
(5765 MHz), the minimum vertical separation between the two AP1500s is 40 feet (12.192 meters) (the
requirement applies for mesh access points equipped with either 8 dBi omnidirectional or 17 dBi high-gain
directional patch antennas).

Iftwo collocated AP1500s operate on channels 1, 6, or 11 (2412 to 2437 MHz) with a 5.5-dBi omnidirectional
antenna, then the minimum vertical separation is § feet (2.438 meters).

Collocating AP1500s on Alternate Adjacent Channels

If two collocated AP1500s operate on alternate adjacent channels such as channel 149 (5745 MHz) and channel
157 (5785 MHz), the minimum vertical separation between the two AP1500s is 10 feet (3.048 meters) (the
requirements applies for mesh access points equipped with either 8-dBi omnidirectional or 17-dBi high-gain
directional patch antennas).

If two collocated AP1500s operate on alternate adjacent channels 1 and 11 (2412 MHz and 2462 MHz) with
a 5.5-dBi omnidirectional antenna, then the minimum vertical separation is 2 feet (0.609 meters).

In summary, a 5-GHz antenna isolation determines mesh access point spacing requirements and antenna
proximity must be followed and is dependent upon the adjacent and alternate adjacent channel usage.

Special Considerations for Indoor Mesh Networks

Note these considerations for indoor mesh networks:

* For outdoors, voice is supported on a best-effort basis on a mesh infrastructure.
* Quality of Service (QoS) is supported on the local 2.4-GHz client access radio and on the 5-GHz.

* Cisco also supports static Call Admission Control (CAC) in CCXv4 clients, which provides CAC between
the access point and the client.

* RAP-to-MAP ratio—The recommended ratio is 3 to 4 MAPs per RAP.
» AP-to-AP distance:

* For 11n and 11ac mesh APs, a spacing of no more than 250 feet between each mesh AP with a cell
radius of 125 feet is recommended.

* Hop count—For data, the maximum is 4 hops. No more than 2 hops is recommended for voice.

* RF considerations for client access on voice networks:

* Coverage hole of 2 to 10 percent

* Cell coverage overlap of 15 to 20 percent

* Voice needs RSSI and SNR values that are at least 15 dB higher than data requirements
* RSSI of -67 dBm for all data rates should be the goal for 11b/g/n and 11a/n

* SNR should be 25 dB for the data rate used by client to connect to the AP

* Packet error rate (PER) should be configured for a value of one percent or less
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Special Considerations for Indoor Mesh Networks .

* Channel with the lowest utilization (CU) must be used

Check the CU when no traffic is running

* Radio resource manager (RRM) can be used to implement the recommended RSSI, PER, SNR, CU,
cell coverage, and coverage hole settings on the 802.11b/g/n/ac radio.

Figure 23: Cell Radius of 100 Feet (30.4 meters) and Access Point Placement for Voice Mesh Networks

! 200 Feet | 200 Feet |
1

________ b : i
1 | 1 i _
200 Feet| i_. e W . o ! 2.4GHz coverage
" w : ; | m Indoor RAP
————————— il e . i
- - - | m Indoor MAP 8
100 Foet ’ =
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Note  Although you can use directional antenna and have an AP-to-AP distance longer
than 250 feet (76.2 meters), for seamless roaming, we recommend that you have
an AP-to-AP distance no more than 250 feet.
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. Mesh AP Back-Ground Scan rel 8.3

Mesh AP Back-Ground Scan rel 8.3

In release 8.3 additional enhancements introduced for faster mesh convergence - Mesh AP background scan
feature . There are already two Mesh convergence features implemented in releases 8.0 and 8.1 WLC software
releases to reduce convergence time taken for a MAP and to re-converge the mesh network faster:

* Mesh Subset channel based convergence in rel 8.0

* Mesh Clear Channel Notification Convergence in rel 8.1

With both features in place, a 31 Hop MAP in a mesh tree is able to re-converge and recover its data path in
less than 10 seconds.

This new Mesh Background Scanning and Auto parent selection will further improve convergence times and
parent selection reliability and stability - a MAP should be able to find and connect with a better potential
parent across any channels and maintain its uplink with a best parent all the time .

Note

This implementation of BG scanning will be applicable to Marvell-based APs. Specifically, AP1550, AP1570,
AP 1560 and TW3702.

A child MAP maintains its uplink with its parent using AWPP - Neighbor Discovery Request/Response
(NDReqg/NDResp) messages which are acting as keep-alives. If there are consecutive losses of NDResp
messages, a parent is declared to be lost and the child MAP tries to find its new parent. A MAP maintains a
list of neighbors of current on-channel, and on losing its current parent, it will try roaming to next best potential
neighbor in the same serving channel. But if there are no other neighbors found in same channel, it has to do
scan/seek across all/subset channels to find a parent.

Each off-channel list node will have a neighbor list managing all neighbors heard in that channel. Upon each
off-channel NDReq broadcasts, the neighbors will be updated with latest SNR values based on their NDResp
packets. A misscount parameter will indicate the number of times a neighbor did not respond to off-channel
scan attempt . Each adjacency neighbor will have its adjusted Ease updated after every BG Scan cycle with
latest linkSNR value.

This feature tries to avoid finding a parent across other channels by scan/seek which are time consuming, but
keeps the child MAP updated with all the neighbors across all channels and will help just 'switching' to a
neighbor of any channel and use him as its next parent for its uplink. This 'switching' parent procedure need
not be a triggered event like parent loss detection, but also on identifying a better parent using 'Auto parent
selection algorithm' when the child MAP still has its current parent uplink active. The " Auto Parent selection
algorithm" is based on the new "ease" values. For better convergence calculation in rel 8.3 a new "Ease" value
introduced for smoother and faster parent or neighbor finding and auto parent connection algorithm. The Ease
value is based on SNR, number of Hops, Timers and load values. For the off-channel neighbors the
AdjustedEase value will be used and a best neighbor per off-channel shall be identified based on its highest
AdjustedEase value. StickyEase shall be applicable only for on-channel parent.

A child MAP will switch between optimal parents based on periodic evaluation of best neighbors across all
off-channels. Best next parent is identified with highest adjustedEase value of another off-channel neighbor
compared to current on-channel parent's stickyEase.

Table below illustrates the new convergence times based on different convergence configuration options.
With the implementation of the latest CCN and Background scan features and fast convergence the First Hop
MAP can achieve a 3 to 4 sec convergence.
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DFS and None-DFS Channel Scan .

Parent Loss Channel Scan/Seek | DHCP/CAPWAP Time per hop (sec)
Detection/ Keep Information
Alive Timers

Standard 21/3 sec Scan/Seek all 2.4 Renew / Restart 48.6*

and 5 Ghz Channels | CAPWAP

Fast 7/3 sec Scan/Seek only Maintain DHCP and | 20.5*
channels found in | CAPWAP
same bridge group

Very Fast 4/1.5 sec Scan/Seek only Maintain DHCP and | 15.9*
channels found in | CAPWAP
same bridge group

CCN/BG Scan 4 /3 sec for 50ms | Scan/Seek only Maintain DHCP and | 8-10 sec
Fast/VF channels found in | CAPWAP
same bridge group

DFS and None-DFS Channel Scan

Non-DFS channel scan

* A MAP goes off-channel periodically, transmits NDReq broadcast packets on the selected off-channel,
and shall receive NDResp packets from all ‘reachable’ neighbors

* Off-channel scan periodicity will occur every 3 seconds and stay for a maximum of 50 milliseconds per
off-channel

* NDReq has to be transmitted every 10 milliseconds to send at least 4 messages within 50 milliseconds
dwell time to hear better from each neighbor

DFS channel scan

Per regulatory restrictions, an AP shall not transmit over a DFS channel (when set on radio for off-channel
scan) unless the channel is declared to be 'safe to send'. If there are radar signals detected, there should be no
transmission and the channel should be avoided for AP's wireless Tx/Rx. One way to make sure that the
channel is safe to send is by when the AP does passive scan and it receives any packet from other neighbors
who are on DFS on-channel.

* To enable MAPs receive a packet during their off-channel scan over a DFS channel, all other on-channel
DFS neighbors shall transmit the AWPP mesh beacons if there is no Tx/Rx in last 50 milliseconds

* These mesh beacons will help the MAPs which is doing the off-channel on the DFS channel to declare
‘safe to send’ and do off-channel activities
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. Configuring Mesh Convergence

BGN_1 60, 100, 140

Available from 8.3 Release

cisco

@ | =

m RAP Channels

RAP1
Ch 60

MAP2
o

CCN_CINFO

NG Ch B N

Auto Parent Selection— Background Scan & Messagin&

MAP1 Scan for parents

Finds Best Parent

Background Scans all parents
Parent Fails

Send CCN_WAIT to children
Join New Parent from list
Notifies child of channel change
Auto switching on with BG Scan
when parent didn't fail

. Sticky
LinksNR ~ AdlEase oo On-
off-Ch o

3500 3500
e MAP2 30 1200 1200
100 RAP2 45 4500 4000
140 RAP3 10 1000 1000

The illustration above shows a typical Off-Channel convergence process during the "standard" or "fast/very

fast" configuration.

)

Note The timers in the table are for the illustration purpose only

i

BGN_1 60, 100, 140

aliilis
{1113

RAP Channels

RAP1-Ch 60

Channel

Mesh Convergence — Auto Switching a Paré'nt"

MAP1 Scan for parents

Finds and joins Best Parent
Background Scans all parents
Finds a better Parent

Send CCN_WAIT to children
Auto Switch to New Parent
Motifies child of channel change

Off-Ch

140 RAPZ

10 1000 1000

The illustration below shows Mesh convergence and Parent Auto Switching when the "ease" value dictates
switching to a better parent is prompted by new "ease value" even if the original parent is still available.

Configuring Mesh Convergence

Configuration steps are very simple to invoke new Background Scan feature.

Perform the following steps to configure controller using GUI:
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Configuring Mesh Convergence .

SUMMARY STEPS
1. On the controller choose Wireless > Mesh tabs and then under the "Convergence" section of the Mesh
configuration choose Mode and then enable CCN and Background Scan.
2. Note, that under Mode there are three options to select the convergence mode, as indicated above the
convergence times will change drastically depending on the mode selected.
DETAILED STEPS
Step 1 On the controller choose Wireless > Mesh tabs and then under the "Convergence" section of the Mesh configuration

choose Mode and then enable CCN and Background Scan.

CIsSCO MOMITOR  WIANs  COMNTROLLER

¥ Access Points

Wireless Mesh

WIRELES

SECURITY  MAMAGEMENT

Country

All APs General
= Radios
802.11a/n/ac Range (RootAP to MeshAP) 12000 feet
g0z.11b/a/n :
IDS(R ds t
| EL:aI-Bafljd Rat?llos Detéct?og#)e SREeRlIRAE Enabled
slobalisontgraten Backhaul Client Access Enabled
¥ Advanced
f Mesh DCA Channels £ | Enabled
Mesh :
Global Public Safety Enabled
F ATF
Mesh Backhaul RRM Enabled
RF Profiles Outdoor Ext. UNII B Domain .
FlexConnect Groups Channels
FlexConnect ACLs =
FlaxConnect YLAN Mesh RAP Downlink Backhaul
Ternplates
OEAP ACLs RAP Downlink Backhaul 2
Network Lists 5 GHz 2iehilGhlz
F B02.11a/nfac
inf Enable I
b 802.11bjg/n
b Media Stream Convergence
» Application Visibility Made VERYFAST ¥
And Control
Channel Change Motification #| Enabled
Lync Server
Background Scanning #| Enabled

Background scan configure from CLI using the following commands:

[Cisco Controller)

Enable Enable background scanning on Mesh
lisable Iisable background scanning on Mesh

[Cisco Controller) >config mesh background-scanning ensble I ‘%’J’ﬁ

roonfig mesh background-scanning ?

[Cizco Controller)

rzonfig mesh ccn ?

Configure CCN using the following CLI command:

enable Enables channel change notification
dizsable Disakbles channel change notification

[Cizco Controller) >config mesh con enable I'ﬁ-

Step 2 Note, that under Mode there are three options to select the convergence mode, as indicated above the convergence times

will change drastically depending on the mode selected.
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Convergence

Mode

Channel Change Motification

Background

From the CLI the same convergence configured using the following commands:

[Cisco Control

Scanning

[VERVFAST v | W
STAHDARD

ler) rconfig mesh convergence 7

fast
noise-tolerant
standard
very-fast

[Cizco Control

ler) »>config mesh convergence wery-fast all

|set fast convergence method
~fast 3et noise-tolerant fast convergence method to handle unstable RF environment
et standard convergence method
SJet very fast convergence method

Site Preparation and Planning |

Note In Standard mode CCN and BG scan options do not apply

Managing Mesh Features

There are several commands introduced to debug and troubleshoot convergence issues

Debug mesh convergence enable—debug trace
AP1572-7a7f.09c0fdebuy mesh 7

adjacency
channe 1l
CONVEr gEnCE
EYrOr
ethernet
EVENL
forwarding
link

mpert

node
port-control
relisble
security
trace

MESH
Mesh
Mesh
Mesh
Mesh
Mesh
Mesh
MESH
MESH
Mesh
Mesh
Mesh
MESH

Adjacency debug

Channel debug
convergence debug Q}______;
error debug

Ethernet debug

event debug

forwarding debug

Link debug

BW test tool

node debug

port control debug
Felighle Delivery debug
Security debug

trace address

Debug mesh bgscan enable/disable

adjacency
bgscan
channel
CONVEr gence
errar
ethernet
event
forwarding
Tink

mperf

node
port-contraol
reliable
security
trace

MESH
Mesh
mMesh
Mesh
mMesh
Mesh
mesh
mMesh
MESH
MESH
mMesh
Mesh
mMesh
MESH

Cyprus_marl#debug mesh 7

Edjacengybdebug

scan debug g
Cﬁanne? debgg -
convergence debuy @
error debug

Ethernet debug

event debug

forwarding debug

Link debug

Bw test too]

node debug

port control debug
reliable pDeliwvery debug
Security debug

trace address

Show mesh convergence—for state and counters
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AF157z2-7a7f.09z0#=sh
adjacency MESH
hackhaul MESH
channel MESH
config MESH
convergence MESH
df= MESH
ethernet shaow
forwarding MESH
inventory
linktest MESH
1=c MESH
module MESH
mpert MESH
security MESH
Sirmlation MESH
status MESH

Show mesh bgscan

Cyprus_mapl#sh mesh
adjacency MESH
hackhaul MESH
hogscan MESH
channel MESH
config MESH
comvergence  MESH
dfs MESH
ethearnat show
forwarding  MESH
irvent ory
Tinktest MESH
1sc MESH
module MESH
mpert MESH
securit MESH
simulation MESH
status MESH

i
S oW MESH BG Scan

Managing Mesh Features .

mesh ?

LAdjacency

hackhaul

channel

config paramenter
convergence info 'ﬁ-—‘—“‘”‘—l
df= informwation

mesh ethernet bridging
Forwarding

platform inventory

linktest =stats

l=sc details

module detail

EW tool

Security show

simulated configuration
status

i

adjacenc
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Wireless Propagation Characteristics

Table 8: Comparison of 2.4-GHz and 5-GHz Bands, on page 76 provides a comparison of the 2.4-GHz and
5-GHz bands.

The 2.4-GHz band provides better propagation characteristics than 5 GHz, but 2.4 GHz is an unlicensed band
and has historically been affected with more noise and interference to date than the 5-GHz band. In addition,
because there are only three backhaul channels in 2.4 GHz, co-channel interference would result. Therefore,
the best method to achieve comparable capacity is by reducing system gain (that is, transmit power, antenna
gain, receive sensitivity, and path loss) to create smaller cells. These smaller cells require more access points
per square mile (greater access point density).

Table 8: Comparison of 2.4-GHz and 5-GHz Bands

2.4-GHz Band Characteristics 5-GHz Band Characteristics

3 channels 22 channels (-A/-B regulatory domain)

More prone to co-channel interference No co-channel interference

Lower power Higher power

Lower SNR requirements given lower data rates Higher SNR requirements given higher data rates

Better propagation characteristics than 5 GHz but | Worse propagation characteristics than 2.4 GHz but
more susceptible to noise and interference less susceptible to noise and interference

Unlicensed band. Widely available throughout the | Not as widely available in the world as 2.4-GHz.
world. Licenses in some countries.

2.4 GHz has more penetration capability across the obstacles due to a larger wavelength. In addition, 2.4 GHz
has lower date rates which increases the success of the signal to reach the other end.

CleanAir

The 1550/1560/1570 series access points contain the CleanAir chipset, allowing full CleanAir support.

CleanAir in mesh can be implemented on the 2.4-GHz radio and provides clients complete 802.11n/ac data
rates while detecting, locating, classifying, and mitigating radio frequency (RF) interference. This provides
a carrier class management and customer experience and ensures that you have control over the spectrum in
the deployed location. CleanAir enabled RRM technology on the outdoor platform detects, quantifies, and
mitigates Wi-Fi and non-Wi-Fi interference on 2.4-GHz radios. Access points operating in Bridge Mode
support CleanAir in 2.4 GHz client access mode.

CleanAir AP Modes of Operation

Bridge (Mesh) Mode AP—CleanAir capable access points offer complete CleanAir functionality in the 2.4
GHz band and CleanAir advisor on the 5 GHz radio. This is across all access points that operate in Bridge
mode.

Tight silicon integration with the Wi-Fi radio allows the CleanAir hardware to listen between traffic on the

channel that is currently being served with no penalty to throughput of attached clients. That is, line rate
detection without interrupting client traffic.
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Bridge mode access points support Radio Resource Management (RRM) on the 2.4 GHz band, which helps
to mitigate the interference from WiFi interferers. RRM is only available on the 5 GHz band, if a Bridge mode
RAP has no child MAPs.

A CleanAir Mesh AP only scans one channel of each band continuously. In a normal deployment density,
there should be many access points on the same channel, and at least one on each channel, assuming RRM is
handling channel selection. In 2.4 GHz, access points have sufficient density to ensure at least three points of
classification. An interference source that uses narrow band modulation (operates on or around a single
frequency) is only detected by access points that share the frequency space. If the interference is a frequency
hopping type (uses multiple frequencies—generally covering the whole band), it is detected by every access
point that can hear it operating in the band.

Monitor Mode AP (MMAP)—A CleanAir monitor mode AP is dedicated and does not serve client traffic.
The monitor mode ensures that all bands-channels are routinely scanned. The monitor mode is not available
for access points in bridge (mesh) mode because in a mesh environment, access points also talk to each other
on the backhaul. If a mesh AP (MAP) is in the monitor mode, then it cannot perform mesh operation.

Local Mode AP— When an outdoor access point is operating in local mode, it can preform full CleanAir and
RRM on both the 2.4 GHz and 5 GHz channels. It will predominately scan its primary channel, but will
periodically go off-channel to scan the rest of the spectrum. Enhanced Local Mode (ELM) wIPS detection is
not available on the 1532, 1550, or 1570.

Spectrum Expert Connect Mode (optional) (SE Connect)—An SE Connect AP is configured as a dedicated
spectrum sensor that allows connection of the Cisco Spectrum Expert application running on a local host to
use the CleanAir AP as a remote spectrum sensor for the local application. This mode allows viewing of the
raw spectrum data such as FFT plots and detailed measurements. This mode is intended for only remote
troubleshooting.

Pseudo MAC (PMAC) and Merging

PMAC and Merging phenomenon is similar to the one for Generation 2 access points in local mode. A PMAC
is calculated as part of the device classification and included in the interference device record (IDR). Each
AP generates the PMAC independently. While it is not identical for each report (at a minimum the measured
RSSI of the device is likely different at each AP), it is similar. The function of comparing and evaluating
PMAC:s is called merging. The PMAC is not exposed to customer interfaces. Only the results of merging are
available in the form of a cluster ID.

The same device can be detected by multiple APs. All the PMACs and IDRs are analyzed on the controller
and a report is generated called a device cluster, which shows the APs detecting the device and the device
cluster showing the AP which is hearing the device as strongest.

In this merging spatial proximity, RF proximity (RF neighbor relationship) work together. If there are six
similar IDRs with 5 APs nearby and another one from an AP that is far away, it is unlikely that it is the same
interferer. Therefore, a cluster is formed taking all these into account. MSE and the controller first rely on RF
Neighbor lists to establish spatial proximity in a merge.

PMAC Convergence and Merging depends upon the following factors:

* Density of the sensors
* Quality of the observed classification
* RSSI from the interferer to the APs

* RF neighbor list at the APs
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. Event Driven Radio Resource Management and Persistence Device Avoidance

So RRM on 2.4 GHz in mesh also plays a key role in deciding the merging aspect. APs should be RF neighbors
for any possibility of Merging. RF Neighbor list is consulted and spatial relationships for IDRs are taken into
account for Merging.

Because there is no Monitor Mode in mesh, a single controller merging occurs on the controller. The result
of a controller merge is forwarded to the MSE (if present) along with all of the supporting IDRs.

For more than one WLC (possible in outdoor deployments), merging occurs on the MSE. MSE does more
advanced merging and extracts location and historical information for interferers. No Location is performed
on controller merged interferers. Location is done on the MSE.

Figure 25: Pseudo MAC Merging in Outdoors
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After PMAC signature merging, you can identify which AP can hear the device, and which AP is the center
of a cluster. In the figure above, the values are relevant to the band selected. The label R on AP indicates that
the AP is a RAP and the line between APs shows the mesh relationship.

Event Driven Radio Resource Management and Persistence Device Avoidance

\}

There are two key mitigation features that are present with CleanAir. Both rely directly on information that
can only be gathered by CleanAir. Event Driven Radio Resource Management (EDRRM) and Persistence
Device Avoidance (PDA). For mesh networks, they work exactly the same way as for nonmesh networks in
the 2.4-GHz band.

Note

EDRRM and PDA are only available in a Greenfield installation and configured off by default.
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CleanAir Access Point Deployment Recommendations

CleanAir is a passive technology that does not affect the normal operation of Wi-Fi networks. There is no
inherent difference between a CleanAir deployment and a mesh deployment.

Locating a non-Wi-Fi device has a lot of variables to consider. Accuracy increases with power, duty cycle,
and the number of channels hearing the device. This is advantageous because higher power, higher duty cycle,
and devices that impact multiple channels are considered to be severe with respect to interference to networks.

Note

There is no guarantee of accuracy for location of non- Wi-Fi devices.

There are a lot of variables in the world of consumer electronics and unintentional electrical interference. Any
expectation of accuracy that is derived from current Client or Tag location accuracy models does not apply
to non-Wi-Fi location and CleanAir features.

Important notes to consider:

* CleanAir mesh AP supports the assigned channel only.

* Band Coverage is implemented by ensuring that channels are covered.

* The CleanAir mesh AP can hear very well, and the active cell boundary is not the limit.
* For Location solutions, the RSSI cutoff value is —75 dBm.

* A minimum of three quality measurements is required for location resolution.

In most deployments, it is difficult to have a coverage area that does not have at least three APs nearby on
the same channel in the 2.4-GHz band. In locations where there is minimal density, while the location resolution
is likely not supported, the active user channel is protected.

Deployment considerations are dependent upon planning the network for desired capacity and ensuring that
you have the correct components and network paths in place to support CleanAir functions. RF proximity
and the importance of RF Neighbor Relations cannot be understated. It is important to keep in mind the PMAC
and the merging process. If a network does not have a good RF design, the neighbor relations is affected,
which in turn affects CleanAir performance.

The AP Density recommendations for CleanAir remain the same as normal mesh AP deployment.

Location resolution in the Outdoors is to the nearest AP. Devices are located near the AP which is physically
closest to the device. It is advisable to assume closest AP resolution.

It is possible to deploy a few 1530 APs (non-CleanAir) with an installation that consists of 1552 APs and
1572 APs (CleanAir). This deployment can work from a client and coverage standpoint as these access points
are fully interoperable with each other. The complete CleanAir functionality depends on all access points
being CleanAir enabled. Detection can be affected, and mitigation is not recommended.

A CleanAir AP actively serving clients can only monitor the assigned channel that it is serving. In an area
where you have multiple access points serving clients in close proximity, the channels being served by CleanAir
access points can drive CleanAir features. Legacy non-CleanAir access points rely on RRM, and mitigate
interference issues, but not report the type and severity as CleanAir access points do to the system level.

For more information about mixed systems, see http://www.cisco.com/en/US/products/ps10315/products_
tech_note09186a0080b4bdc1.shtml
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If CleanAir is enabled on a backhaul radio, CleanAir Advisor is activated. CleanAir Advisor generates Air
Quality Index (AQI) and Interferer Detection Reports (IDR) but the reports are only displayed in the controller.
No action is taken through event driven RRM (ED-RRM). CleanAir Advisor is only present on the 5-GHz
backhaul radio of the 1552 access points in Bridge mode. In all other AP modes, the 5-GHz backhaul radio
of the 1552 access points operates in CleanAir mode.

Enabling CleanAir

Licensing

To enable CleanAir functionality in the system, you first need to enable CleanAir on the controller through
Wireless > 802.11a/b > CleanAir. Although CleanAir is disabled by default, CleanAir is enabled by default
on the AP interface.

After you enable CleanAir, it takes 15 minutes to propagate air quality information because the default reporting
interval is 15 minutes. However, you can see the results instantly at the CleanAir detail level on the radio by
going to Monitor > Access Points > 802.11a/n or 802.11b/n.

A CleanAir system requires a CleanAir AP and a controller that is running release 7.0 or later releases. Adding
the Cisco Prime Infrastructure allows the displays to be enhanced and additional information to be correlated
within the system. Adding the MSE further enhances the available features and provides the history and
location of specific interference devices. There is no additional license requirement for the CleanAir feature
because the CleanAir AP is the license. Adding the Prime Infrastructure can be done with a basic license.
Adding the MSE to the system requires a Prime Infrastructure Plus license and a context-aware license selection
for the MSE.

For purposes of interference location with the MSE or CMX, each interference device counts as a location
target in Context-Aware. One hundred Permanent Interferer licenses are embedded in the MSE. Interferer
Licenses open as CleanAir APs are detected, in stages of five licenses per CleanAir AP. This process is
applicable to AP1552/1562/1572. An Interference device is the same as a client or a tag from a license quantity
standpoint. Only a small percentage of the available licenses are used because there should be far less
interference devices than clients or tags to track. Users do have control over what types of interference devices
to detect and located from the controller configuration menus.

Cisco context-aware licenses can be managed and limited by the class of target (client, tag, interference),
which gives users complete control over how licenses are used.

Note

Each interference device requires one context-aware service (CAS) license.

If you have too many Bluetooth devices, it is advisable to switch off the tracing of these devices because they
might take up too many CAS licenses.

Wireless Mesh Mobility Groups

A mobility group allows controllers to peer with each other to support seamless roaming across controller
boundaries. APs learn the IP addresses of the other members of the mobility group after the CAPWAP Join
process. A controller can be a member of a single mobility group which can contain up to 24 controllers.
Mobility is supported across 72 controllers. There can be up to 72 members (WLCs) in the mobility list with
up to 24 members in the same mobility group (or domain) participating in client hand-offs. The IP address of

. Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8



| Site Preparation and Planning
Multiple Controllers .

a client does not have to be renewed in the same mobility domain. Renewing the IP address is irrelevant in
the controller-based architecture when you use this feature.

Multiple Controllers

The consideration in distance of the CAPWAP controllers from other CAPWAP controllers in the mobility
group, and the distance of the CAPWAP controllers from the RAP, is similar to the consideration of an
CAPWAP WLAN deployment in an enterprise.

There are operational advantages to centralizing CAPWAP controllers, and these advantages need to be traded
off against the speed and capacity of the links to the CAPWAP APs and the traffic profile of the WLAN
clients using these mesh access points.

If the WLAN client traffic is expected to be focused on particular sites, such as the Internet or a data center,
centralizing the controllers at the same sites as these traffic focal points gives the operational advantages
without sacrificing traffic efficiency.

If the WLAN client traffic is more peer-to-peer, a distributed controller model might be a better fit. It is likely
that a majority of the WLAN traffic are clients in the area, with a smaller amount of traffic going to other
locations. Given that many peer-to-peer applications can be sensitive to delay and packet loss, you should
ensure that traffic between peers takes the most efficient path.

Given that most deployments see a mix of client-server traffic and peer-to peer traffic, it is likely that a hybrid
model of CAPWARP controller placement is used, where points of presence (PoPs) are created with clusters
of controllers placed in strategic locations in the network.

The CAPWAP model used in the wireless mesh network is designed for campus networks; that is, it expects
a high-speed, low-latency network between the CAPWAP mesh access points and the CAPWAP controller.

Increasing Mesh Availability

In the Cell Planning Distance section, a wireless mesh cell of one square mile was created and then built upon.
This wireless mesh cell has similar properties to the cells used to create a cellular phone network because the
smaller cells (rather than the defined maximum cell size) can be created to cover the same physical area,
providing greater availability or capacity. This process is done by adding a RAP to the cell. Similar to the
larger mesh deployment, the decision is whether to use RAP on the same channel, as shown in Figure 26:
Two RAPs per Cell with the Same Channel, on page 82, or to use RAPs placed on different channels, as
shown in Figure 27: Two RAPs per Cell on Different Channels, on page 82. The addition of RAPs into an
area adds capacity and resilience to that area.
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Figure 26: Two RAPs per Cell with the Same Channel
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Figure 27: Two RAPs per Cell on Different Channels
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Multiple RAPs

If multiple RAPs are to be deployed, the purpose for deploying these RAPs needs to be considered. If the
RAPs are being deployed to provide hardware diversity, the additional RAP(s) should be deployed on the
same channel as the primary RAP to minimize the convergence time in a scenario where the mesh transfers
from one RAP to another. When you plan RAP hardware diversity, consider the 32 MAPs per RAP limitation.

If additional RAPs are deployed to primarily provide additional capacity, then the additional RAPs should be
deployed on a different channel than its neighboring RAP to minimize the interference on the backhaul
channels.

Adding a second RAP on a different channel also reduces the collision domain through channel planning or
through RAP cell splitting. Channel planning allocates different nonoverlapping channels to mesh nodes in
the same collision domain to minimize the collision probability. RAP cell splitting is a simple, yet effective,
way to reduce the collision domain. Instead of deploying one RAP with omnidirectional antennas in a mesh
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network, two or more RAPs with directional antennas can be deployed. These RAPs collocate with each other
and operate on different frequency channels. This process divides a large collision domain into several smaller
ones that operate independently.

If the mesh access point bridging features are being used with multiple RAPs, these RAPs should all be on
the same subnet to ensure that a consistent subnet is provided for bridge clients.

If you build your mesh with multiple RAPs on different subnets, MAP convergence times increase if a MAP
has to fail over to another RAP on a different subnet. One way to limit this process from happening is to use
different BGNs for segments in your network that are separated by subnet boundaries.

Indoor Mesh Interoperability with Outdoor Mesh

A

Complete interoperability of indoor mesh access points with the outdoor ones is supported. It helps to bring
coverage from outdoors to indoors. We recommend indoor mesh access points for indoor use only, and these
access points should be deployed outdoors only under limited circumstances as described below.

Caution

The indoor access points in a third-party outdoor enclosure can be deployed for limited outdoor deployments,
such as a simple short haul extension from an indoor WLAN to a hop in a parking lot. The 1700, 1800, 2600,
2700, 2800, 3500e/1, 3600, 3700 and 3800 series access points in an outdoor enclosure is recommended
because of its robust environmental and temperature specifications. Additionally, the indoor access points
have connectors to support articulated antennas when the AP is within an outdoor enclosure. Exercise caution
with the SNR values as they may not scale and long-term fades may take away the links for these APs when
compared to a more optimized outdoor 1500 series access point.

Mobility groups can be shared between outdoor mesh networks and indoor WLAN networks. It is also possible
for a single controller to control indoor and outdoor mesh access points simultaneously. The same WLANs
are broadcast out of both indoor and outdoor mesh access points.
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CHAPTER 6

Connecting the Cisco Mesh Access Points to the
Network

This chapter describes how to connect the Cisco mesh access points to the network.

The wireless mesh terminates on two points on the wired network. The first location is where the RAP attaches
to the wired network, and where all bridged traffic connects to the wired network. The second location is
where the CAPWAP controller connects to the wired network; this location is where the WLAN client traffic
from the mesh network connects to the wired network (see Figure 28: Mesh Network Traffic Termination,
on page 85). The WLAN client traffic from CAPWAP is tunneled at Layer 2, and matching WLANSs should
terminate on the same switch VLAN where the controllers are collocated. The security and network
configuration for each of the WLANSs on the mesh depend on the security capabilities of the network to which
the controller is connected.

Figure 28: Mesh Network Traffic Termination
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Note

When an HSRP configuration is in operation on a mesh network, we recommend that the In-Out multicast
mode be configured. For more details on multicast configuration, see the Enabling Multicast on the Network

(CLI) section.
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. Adding Mesh Access Points to the Mesh Network

For more information about upgrading to a new controller software release, see the Release Notes for Cisco
Wireless LAN Controllers and Lightweight Access Points at http://www.cisco.com/en/us/products/ps10315/
prod_release notes_list.html.

For more information about mesh and controller software releases and the compatible access points, see the
Cisco Wireless Solutions Software Compatibility Matrix at http://www.cisco.com/en/US/docs/wireless/
controller/5500/tech_notes/Wireless Software Compatibility Matrix.html.

This chapter contains the following sections:

* Adding Mesh Access Points to the Mesh Network, on page 86

* Mesh PSK Key provisioning in release 8.2 , on page 95

* Configuring Global Mesh Parameters, on page 103

* Mesh Backhaul at 5 and 2.4 Ghz in Release 8.2 , on page 109

* Backhaul Client Access, on page 114

* Configuring Local Mesh Parameters, on page 116

* Configuring Antenna Gain, on page 124

* Configuring Dynamic Channel Assignment, on page 124

* Configuring Radio Resource Management on a Bridge Mode Access Point, on page 127
* Configuring Advanced Features, on page 128

Adding Mesh Access Points to the Mesh Network

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6
Step 7
Step 8
Step 9
Step 10

This section assumes that the controller is already active in the network and is operating in Layer 3 mode.

N

Note Controller ports that the mesh access points connect to should be untagged.

Before adding a mesh access point to a network, do the following:

Add the MAC address of the mesh access point to the controller’s MAC filter. See the Adding MAC Addresses of
Mesh Access Points to MAC Filter section.

Define the role (RAP or MAP) for the mesh access point. See the Defining Mesh Access Point Role section.
Verify that Layer 3 is configured on the controller. See the Verifying Layer 3 Configuration section.

Configure a primary, secondary, and tertiary controller for each mesh access point. See the Configuring Multiple
Controllers Using DHCP 43 and DHCP 60 section.

Configure a backup controller. See the Configuring Backup Controllers section.

Configure external authentication of MAC addresses using an external RADIUS server. See the Configuring External
Authentication and Authorization Using a RADIUS Server.

Configure global mesh parameters. See the Configuring Global Mesh Parameters section.
Configure backhaul client access. See the Configuring Advanced Features section.
Configure local mesh parameters. See the Configuring Local Mesh Parameters section.
Configure antenna parameters. See the Configuring Antenna Gain section.

Configure channels for serial backhaul. This step is applicable only to serial backhaul access points. See the Backhaul
Channel Deselection on Serial Backhaul Access Point section.
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Step 11
Step 12

Step 13
Step 14

Adding MAC Addresses of Mesh Access Points to MAC Filter .

Configure the DCA channels for the mesh access points. See the Configuring Dynamic Channel Assignment section.

Configure mobility groups (if desired) and assign controllers. See the Configuring Mobility Groups chapter in the Cisco
Wireless LAN Controller Configuration Guide.

Configure Ethernet bridging (if desired). See the Configuring Ethernet Bridging section.

Configure advanced features such as Ethernet VL AN tagging network, video, and voice. See the Configuring Advanced
Features section.

Adding MAC Addresses of Mesh Access Points to MAC Filter

)

You must enter the radio MAC address for all mesh access points that you want to use in the mesh network
into the appropriate controller. A controller only responds to discovery requests from outdoor radios that
appear in its authorization list. MAC filtering is enabled by default on the controller, so only the MAC addresses
need to be configured. If the access point has an SSC and has been added to the AP Authorization List, then
the MAC address of the AP does not need to be added to the MAC Filtering List.

You can add the mesh access point using either the GUI or the CLI.

Note

You can also download the list of mesh access point MAC addresses and push them to the controller using
Cisco Prime Infrastructure.

Adding the MAC Address of the Mesh Access Point to the Controller Filter List (GUI)

Step 1

Step 2
Step 3

To add a MAC filter entry for the mesh access point on the controller using the controller GUI, follow these
steps:

Choose Security > AAA > MAC Filtering. The MAC Filtering page appears.

Figure 29: MA

C Filtering Page
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Password Policies

Click New. The MAC Filters > New page appears.
Enter the radio MAC address of the mesh access point.
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. Adding the MAC Address of the Mesh Access Point to the Controller Filter List (CLI)

Step 4
Step 5

Step 6
Step 7

Step 8
Step 9

Note For 1500 series outdoor mesh access points, specify the BVI MAC address of the mesh access point into the
controller as a MAC filter. For indoor mesh access points, enter the Ethernet MAC. If the required MAC address
does not appear on the exterior of the mesh access point, enter the following command at the access point
console to display the BVI and Ethernet MAC addresses: sh int | i hardware.

From the Profile Name drop-down list, select Any WLAN.
In the Description field, specify a description of the mesh access point. The text that you enter identifies the mesh access
point on the controller.

Note You might want to include an abbreviation of its name and the last few digits of the MAC address, such as
ap1522:62:39:10. You can also note details on its location such as roof top, pole top, or its cross streets.

From the Interface Name drop-down list, choose the controller interface to which the mesh access point is to connect.

Click Apply to commit your changes. The mesh access point now appears in the list of MAC filters on the MAC Filtering
page.
Click Save Configuration to save your changes.

Repeat this procedure to add the MAC addresses of additional mesh access points to the list.

Adding the MAC Address of the Mesh Access Point to the Controller Filter List (CLI)

Step 1

Step 2

To add a MAC filter entry for the mesh access point on the controller using the controller CLI, follow these
steps:

To add the MAC address of the mesh access point to the controller filter list, enter this command:
config macfilter add ap_mac wlan_id interface [description]

A value of zero (0) for the wlan_id parameter specifies any WLAN, and a value of zero (0) for the interface parameter
specifies none. You can enter up to 32 characters for the optional description parameter.

To save your changes, enter this command:

save config

Defining Mesh Access Point Role

By default, AP1500s are shipped with a radio role set to MAP. You must reconfigure a mesh access point to
act as a RAP.

General Notes about MAP and RAP Association With The Controller

The general notes are as follows:

* A MAP always sets the Ethernet port as the primary backhaul if it is UP, and secondarily the 802.11a/n/ac
radio. This gives the network administrator time to reconfigure the mesh access point as a RAP, initially.
For faster convergence on the network, we recommend that you do not connect any Ethernet device to
the MAP until it has joined the mesh network.
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* A MAP that fails to connect to a controller on a UP Ethernet port, sets the 802.11a/n/ac radio as the
primary backhaul. If a MAP fails to find a neighbor or fails to connect to a controller through a neighbor,
the Ethernet port is set as the primary backhaul again.

* A MAP connected to a controller over an Ethernet port does not build a mesh topology (unlike a RAP).
* A RAP always sets the Ethernet port as the primary backhaul.

» If the Ethernet port is DOWN on a RAP, or a RAP fails to connect to a controller on a UP Ethernet port,
the 802.11a/n/ac radio is set as the primary backhaul for 15 minutes. Failing to find a neighbor or failing
to connect to a controller via any neighbor on the 802.11a/n/ac radio causes the primary backhaul to go
into the scan state. The primary backhaul begins its scan with the Ethernet port.

* The Cisco Wave 2 RAPs can fall back on Ethernet in less than 15 minutes if they are not able to find
any valid uplink on the radio for 5 minutes.

Configuring the AP Role (GUI)

To configure the role of a mesh access point using the GUI, follow these steps:

Step 1 Click Wireless to open the All APs page.
Step 2 Click the name of an access point. The All APs > Details (General) page appears.
Step 3 Click the Mesh tab.
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Step 4
Step 5

Figure 30: All APs > Details for (Mesh) Page
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Choose RootAP or MeshAP from the AP Role drop-down list.

Click Apply to commit your changes and to cause the access point to reboot.

Configuring the AP Role (CLI)

To configure the role of a mesh access point using the CLI, enter the following command:

config ap role {rootAP | meshAP} Cisco AP

Daisy Chaining

Delete PSK | 3

Configuring Multiple Controllers Using DHCP 43 and DHCP 60

To configure DHCP Option 43 and 60 for mesh access points in the embedded Cisco IOS DHCP server,
follow these steps:

Step 1
Step 2

Enter configuration mode at the Cisco IOS CLI.

Create the DHCP pool, including the necessary parameters such as the default router and name server. The commands
used to create a DHCP pool are as follows:

ip dhcp pool pool name
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Step 3

Step 4

Backup Controllers .

network IP Network Netmask
default-router Default router
dns-server DNS Server

where:

pool name is the name of the DHCP pool, such as AP1520

IP Network is the network IP address where the controller resides, such as 10.0.15.1
Netmask is the subnet mask, such as 255.255.255.0

Default router is the IP address of the default router, such as 10.0.0.1

DNS Server 1is the IP address of the DNS server, such as 10.0.10.2

Add the option 60 line using the following syntax:
option 60 ascii “WCI string”
For the VCI string, use one of the values below. The quotation marks must be included.

For Cisco 1570 series access points, enter “Cisco AP cl1570”
For Cisco 1560 series access points, enter “Cisco AP cl1560”
For Cisco 1530 series access points, enter “Cisco AP c1530”
For Cisco 1540 series access points, enter “Cisco AP cl1540”

Add the option 43 line using the following syntax:
option 43 hex hex string

The hex string is assembled by concatenating the TLV values shown below:
Type + Length + Value

Type is always f1(hex). Length is the number of controller management IP addresses times 4 in hex. Value is the IP
address of the controller listed sequentially in hex.

For example, suppose that there are two controllers with management interface IP addresses 10.126.126.2 and 10.127.127.2.
The type is f1(hex). The length is 2 * 4 = 8 = 08 (hex). The IP addresses translate to 0a7e¢7¢02 and 0a7{7f02. Assembling
the string then yields f1080a7e7¢020a7{7102.

The resulting Cisco IOS command added to the DHCP scope is listed below:

option 43 hex f1080a7e7e020a7£7£02

Backup Controllers

A single controller at a centralized location can act as a backup for mesh access points when they lose
connectivity with the primary controller in the local region. Centralized and regional controllers need not be
in the same mobility group. Using the controller GUI or CLI, you can specify the IP addresses of the backup
controllers, which allows the mesh access points to fail over to controllers outside of the mobility group.
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You can also configure primary and secondary backup controllers (which are used if primary, secondary, or
tertiary controllers are not specified or are not responsive) for all access points connected to the controller as
well as various timers, including the heartbeat timer and discovery request timers.

Note

The fast heartbeat timer is not supported on access points in bridge mode. The fast heartbeat timer is configured
only on access points in local and FlexConnect modes.

The mesh access point maintains a list of backup controllers and periodically sends primary discovery requests
to each entry on the list. When the mesh access point receives a new discovery response from a controller,
the backup controller list is updated. Any controller that fails to respond to two consecutive primary discovery
requests is removed from the list. If the mesh access point’s local controller fails, it chooses an available
controller from the backup controller list in this order: primary, secondary, tertiary, primary backup, and
secondary backup. The mesh access point waits for a discovery response from the first available controller in
the backup list and joins the controller if it receives a response within the time configured for the primary
discovery request timer. If the time limit is reached, the mesh access point assumes that the controller cannot
be joined and waits for a discovery response from the next available controller in the list.

Note

When a mesh access point’s primary controller comes back online, the mesh access point disassociates from
the backup controller and reconnects to its primary controller. The mesh access point falls back to its primary
controller and not to any secondary controller for which it is configured. For example, if a mesh access point
is configured with primary, secondary, and tertiary controllers, it fails over to the tertiary controller when the
primary and secondary controllers become unresponsive and waits for the primary controller to come back
online so that it can fall back to the primary controller. The mesh access point does not fall back from the
tertiary controller to the secondary controller if the secondary controller comes back online; it stays connected
to the tertiary controller until the primary controller comes back up.

Configuring External Authentication and Authorization Using a RADIUS Server

External authorization and authentication of mesh access points using a RADIUS server such as Cisco ACS
(4.1 and later) and ISE are supported in release 7.0 and later releases. The RADIUS server must support the
client authentication type of EAP-FAST with certificates.

Before you employ external authentication within the mesh network, ensure that you make these changes:
» The RADIUS server to be used as an AAA server must be configured on the controller.
* The controller must also be configured on the RADIUS server.

» Add the mesh access point configured for external authorization and authentication to the user list of the
RADIUS server.

* For additional details, see the Adding a Username to a RADIUS Server section.

* Configure EAP-FAST on the RADIUS server and install the certificates. EAP-FAST authentication is
required if mesh access points are connected to the controller using an 802.11a interface; the external
RADIUS servers need to trust Cisco Root CA 2048. For information about installing and trusting the
CA certificates, see the Configuring RADIUS Servers section.
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N

Note If mesh access points connect to a controller using a Fast Ethernet or Gigabit
Ethernet interface, only MAC authorization is required.

N

Note This feature also supports local EAP and PSK authentication on the controller.

Configuring RADIUS Servers

To install and trust the CA certificates on the RADIUS server, follow these steps:

Step 1 Download the CA certificates for Cisco Root CA 2048 from the following locations:

* https://www.cisco.com/security/pki/certs/crca2048.cer

* https://www.cisco.com/security/pki/certs/cmca.cer

Step 2 Install the certificates as follows:

a) From the CiscoSecure ACS main menu, click System Configuration > ACS Certificate Setup > ACS Certification
Authority Setup.

b) Inthe CA certificate file box, type the CA certificate location (path and name). For example: C:\Certs\crca2048.cer.
¢) Click Submit.

Step 3 Configure the external RADIUS servers to trust the CA certificate as follows:

a) From the CiscoSecure ACS main menu, choose System Configuration > ACS Certificate Setup > Edit Certificate
Trust List. The Edit Certificate Trust List appears.

b) Select the check box next to the Cisco Root CA 2048 (Cisco Systems) certificate name.
¢) Click Submit.
d) To restart ACS, choose System Configuration > Service Control, and then click Restart.

For additional configuration details on Cisco ACS servers, see the following:
* httpz//wwwicisco.com/en/US/products/sw/secursw/ps2086/products_installation and configuration_guides_listhtmi(Windows)

* http://www.cisco.com/en/US/products/sw/secursw/ps4911/(UNIX)

Enabling External Authentication of Mesh Access Points (GUI)

To enable external authentication for a mesh access point using the GUI, follow these steps:

Step 1 Choose Wireless > Mesh. The Mesh page appears (see Figure 31: Mesh Page, on page 94).
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Step 3
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Step 5

Figure 31: Mesh Page
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External MAC Filter Authorization Enabled
Force External Authentication Enabled
LSC Only MAP Authentication Enabled
Server ID Server Address(Ipv4 fIpve) Port Enabled
1 10.91.104.106 1812 Ld

Foot Notes

In the security section, select the EAP option from the Security Mode drop-down list.

Select the Enabled check boxes for the External MAC Filter Authorization and Force External Authentication options.
Click Apply.

Click Save Configuration.

Adding a Username to a RADIUS Server

Add MAC addresses of mesh access point that are authorized and authenticated by external RADIUS servers
to the user list of that server prior to enabling RADIUS authentication for a mesh access point.

For remote authorization and authentication, EAP-FAST uses the manufacturer’s certificate (CERT) to
authenticate the child mesh access point. Additionally, this manufacturer certificate-based identity serves as
the username for the mesh access point in user validation.

For Cisco 10S-based mesh access points, in addition to adding the MAC address to the user list, you need to
enter the platform_name_string—MAC _address string to the user list (for example, c1240-001122334455).
The controller first sends the MAC address as the username; if this first attempt fails, then the controller sends
the platform_name_string—MAC _address string as the username.

Note

The Authentication MAC address is different for outdoor versus indoor APs. Outdoor APs use the AP's BVI
MAC address, whereas indoor APs use the AP's Gigabit Ethernet MAC address.

RADIUS Server Username Entry

For each mesh access point, two entries must be added to the RADIUS server, the
platform_name_string-MAC _address string, then a hyphen delimited MAC Address. For example:

* platform_name_string-MAC_address
User: ¢1570-aabbccddeeff

Password: cisco

* Hyphen Delimited MAC Address
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User: aa-bb-cc-dd-ee-ff
Password: aa-bb-cc-dd-ee-ff

\)

Note The AP1552 platform uses a platform name of ¢1550. The AP1572 uses a platform name of c1570.

Enable External Authentication of Mesh Access Points (CLI)

To enable external authentication for mesh access points using the CLI, enter the following commands:

Step 1 config mesh security eap

Step 2 config macfilter mac-delimiter colon

Step 3 config mesh security rad-mac-filter enable

Step 4 config mesh radius-server index enable

Step 5 config mesh security force-ext-auth enable (Optional)

View Security Statistics (CLI)

To view security statistics for mesh access points using the CLI, enter the following command:
show mesh security-stats Cisco AP

Use this command to display packet error statistics and a count of failures, timeouts, and association and
authentication successes as well as reassociations and reauthentications for the specified access point and its
child.

Mesh PSK Key provisioning in release 8.2

Customers with Cisco Mesh deployment will see their Mesh Access Points (MAP) possibly moving out of
their network and joining another Mesh network when both of these Mesh Deployments use AAA with wild
card MAC filtering to allow MAPs association. As Mesh APs security may use EAP-FAST this cannot be
controlled since for EAP security combination of MAC address and type of AP is used and there is no controlled
configuration is available. PSK option with default passphrase also presents security risk and hijack possibility.
This issue will be prominently seen in overlapping deployments of two different SPs when the MAPs are used
in a moving vehicle (public transportations, ferry, ship and so on.). This way, there is no restriction on MAPs
to 'stick' to the SPs mesh network and MAPs can be hijacked / getting used by another SPs network / and
cannot serve intended customers of SPs in a deployment.
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SP Mesh Adjacent Network Architecture that can create MAP hijacking

Customer XYZ

The new feature introduced in 8.2 release will enable a provision-able PSK functionality from WLC which
will help make a controlled mesh deployment and enhance MAPs security beyond default 'cisco' PSK used
today. With this new feature the MAPs which are configured with a custom PSK, will use this key to do their
authentication with their RAPs and WLC. A special precaution should be taken when upgrading from Controller
Software release 8.1 and below or downgrading from release 8.2. Admin needs to understand the implications
when MAP software is moving in and out of PSK support.

Wireless Mesh Components Supported
* 3504, WiSM-2, 5508, 5520, 7500 and 8500 Series Wireless LAN Controller
* Mesh AP 1550, 1530, 1540 (rel 8.5), 1560 (rel 8.4) or 1570 series and all indoor Mesh supported APs

» Wireless clients (tablets, smartphones and so on.)

Feature Configuration Step-by-Step

Admin shall set security mode as PSK and optionally configure a new PSK. If there is no PSK configured
MAPs will be able to join with default PSK key ‘cisco’.

* Provisioning shall be local to each WLC
* Need to be in 'enabled' state to allow local provisioning

* Key strength as followed in WLC (Alphanumeric with special characters combination of lower, upper
case, length 3-32 characters, special characters supported, redundant passwords not supported.

* Provisioned PSK is encrypted at WLC, stored, and sent to APs in encrypted format.
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Mesh PSK GUI Configuration

Step 1

Connect a RAP to the controller as documented in the above sections of this Deployment Guide. As shown in the
Configuration illustration example below two 1532 MAPs are connected to the RAP 1572.

-onfiguration

alvaln Eing
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DEAP ACLs
Metveork Lists

As indicated in the deployment guide one of the options for the MAPs initial connection the MAP MAC addresses have
to be entered on the controller for them to be connected to the RAP as indicated in the screen shot.
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i)
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Step 2 From Wireless > Mesh menu, choose Security Mode as PSK and enable PSK provisioning.

Prior to release 8.2 MAC, AAA authentication with wild card character or EAP authentication were the only three methods
where EAP was basically used with default internal authentication and MAC address provisioning was not reliable enough
in certain installations especially when Mesh installations from different customers were overlapping and there was a
strong probability of Mesh APs being accidently hijacked from one Mesh network to another. That could create many
issues and coverage holes in the Mesh deployments. For that reason in release 8.2 a PSK MAP provisioning was introduced.
As indicated above the PSK key has to be created on the wireless controller.
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CISCO

Mesh PSK GUI Configuration .
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Enter Provisioning Key as shown in the example and hit ADD to apply the entered value.

The Key value will not show in the list but only the Index of the key with a time stamp when that key was provisioned
on the controller. Up to 5 keys can be entered on the controller for MAPs to be used for provisioning. Any of those 5
keys that are always stored in flash on the controller, can be used by MAP for provisioning. MD5 cryptographic algorithm
(128-bit) is used to encrypt a provisioned PSK and sent down to APs during new key configuration.
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Security
Security Mode L_PSK '__|
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Step 4 Once the controller has the PSK key configured and enabled the key will be provisioned on the RAP and propagated to
all MAPs connected to that RAP. The same key will be also propagated to all other children MAPs in the mesh network.
There is no need to do anything on the MAPs in order for them to receive PSK key and authenticate to the RAP/MAP
network

As shown in the example when observing one specific MAP that connected to the RAP, under the Mesh tab - you can
see that MAP has been provisioned using PSK key with index 1 and Time Stamp from August 19,

!lli!lll!
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Step 6

Mesh PSK GUI Configuration .

The provisioned PSK key can be deleted from MAP or RAP in case PSK key was compromised or deleted on the controller
intentionally.

afrer]es
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DEAP ACLS
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If MAP accidently connected to the wrong network and obtained Key from there, admin has an option to delete that
wrong PSK key. In addition, "Delete PSK" for PSK timestamp in WLC GUI interface can be used to remove a provisioned
PSK of AP when it joined via EAP security. This option is sort of Mesh AP recovery option when AP has been stranded
with staled or not valid PSK and EAP security was used to rejoin a stranded Mesh AP. When PSK key is deleted from
the MAP, it will go back to using its default PSK key "cisco".

Note

* Configuring a PSK with passphrase ‘cisco’ does NOT mean that its equivalent to ‘Default cisco PSK’. Provisioned
PSK works independent of ‘Default PSK’

* Deleting PSK key on the RAP does not apply unless RAP becomes a MAP.
However, note that if the PSK key is still configured on the controller and in turn on the RAP/MAP, then the MAP without

a matching PSK key will not be able to connect to the Mesh network. For un-provisioned MAP to connect to the PSK
enabled mesh network on the controller the Provisioning Window has to be enabled.

As shown in the example when Provisioning Window is manually enabled the MAP will be allowed to connect using
default "cisco" PSK key and at the same time obtain new PSK key.
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. Mesh PSK Provisioning with Controllers In Mobility Group

HELP

oy I el I ' Save Configuration
CISCO MOMITOR  WLANs COMTROLLER  WIRELESS SECURITY MAMAGEMENT  COMMANDS
Wireless 1 Ethernet Bridging
R Pl YLAM Transparent #| Enabled
all aPs
» Radios Security
anz.1la/nfac I
g02.11b/g/n Security Mode FSK ¥
CDual-Band Radios L
Global Configuration PSK Provisioning #! Enabled
¥ Advanced Default PSK #| Enabled
Mesh ADD New Provisioning Key
bATH Provisioning key
RF Profiles Description
FlexConnect
Groups LA
E:zigggzzz SE;; Key Index TimeStamp Description
Usamslinke 1 Tue Nov 17 17:16:08 2015 [Mesh123 &
SRR BELS 2 Fri Nov 13 09:11:48 2015 Mike123 -]
SRRk Llsts 3 Fri Now 13 09:11:03 2015 Cisco123 |2
F B02.11afnfac . e
External MAC Filter Authorization 1 Enabled
¥ 802.11bfg/n _—
Force External Authentication I Enabled
F Media Stream o )
LSC Only MAP Authentication ! Enabled
Application
b Vicibili
g::lsrllli::'ll‘:::::? il Server ID Server Address{Ipv4fIpv6) Port Enabled
Lync Server Loot Hotes
e = I Mesh DCA channels are only applicable for serial bacikhaw! AFs

Note It is important for Mesh administrator to disable default provisioning Window so that MAPs with default PSK
key don’t connect to the provisioned Mesh network.

Note the following scenarios can cause Mesh AP to get stranded, make sure avoiding these configuration mistakes:

* Out-of-the-box APs trying to join using default PSK, but default or “PSK Provisioning Window” option is not
enabled in WLC

* Forgotten the provisioned PSKs in WLC —always write description of the PSK to remind you later and save
provisioned PSK or recovery will have to be performed on AP.

Mesh PSK Provisioning with Controllers In Mobility Group

In case there is a configuration of RAPs in the Mobility Group it is always advised to use the same PSK Keys
or one of the 5 allowable PSK keys on all controllers in the Mobility Group; this way when MAPs coming
from a different controllers they will be able to authenticate. By looking at the time stamp of the PSK you
can find out where the MAP and PSK Key came from.

The following are recommendations when configuring Mesh APs with PSK or EAP security in a multi-controller
configuration:
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+ All Controllers should have the same PSKs. WLCs with different keys will result in unexpected behavior
if RAPs and MAPs move between them, and may even cause extended outages.

+ All controllers should be set for the same security method — mixed EAP and PSK (with provisioning
enabled and PSK(s) created) is not recommended..

All controllers should be set for the same security method — mixed EAP and PSK (with provisioning
enabled and PSK(s) created) is not recommended

CLI Commands for PSK Provisioning

* config mesh security psk provisioning enable/disable
» config mesh security psk provisioning key <pre-shared-key>
» config mesh security psk provision window enable/disable

» config mesh security psk provisioning delete psk <ap|wlc> <ap name|psk index>"

Configuring Global Mesh Parameters

This section provides instructions to configure the mesh access point to establish a connection with the
controller including:

* Setting the maximum range between RAP and MAP (not applicable to indoor MAPs).
* Enabling a backhaul to carry client traffic.
* Defining if VLAN tags are forwarded or not.

* Defining the authentication mode (EAP or PSK) and method (local or external) for mesh access points
including security settings (local and external authentication).

You can configure the necessary mesh parameters using either the GUI or the CLI. All parameters are applied
globally.

Configuring Global Mesh Parameters (GUI)

To configure global mesh parameters using the controller GUI, follow these steps:

Step 1 Choose Wireless > Mesh.
Step 2 Modify the mesh parameters as appropriate.
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Table 9: Global Mesh Parameters

Connecting the Cisco Mesh Access Points to the Network |

Parameter

Description

Range (RootAP to MeshAP)

The optimum distance (in feet) that should exist between
the root access point (RAP) and the mesh access point
(MAP). This global parameter applies to all mesh access
points when they join the controller and all existing mesh
access points in the network.

Range: 150 to 132,000 feet
Default: 12,000 feet

Note After this feature is enabled, all mesh access
points reboot.

IDS (Rogue and Signature Detection)

When you enable this feature, IDS reports are generated for
all traffic on the client access only and not on the backhaul.

When you disable this feature, no IDS reports are generated,
which preserves bandwidth on the backhaul.

You have to use the following command to enable or disable
it on the mesh APs:

config mesh ids-state {enable | disable)

Note 2.4GHz IDS is activated with the global IDS
settings on the controller.

Backhaul Client Access

Note This parameter applies to mesh access points
with two or more radios.

When Backhaul Client Access is enabled, it allows wireless
client association over the backhaul radio. Generally,
backhaul radio is a 5 GHz radio for most of the mesh access
points. This means that a backhaul radio can carry both
backhaul traffic and client traffic.

When Backhaul Client Access is disabled, only backhaul
traffic is sent over the backhaul radio and client association
is only over the second radio(s).

Default: Disabled

Note After this feature is enabled, all mesh access
points reboot.
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Configuring Global Mesh Parameters (GUI) .

Parameter Description

VLAN Transparent This feature determines how a mesh access point handles
VLAN tags for Ethernet bridged traffic.

Note See the Configuring Advanced Features section
for overview and additional configuration details.

If VLAN Transparent is enabled, then VLAN tags are not

handled and packets are bridged as untagged packets.

Note No configuration of Ethernet ports is required
when VLAN transparent is enabled. The Ethernet
port passes both tagged and untagged frames
without interpreting the frames.

If VLAN Transparent is disabled, then all packets are

handled according to the VLAN configuration on the port

(trunk, access, or normal mode).

Note If the Ethernet port is set to Trunk mode, then
Ethernet VLAN tagging must be configured. See
the Enabling Ethernet Bridging (GUI) section.

Note For an overview of normal, access, and trunk
Ethernet port use, see the Ethernet Port Notes
section.

Note To use VLAN tagging, you must uncheck the
VLAN Transparent check box.

Note VLAN Transparent is enabled as a default to
ensure a smooth software upgrade from
4.1.192.xxM releases to release 5.2. Release
4.1.192.xxM does not support VLAN tagging.

Default: Enabled.

Security Mode Defines the security mode for mesh access points:
Pre-Shared Key (PSK) or Extensible Authentication
Protocol (EAP).

Note EAP must be selected if external MAC filter
authorization using a RADIUS server is
configured.

Note Local EAP or PSK authentication is performed
within the controller if the External MAC Filter
Authorization parameter is disabled (check box
unchecked).

Options: PSK or EAP

Default: EAP
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Parameter

Description

External MAC Filter Authorization

MAC filtering uses the local MAC filter on the controller
by default.

When external MAC filter authorization is enabled, if the
MAC address is not found in the local MAC filter, then the
MAC address in the external RADIUS server is used.

This protects your network against rogue mesh access points
by preventing mesh access points that are not defined on
the external server from joining.

Before employing external authentication within the mesh
network, the following configuration is required:

* The RADIUS server to be used as an AAA server must
be configured on the controller.

* The controller must also be configured on the RADIUS
server.

* The mesh access point configured for external
authorization and authentication must be added to the
user list of the RADIUS server.

* For remote authorization and authentication,
EAP-FAST uses the manufacturer’s certificate
(CERT) to authenticate the child mesh access
point. Additionally, this manufacturer
certificate-based identity serves as the username
for the mesh access point in user validation.

* For I0S-based mesh access points (1130, 1240),
the platform name of the mesh access point is
located in front of its Ethernet address within the
certificate; therefore, their username for external
RADIUS servers is
platform_name_string—Ethernet MAC address
such as ¢1520-001122334455.

* The certificates must be installed and EAP-FAST must
be configured on the RADIUS server.

Note When this capability is not enabled, by
default, the controller authorizes and
authenticates mesh access points using the
MAC address filter.

Default: Disabled.
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Parameter Description

Force External Authorization When enabled along with EAP and External MAC Filter
Authorization parameters, external authorization and
authentication of mesh access points is done by default by
an external RADIUS server (such as Cisco 4.1 and later).
The RADIUS server overrides local authentication of the
MAC address by the controller which is the default.

Default: Disabled.

Step 3 Click Apply.
Step 4 Click Save Configuration.

Configuring Global Mesh Parameters (CLI)

To configure global mesh parameters including authentication methods using the controller CLI, follow these
steps:

)

Note See the Configuring Global Mesh Parameters (GUI) section for descriptions, valid ranges, and default values
of the parameters used in the CLI commands.

Step 1 To specify the maximum range (in feet) of all mesh access points in the network, enter this command:
config mesh range feet

To see the current range, enter the show mesh range command.

Step 2 To enable or disable IDS reports for all traffic on the backhaul, enter this command:

config mesh ids-state {enable | disable}
Step 3 To specify the rate (in Mbps) at which data is shared between access points on the backhaul interface, enter this command:
config ap bhrate {rate | auto} Cisco AP

Step 4 To enable or disable client association on the primary backhaul (802.11a) of a mesh access point, enter these commands:
config mesh client-access {enable | disable}
config ap wlan {enable | disable} 802.11a Cisco 4P
config ap wlan {add | delete} 802.11a wlan_id Cisco AP

Step 5 To enable or disable VLAN transparent, enter this command:

config mesh ethernet-bridging VLAN-transparent {enable | disable}

Step 6 To define a security mode for the mesh access point, enter one of the following commands:

a) To provide local authentication of the mesh access point by the controller, enter this command:
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. Viewing Global Mesh Parameter Settings (CLI)

b)

d)

config mesh security {eap | psk}

To store the MAC address filter in an external RADIUS server for authentication instead of the controller (local),
enter these commands:

config macfilter mac-delimiter colon
config mesh security rad-mac-filter enable
config mesh radius-server index enable

To provide external authentication on a RADIUS server and define a local MAC filter on the controller, enter these
commands:

config mesh security eap

config macfilter mac-delimiter colon
config mesh security rad-mac-filter enable
config mesh radius-server index enable

config mesh security force-ext-auth enable

To provide external authentication on a RADIUS server using a MAC username (such as c1520-123456) on the
RADIUS server, enter these commands:

config macfilter mac-delimiter colon
config mesh security rad-mac-filter enable
config mesh radius-server index enable

config mesh security force-ext-auth enable

Step 7 To save your changes, enter this command:

save config

Viewing Global Mesh Parameter Settings (CLI)

Use these commands to obtain information on global mesh settings:

» show mesh client-access—When Backhaul Client Access is enabled, it allows wireless client association
over the backhaul radio. Generally, backhaul radio is a 5-GHz radio for most of the mesh access points.
This means that a backhaul radio can carry both backhaul traffic and client traffic.

When Backhaul Client Access is disabled, only backhaul traffic is sent over the backhaul radio and client
association is only over the second radio(s).

(Cisco Controller)> show mesh client-access
Backhaul with client access status: enabled
* show mesh ids-state—Shows the status of the IDS reports on the backhaul as either enabled or disabled.

(Cisco Controller)> show mesh ids-state
Outdoor Mesh IDS(Rogue/Signature Detect): .... Disabled
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» show mesh config—Displays global configuration settings.

(Cisco Controller)> show mesh config
Mesh RaANGE . .t ittt ittt ettt et teeaaeenn
Mesh Statistics update period............
Backhaul with client access status
Background Scanning State................
Backhaul Amsdu State............ ... . ...

Mesh Security

Security Mode. ..ottt ittt ettt
External-Auth. ... ... ..ttt
Use MAC Filter in External AAA server
Force External Authentication.................

Mesh Alarm Criteria

Max HOp CoUunt ...ttt iiiiiiiiiiieeeeennn

Recommended Max Children for MAP
Recommended Max Children for RAP

Low Link SNR. ..ttt ittt it iiiae e
High Link SNR. .. ...ttt ittt iie e
Max Association Number............ouieeiiinenn..
Association Interval........iiuiiiiiiieinnnnnnn
Parent Change Numbers..........c.iiiiieeennnnn.
Parent Change Interval.........c.iiiiiiiinnnnn.

Mesh Multicast Mode.......iiiiiiiiinnenann
Mesh Full Sector DES......iiiitiiinnnnenn

Mesh Ethernet Bridging VLAN Transparent Mode

Mesh Backhaul at 5 and 2.4 Ghz in Release 8.2 .

12000

3 minutes
disabled
enabled
disabled

EAP

disabled
disabled
disabled

minutes

minutes

In-Out
enabled

Mesh Backhaul at5 and 2.4 Ghz in Release 8.2

Prior to release 8.2 Wireless Mesh Backhaul was supported only at SGHz. In release 8.2 Wireless Mesh

backhaul is supported at 5 and 2.4 GHz.

In certain countries it is not allowed to use Mesh Network with 5 Ghz backhaul network or even in the courtiers
when 5Ghz is permitted customer may prefer to use 2.4 Ghz radio frequencies to achieve much larger Mesh

or Bridge distances.

When a RAP gets change of the configuration from 5 to 2.4 Ghz that selection gets propagated from RAP to
all MAPs and they will disconnect from 5Ghz network and get reconnected at 2.4 Ghz. Please note if configuring
2.4Ghz make sure all Controllers are configured with version 8.2 so that 2.4 Ghz backhaul is recognized.
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. Mesh Backhaul at 5 and 2.4 Ghz in Release 8.2

A\

Note Only RAPs are configured with the backhaul frequency of 5 or 2.4GHz. Once RAP is configured that frequency

selection will propagate down the branch to all MAPs.

| MSE
4
—g .%i—m GHz Access

2.4 GHz Acce

L3/L2 switch RAP MAP Eﬁﬁ
(Root AP) Backhaul 2.4GHz (Mesh AP L2 switch

WLC A/ ="} 5 GHz Access
[ Backhaul 2.4GHz e
CPI L2 |0 e T T LTl §
S Wired access MAP 00000

7
@ Backhaul 2.4GHz E

y /v

=

Step 1 To configure Mesh Backhaul to 2.4 Ghz one simple step is required on the controller. As illustrated configure the RAP

Downlink Backhaul to 2.4 Ghz and hit Enable.

Note In the example below a Controller Global 2.4 GHz configuration is shown. When it is done on the global
configuration it will apply to all Mesh RAPs. Chanel provisioning can be done also on individual RAP in that

case the Chanel provisioning will apply only to that specific RAP branch of parents and children
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TIMIIE

CISCO

CONTROLLER

Mesh Backhaul at 5 and 2.4 Ghz in Release 8.2 .

WIRELESS  SECURITY

YWireless

* Arooess Points
all APs
= Fadios

Cwal-Band Radios
Global Configuration

F Advanced
Mesh

F ATF
RF Profiles

FlexConnect Groups
FlaxConnact ACLS

Fle nnEct WLAN
Templatas

DEAP ACLS

Metwiork Lists
F BD2.11a/nfac
b B802.11b/a/n
F Media Stream

Genaral

Rangs (FoothP to MeshaP)

IDS(Rogue and Signature
Dietechon)

Backhaul Chent Access

Extended Backhaul Chent Access
Mash DCA Channels £

Global Public Safety

Mesh Backhaul REM

Cutdoor Ext. UNII B Domain
Channels

Mesh RAP Downlink Backhaul

RAP Downlink &ackhqg/

& GHz ® 2.4 GHz

Enable |

12000 feet
Enabled

¥ Enasbled
Enabled
' Enabled
Enabled

¥ Enasbled

Enabled

From the CLI you can issue "show mesh ap tree" and "show mesh backhaul <ap-name> to see the backhaul connection.
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. Mesh Backhaul at 5 and 2.4 Ghz in Release 8.2

[EEEE-Hklzlbahuw meah ap tree I

|1 AP Hoame [Hop Counter, Link 3NR, Bridge Group HName] ||

[Sector 1]
AF1572=Ta7L.08cO [0, 0, tme]
| =AF1532=-3546.£14c[1,37,tme]
| =AP1532-3546.£678[1,28, tme]

Hiaabatr Of Eash KPS oo oo o6 o6 o0 o 0w os 5 0s os 5d ososos o
ot Of RAPS. oo o as o o s ass o aos s G d i G dE i @ 1
Haaas Of BEPE . oo oo oo oo i o o i o G S o o 6 o e

[(S520-H&l) >ahow meah backhaul 7

<Ciaco AP> Enter the nmme of the Ciaco AF.

[S520-HA1M =ahow meah backhaul AP1532-3546.1f14c

Cucrent Backhaul Sloti®) .ciisnsossssnsosssnsannans L

Basic Attributea for Slot 1

Radio TYPE...ovvvvnnrsenrrrnsnssnssnnnnsnnssns RADIO TYPE 80211n-5
PRdic Subbeiedc . oo o o s s o i a o dod @d @ @ dw RADIO SUBBAND KLL
Fadio RolE...cieevscnsnnsnsnsssnnanssnsnnssns UPDOWNLINE ACCESS
Administrative State ....evvevrnnrrscncnense. ADHIN ENABLED
CPRERELON BEWEE o s as oo s i oo as s ios as aw dw e i

Current Tx Power Level ......covvesnsunnnns 1

CucEwnt CHENDELl . o6 o6 o0 o as 56 aw am o o6 as o e DA

ANERTIE TVDE G oo a6 s s oo dos o G aos o G o e E i EXTERNAL ANTENNA

External Antenna Cain (in .5 4dBm unita) . ... O

(55z0-Ha1) >

Step 2 On the RAP the channel has to be changed to 2.4GHz and channel has to be custom selected and that selection will be
propagated to all MAPs and "children" in the Branch of that RAP.
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Mesh Backhaul at 5 and 2.4 Ghz in Release 8.2 .

MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS
Wireless 802.11b/g/n Radios
* Access Points CurantFlitars  MON® [chanaa Filtar] [Clear Filtar]
All APs
11a/n/ac
* s e AP Name Radio Slot# Base Radio MAC  Admin Status Operational Status Channel Cloan Air Admin Status  Claan Air Oper Status  Power Lavel  Antenna
Dual-Band Radios APBOAA. 7792, 7868 ] b0:aa:77:92:52: Enable up 1* NA HA [ 24 Internal [~}
Glabal Canfigurati
e GUIBHEN apge20.360a.1826 0 34:a8:46:08:02; Enable up 6% Disable DOWN e Extarnal -]
» Advanced APTcad. 74 d22e 0 0B:cei68:cctbB: 71 Enable up 6" Enable up 8" Intgrmal a
Mesh APTcad. 74H.dDes 0 0Bicci68:ceibIicl Ensble up 1 Enable up 8 Intetyal -]
b ATF I £4:76:35,dA:43:6 Foahle Lp 1% Enshle L i
RF Profiles AP1572-7a7£ 090 Q 1e:i6s:78:TFideid Enable up 11 Enable up T* External a
C i e 3 FbbrcavEa T Ersble " = i o 1 T
Groups AP1532-3546.F14c 0 20ibbic0i7211ait Enable up 11 A A 4 External a
Flex nec ACLs

After Channel is selected under the Custom option that channel will be used for the RAP Backhaul.

Note RAPs can participate in the RRM process with other RAPs in the same RF domain, however MAP only inherit
the same channel from RAP and stick with it.

HONITOR  WLANS CONTROLLER  WIRELESS ZECURITY

Wirelass 802.11b/g/n Cisco APs > Configure

* Access Points

All &Pg
Rad ;
s 0_; - General RF Backhaul Channel Assignment
B02.11an 8¢
EDZ.11ibfaln .
Dusl-Band Badios AP Hama AP1572-7aTEOFD Currant Channel 11
Global Configuration Adrniin Status Enshle Channel Width :-20 MHz W
b Advanced Oparational Status up Assignmant Mathaod Cralobal
HMesh Slat # 0 ®custem (11 ¥

F ATF Mote: Ondy Channels 16 and 11 are noroweriapping
LINK PARAMETERS

Ll T Povier Level Assignment
ElexConnect Radio Role DOWHLINE ACCESS
Eourca Backhawl MaC 1C8A: 7A TR 1EI DD Current Tx Pover Level o
Asgignrnant Methad (@alobal
11n Parameters =
OEAP ACLs ACEam
Hetwork Lists 11n Supported Ves
b B0Z.11afnjac Elesrii Performance Profile
Foanz.iibfgin view and edit Performasnce Profils for this AP
¢ HMedia Stream Cleanair Capable Wik Performance Profile
Application Clesnair Admin Status Ensble ¥
e * Gl anable wil ok a#uc oy # .55 anabiad 0 this band G e ot i

Hurakhar of Snsmaiee Evnad

After the Channel change on the RAP as illustrated in the example below, the channel on the MAP has changed to CH11
in 2.4 GHz band.

Example of the MAP CLI command: show mesh backhaul <ap-name>
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. Backhaul Client Access

[9520-HA1) >2how mesh backhaul AP157Z-7a71.08cd
Current Backhaul S10T[B) sesesssssnnnnnnnnnnnnnnns U

Bamsic Acctribuces for 3lot O
Badio TY¥pE...cesennesncsnsnsennsnennnsnsnneses BADID TYPE S80211n-Z.4
Badio PFole...csessnsnsnsssssssnsnnnnnnnnnnnsss LWOWNLINKE ROCESS
AdminiaTrACive SCACE ..veeseesesnnsnsnsnsesns ADHIN ENABLED
OpEraCi0on STATE ..cwsnssssnnsnnnsnnnnnnnnnnnn UP
Current Tx Power Lewve]l ....ccvveuananunanas f
Current Chann®]l ..cesssssssnsnsnnnnnsnsnsss 11
Ancents TYPE. .cwewsesnsnsensnnennnsnsnenses EXTERNAL ANTENHA
External Antenna ¢aAln (in .5 dBm unict3) .... O

If for example you would try to change the Backhaul channel on the MAP you will get an error message since this
functionality is not supported on the MAPs. MAPs and “map children” receive their Channel assignments from the
upstream parent RAP. An example of the error message from the MAP is as shown.

Thiss configuration is only supported for Rool APs
[ Present this page from creating sddtionsl dalogs

Backhaul Client Access

‘When Backhaul Client Access is enabled, it allows wireless client association over the backhaul radio. The
backhaul radio is a 5 GHz radio. This means that a backhaul radio can carry both backhaul traffic and client
traffic.

When Backhaul Client Access is disabled, only backhaul traffic is sent over the backhaul radio and client
association is only over the second radio(s).
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Configuring Backhaul Client Access (GUI) .

Note

Backhaul Client Access is disabled by default. After this feature is enabled, all mesh access points, except
slave AP and its child APs in Daisy-chained deployment, reboot.

This feature is applicable to mesh access points with two radios (1552, 1532, 1540, 1560, 1572, and Indoor
APs in Bridge mode).

Configuring Backhaul Client Access (GUI)

This figure shows how to enable Backhaul Client Access using the GUI. You will be prompted that the AP
will reboot if you enable Backhaul Client Access.

Figure 32: Configuring Backhaul Client Access using the GUI

MONITOR  WIANs CONTROLLER. WNIRELES CURITY  MAMNAGEMENT COMMANDS HELP EEEDB

Wirelass Mash

* Access Points

Al aps General
w Radios
E02.11afn Range (ROOLAP to MeshAF) 12000 foat
E02.41b/a/n
Glnbal Configuration éiﬁgg?f:f Sud:Ehitien enables
» Advanced Backhaul Client Avcsse ¥ Enatled
s Extended Backhaul Cliant Access ] Enatled
HREAP Groups Mash DCA Channels 1 [l Enshied
» BOZ.1la/n Global Public Safsty [ enabled

-

B0Z.11bjg/n

Ethernet Bridgin
Media Strea gl

-

Country VLAN Tramsparent ] Enabled
Timaors -
Security
P Qs
Security Made |EAR w
External MAC Filter Autherization ] Enabled
Fores External Authantication [ Enabled
Server 1D Server Address Part Enahled
Fool Notes

I ezt DOA chanmelt are only spplicabls for rerial becihanl APz

331459

What to do next

In a Flex+Bridge deployment, after you enable Backhaul Client Access globally, for the 5-GHz radios to
beacon as expected, you must enable the Install mapping on radio backhaul option for the root APs operating
in Flex+Bridge mode.

For more information about enabling the Install mapping on radio backhaul option, see the "Configuring
Flex+Bridge Mode (GUI)" section at:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-8/config-guide/b_cg88/
flexconnect.html#config-flex-bridge-gui
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Configuring Backhaul Client Access (CLI)

Use the following command to enable Backhaul Client Access:
(Cisco Controller)> config mesh client-access enable

The following message is displayed:

All Mesh APs will be rebooted
Are you sure you want to start? (y/N)

What to do next

In a Flex+Bridge deployment, to have the 5-GHz radios beacon as expected, after you enable Backhaul Client
Access globally, you must enable the Install mapping on radio backhaul option for the root APs operating
in Flex+Bridge mode.

For more information about enabling the Install mapping on radio backhaul option, see the "Configuring
Flex+Bridge Mode (CLI)" section at:

https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-8/config-guide/b_cg88/
flexconnect.html#config-flex-bridge-cli

Configuring Local Mesh Parameters

After configuring global mesh parameters, you must configure the following local mesh parameters for these
specific features if in use in your network:

* Backhaul Data Rate. See the Configuring Wireless Backhaul Data Rate section.
* Ethernet Bridging. See the Configuring Ethernet Bridging section.

* Bridge Group Name. See theConfiguring Ethernet Bridging section.

» Workgroup Bridge. See the Configuring Workgroup Bridges section.

» Power and Channel Setting.

 Antenna Gain Settings. See the Configuring Antenna Gain section.

* Dynamic Channel Assignment.

Configuring Wireless Backhaul Data Rate

Backhaul is used to create only the wireless connection between the access points. The backhaul interface
vary between 802.11a/n/ac rates depending upon the access point. The rate selection is important for effective
use of the available RF spectrum. The rate can also affect the throughput of client devices, and throughput is
an important metric used by industry publications to evaluate vendor devices.

Dynamic Rate Adaptation (DRA) introduces a process to estimate optimal transmission rate for packet
transmissions. It is important to select rates correctly. If the rate is too high, packet transmissions fail resulting
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in communication failure. If the rate is too low, the available channel bandwidth is not used, resulting in
inferior products, and the potential for catastrophic network congestion and collapse.

Data rates also affect the RF coverage and network performance. Lower data rates, for example 6 Mbps, can
extend farther from the access point than can higher data rates, for example 1300 Mbps. As a result, the data
rate affects cell coverage and consequently the number of access points required. Different data rates are
achieved by sending a more redundant signal on the wireless link, allowing data to be easily recovered from
noise. The number of symbols sent out for a packet at the 1-Mbps data rate is higher than the number of
symbols used for the same packet at 11 Mbps. Therefore, sending data at the lower bit rates takes more time
than sending the equivalent data at a higher bit rate, resulting in reduced throughput.

In the controller release 5.2, the default data rate for the mesh 5-GHz backhaul is 24 Mbps. It remains the
same with 6.0 and 7.0 controller releases.

With the 6.0 controller release, mesh backhaul can be configured for ‘Auto’ data rate. Once configured, the

access point picks the highest rate where the next higher rate cannot be used because of conditions not being
suitable for that rate and not because of conditions that affect all rates. That is, once configured, each link is
free to settle down to the best possible rate for its link quality.

We recommend that you configure the mesh backhaul to Auto.

For example, if mesh backhaul chose 48 Mbps, then this decision is taken after ensuring that we cannot use
54 Mbps as there is not enough SNR for 54 and not because some just turned the microwave oven on which
affects all rates.

A lower bit rate might allow a greater distance between MAPs, but there are likely to be gaps in the WLAN
client coverage, and the capacity of the backhaul network is reduced. An increased bit rate for the backhaul

network either requires more MAPs or results in a reduced SNR between MAPs, limiting mesh reliability and
interconnection.

This figure shows the RAP using the "auto" backhaul data rate, and it is currently using 54 Mbps with its child
MAP.
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Figure 33: Bridge Rate Set to Auto
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Note The data rate can be set on the backhaul on a per-AP basis. It is not a global command.

Related Commands  Use these commands to obtain information about backhaul:

Command Description

config ap bhrate—Configures the Cisco Bridge backhaul Tx rate.

The syntax is as follows:

(controller) > config ap bhrate backhaul-rate ap-name
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Command

Description

Note Preconfigured data rates for each AP (RAP=18 Mbps, MAP1=36 Mbps) are
preserved after the upgrade to 6.0 or later software releases.??Before you
upgrade to the 6.0 release, if you have the backhaul data rate configured to
data rate, then the configuration is preserved.

The following example shows how to configure a backhaul rate of 36000 Kb

on a RAP:

(controller) > config ap bhrate 36000 HPRAPI

show ap bhrate—Displays the Cisco Bridge backhaul rate.

The syntax is as follows:

(controller) > show ap bhrate ap-name

show mesh neigh summary—Displays the link rate summary including the current rate being used in

backhaul

Example:

(controller) > show mesh neigh summary #zpPraPrI

AP Name/Radio Channel Rate Link-Snr Flags
00:0B:85:5C:B9:20 0 auto 4 0x10e8fcb8
00:0B:85:5F:FF:60 0 auto 4 0x10e8fchb8
00:0B:85:62:1E:00 165 auto 4 0x10e8fcb8
00:0B:85:70:8C:A0 O auto 1 0x10e8fcb8
HPMAP1 165 54 40 0x36
HJMAP2 0 auto 4 0x10e8fcb8

BEACON

BEACON DEFAULT
BEACON

BEACON

CHILD BEACON
BEACON

Backhaul capacity and throughput depends upon the type of the AP, that is, if it is 802.11a/n or only 802.11a,

number of backhaul radios it has, and so on.

Configuring Ethernet Bridging

For security reasons, the Ethernet port on all MAPs is disabled by default. It can be enabled only by configuring

Ethernet bridging on the root and its respective MAP.
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Note

Exceptions are allowed for a few protocols even though Ethernet bridging is disabled. For example, the
following protocols are allowed:

* Spanning Tree Protocol (STP)

* Address Resolution Protocol (ARP)

* Control and Provisioning of Wireless Access Points (CAPWAP)
* Bootstrap Protocol (BOOTP) packets

Enable Spanning Tree Protocol (STP) on all connected switch ports to avoid Layer 2 looping.

Ethernet bridging has to be enabled for two scenarios:

1. When you want to use the mesh nodes as bridges (see Figure 34: Point-to-Multipoint Bridging, on page
120).

Note

You do not need to configure VLAN tagging to use Ethernet bridging for point-to-point and point-to-multipoint
bridging deployments.

2. When you want to connect any Ethernet device such as a video camera on the MAP using its Ethernet
port. This is the first step to enable VLAN tagging.

Figure 34: Point-to-Multipoint Bridging

Enabling Ethernet Bridging (GUI)

To enable Ethernet bridging on a RAP or MAP using the GUI, follow these steps:
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Step 1 Choose Wireless > All APs.

Step 2 Click the AP name link of the mesh access point on which you want to enable Ethernet bridging.

Step 3 At the details page, select the Mesh tab (see Figure 35: All APs > Details for (Mesh) Page, on page 121).
Figure 35: All APs > Details for (Mesh) Page
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Step 4 Select either RootAP or MeshAP from the AP Role drop-down list, if not already selected.
Step 5 Select the Ethernet Bridging check box to enable Ethernet bridging or deselect it to disable this feature.

Step 6 Click Apply to commit your changes. An Ethernet Bridging section appears at the bottom of the page listing each of the
Ethernet ports of the mesh access point.

Step 7 Ensure that you enable Ethernet bridging for every parent mesh AP taking the path from the mesh AP in question to the
controller. For example, if you enable Ethernet bridging on MAP2 in Hop 2, then you must also enable Ethernet bridging
on MAP1 (parent MAP), and on the RAP connecting to the controller.

Configuring Native VLAN (GUI)
N

Note Prior to 8.0, the Native VLAN on the wired backhaul was set as VLAN 1. Starting with the 8.0 release, the
Native VLAN can be set.

Step 1 Choose Wireless > All APs.
Step 2 Choose the mesh access point on which you would like to configure the Native VLAN.
Step 3 Check the VLAN Support checkbox on the AP.
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Step 4 Assign a Native VLAN.

Note It is important that this Native VLAN matches the Native VLAN configured on the switch port of the connected
switch.

Step 5 Click Apply to commit your changes.

Configuring Native VLAN (CLI)
A\

Note Prior to 8.0, the Native VLAN on the wired backhaul was set as VLAN 1. Starting with the 8.0 release, the
Native VLAN can be set.

1. Set the Native VLAN on the wired backhaul port using the command config ap vlan-trunking native
vian-id ap-name.

This applies the Native VLAN configuration to the access point.

Configuring Bridge Group Names

Bridge group names (BGNs) control the association of mesh access points. BGNs can logically group radios
to avoid two networks on the same channel from communicating with each other. The setting is also useful
if you have more than one RAP in your network in the same sector (area). BGN is a string of 10 characters
maximum.

A BGN of NULL VALUE is assigned by default by manufacturing. Although not visible to you, it allows a
mesh access point to join the network prior to your assignment of your network-specific BGN.
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If you have two RAPs in your network in the same sector (for more capacity), we recommend that you
configure the two RAPs with the same BGN, but on different channels.

Configuring Bridge Group Names (CLI)

Step 1 To set a bridge group name (BGN), enter this command:
config ap bridgegroupname set group-name ap-name

Note The mesh access point reboots after a BGN configuration.

Caution Exercise caution when you configure a BGN on a live network. Always start a BGN assignment from the
farthest-most node (last node, bottom of mesh tree) and move up toward the RAP to ensure that no mesh access
points are dropped due to mixed BGNs (old and new BGNs) within the same network.

Step 2 To verify the BGN, enter the following command:

show ap config general ap-name

Verifying Bridge Group Names (GUI)

Step 1 Click Wireless > Access Points > AP Name. The details page for the selected mesh access point appears.
Step 2 Click the Mesh tab. Details for the mesh access point including the BGN appears.

Configuring Power and Channel Settings

The backhaul channel (802.11a/n) can be configured on a RAP. MAPs tune to the RAP channel. The local
access can be configured independently for MAP.

Configuring Power and Channel Settings (GUI)

Step 1 Choose Wireless > Access Points > 802.11a/n.

Note Radio slots are displayed for each radio.

Step 2 Select configure from the Antenna drop-down list for the 802.11a/n radio. The Configure page is displayed.
Step 3 Assign a channel (assignment methods of global and custom) for the radio.

Step 4 Assign Tx power levels (global and custom) for the radio.
There are five selectable power levels for the 802.11a backhaul for AP1500s.
Note The default Tx power level on the backhaul is the highest power level (Level 1).
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Step 5 Click Apply when power and channel assignment are complete.

Step 6 From the 802.11a/n Radios page, verify that channel assignments were made correctly.

Configuring Antenna Gain

You must configure the antenna gain for the mesh access point to match that of the antenna installed using
the controller GUI or controller CLIL

Configuring Antenna Gain (GUI)

To configure antenna parameters using the controller GUI, follow these steps:

Step 1 Choose Wireless > Access Points > Radio > 802.11a/n to open the 802.11a/n Radios page.

Step 2 For the mesh access point antenna you want to configure, hover the mouse over the blue arrow (far right) to display
antenna options. Choose Configure.
Note Only external antennas have configurable gain settings.

Step 3 In the Antenna Parameters section, enter the antenna gain.

The gain is entered in 0.5 dBm units. For example, 2.5 dBm = 5.

Note The entered gain value must match that value specified by the vendor for that antenna.

Step 4 Click Apply and then Save Configuration to save the changes.

Configuring Antenna Gain (CLI)

Enter this command to configure the antenna gain for the 802.11a backhaul radio using the controller CLI:
config 802.11a antenna extAntGain antenna_gain AP _name

where gain is entered in 0.5-dBm units (for example, 2.5 dBm =5).

Configuring Dynamic Channel Assignment

Using the controller GUI, follow these steps to specify the channels that the dynamic channel assignment
(DCA) algorithm considers when selecting the channels to be used for RRM scanning. This functionality is
helpful when you know that the clients do not support certain channels because they are legacy devices or
they have certain regulatory restrictions.

The steps outlined in this section are only relevant to mesh networks.

Step 1 To disable the 802.11a/n or 802.11b/g/n network, follow these steps:
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Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Configuring Dynamic Channel Assignment .

a) Choose Wireless > 802.11a/n or 802.11b/g/n > Network to open the 802.11a (or 802.11b/g) Global Parameters
page.

b) Deselect the 802.11a (or 802.11b/g) Network Status check box.

c) Click Apply to commit your changes.

Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > DCA to open the 802.11a (or 802.11b/g) > RRM > Dynamic
Channel Assignment (DCA) page.

Choose one of the following options from the Channel Assignment Method drop-down list to specify the controller’s
DCA mode:

» Automatic—Causes the controller to periodically evaluate and, if necessary, update the channel assignment for
all joined mesh access points. This is the default value.

* Freeze—Causes the controller to evaluate and update the channel assignment for all joined mesh access points,
if necessary, but only when you click Invoke Channel Update Once.

Note The controller does not evaluate and update the channel assignment immediately after you click Invoke
Channel Update Once. It waits for the next interval to elapse.

* OFF—Turns off DCA and sets all mesh access point radios to the first channel of the band, which is the default
value. If you choose this option, you must manually assign channels on all radios.

From the Interval drop-down list, choose one of the following options to specify how often the DCA algorithm is
allowed to run: 10 minutes, 1 hour, 2 hours, 3 hours, 4 hours, 6 hours, 8 hours, 12 hours, or 24 hours. The default value
is 10 minutes.

From the AnchorTime drop-down list, choose a number to specify the time of day when the DCA algorithm is to start.
The options are numbers between 0 and 23 (inclusive) representing the hour of the day from 12:00 a.m. to 11:00 p.m.
Select the Avoid Foreign AP Interference check box to cause the controller’s RRM algorithms to consider 802.11
traffic from foreign access points (those access points not included in your wireless network) when assigning channels
to lightweight access points, or deselect it to disable this feature. For example, RRM may adjust the channel assignment
to have access points avoid channels close to foreign access points. The default value is checked.

Select the Avoid Cisco AP Load check box to cause the controller’s RRM algorithms to consider 802.11 traffic from
Cisco lightweight access points in your wireless network when assigning channels, or deselect it to disable this feature.
For example, RRM can assign better reuse patterns to access points that carry a heavier traffic load. The default value
is deselected.

Select the Avoid Non-802.11a (802.11b) Noise check box to cause the controller’s RRM algorithms to consider noise
(non-802.11 traffic) in the channel when assigning channels to lightweight access points, or deselect it to disable this
feature. For example, RRM may have access points avoid channels with significant interference from nonaccess point
sources, such as microwave ovens. The default value is checked.

From the DCA Channel Sensitivity drop-down list, choose one of the following options to specify how sensitive the
DCA algorithm is to environmental changes such as signal, load, noise, and interference when determining whether to
change channels:

* Low—The DCA algorithm is not particularly sensitive to environmental changes.
* Medium—The DCA algorithm is moderately sensitive to environmental changes.
* High—The DCA algorithm is highly sensitive to environmental changes.

The default value is Medium.
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Step 10

Step 11

Step 12

Step 13
Step 14

Table 10: DCA Sensitivity Thresholds

Option 2.4-GHz DCA Sensitivity Threshold 5-GHz DCA Sensitivity Threshold
High 5dB 5dB

Medium 15dB 20 dB

Low 30dB 35dB

For 802.11a/n networks only, choose one of the following Channel Width options to specify the channel bandwidth
supported for all 802.11 n/a/ac radios in the 5-GHz band:

* 20 MHz—The 20-MHz channel bandwidth (default)

Note To override the globally configured DCA channel width setting, you can statically configure an access
point’s radio for 20-MHz mode on the 802.11a/n Cisco APs > Configure page. If you ever change the
static RF channel assignment method to Global on the access point radio, the global DCA configuration
overrides the channel width configuration that the access point was previously using.

This page also shows the following nonconfigurable channel parameter settings:

* Channel Assignment Leader—The MAC address of the RF group leader, which is responsible for channel
assignment.

» Last Auto Channel Assignment—The last time RRM evaluated the current channel assignments.

In the DCA Channel List section, the DCA Channels field shows the channels that are currently selected. To choose a
channel, select its check box in the Select column. To exclude a channel, deselect its check box.

Range: 802.11a—36, 40, 44, 48, 52, 56, 60, 64, 100, 104, 108, 112, 116, 132, 136, 140, 149, 153, 157, 161, 165, 190,
196?802.11b/g—1,2,3,4,5,6,7,8,9, 10, 11

Default: 802.11a—36, 40, 44, 48, 52, 56, 60, 64, 100, 104, 108, 112, 116, 132, 136, 140, 149, 153, 157,
1617802.11b/g—1, 6, 11

Note These extended UNII-2 channels in the 802.11a band do not appear in the channel list: 100, 104, 108, 112,
116, 132, 136, and 140. If you have Cisco Aironet 1500 series mesh access points in the -E regulatory domain,
you must include these channels in the DCA channel list before you start operation. If you are upgrading
from a previous release, verify that these channels are included in the DCA channel list. To include these
channels in the channel list, select the Extended UNII-2 Channels check box.

If you are using AP1500s in your network, you must set the 4.9-GHz channels in the 802.11a band on which they are
to operate. The 4.9-GHz band is for public safety client access traffic only. To choose a 4.9-GHz channel, select its
check box in the Select column. To exclude a channel, deselect its check box.

Range: 7802.11a—1,2, 3,4, 5,6,7,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26
Default:?802.11a—20, 26

Click Apply to commit your changes.

To reenable the 802.11a or 802.11b/g network, follow these steps:

a) Click Wireless > 802.11a/n or 802.11b/g/n > Network to open the 802.11a (or 802.11b/g) Global Parameters
page.

b) Select the 802.11a (or 802.11b/g) Network Status check box.

c) Click Apply to commit your changes.
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Step 15

Note

Configuring Radio Resource Management on a Bridge Mode Access Point .

Click Save Configuration to save your changes.

To see why the DCA algorithm changed channels, click Monitor and then View All under Most Recent
Traps. The trap provides the MAC address of the radio that changed channels, the previous channel and the
new channel, the reason why the change occurred, the energy before and after the change, the noise before
and after the change, and the interference before and after the change. Dynamic Channel Assignment on 5
GHz radio is supported only on outdoor access points in local or flexconnect mode.

Configuring Radio Resource Management on a Bridge Mode
Access Point

Radio Resource Management (RRM) can be enabled on the backhaul radio of a bridge mode access point if:
* AP is aroot AP (RAP)
* RAP has a wired Ethernet link to a WLC
* RAP has no child Mesh APs connected to it

Once these conditions are met, full RRM will be established, including transmit power control (TPC), Dynamic

Channel Assignment (DCA), and Coverage Hole Detection and Mitigation (CHDM). If a Mesh AP needs to
re-join a RAP participating in RRM, the RAP will immediately stop all RRM functionality.

The following commands enable RRM:

« config mesh backhaul rrm <enable|disable> — To enable RRM on the mesh backhaul radio

* Config mesh backhaul rrm <auto-rf global|off> — To enable/disable dynamic channel assignment
only
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Configuring Advanced Features

Configuring Ethernet VLAN Tagging

Ethernet VLAN tagging allows specific application traffic to be segmented within a wireless mesh network
and then forwarded (bridged) to a wired LAN (access mode) or bridged to another wireless mesh network
(trunk mode).

A typical public safety access application that uses Ethernet VLAN tagging is the placement of video
surveillance cameras at various outdoor locations within a city. Each of these video cameras has a wired
connection to a MAP. The video of all these cameras is then streamed across the wireless backhaul to a central
command station on a wired network.

Figure 36: Ethernet VLAN Tagging
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Ethernet Port Notes

Ethernet VLAN tagging allows Ethernet ports to be configured as normal, access, or trunk in both indoor and
outdoor implementations:

)

Note When VLAN Transparent is disabled, the default Ethernet port mode is normal. VLAN Transparent must be
disabled for VLAN tagging to operate and to allow configuration of Ethernet ports. To disable VLAN
Transparent, which is a global parameter, see the Configuring Global Mesh Parameters section.

» Normal mode—In this mode, the Ethernet port does not accept or send any tagged packets. Tagged
frames from clients are dropped.

Use the normal mode in applications when only a single VLAN is in use or there is no need to segment
traffic in the network across multiple VLANS.

* Access Mode—In this mode, only untagged packets are accepted. All incoming packets are tagged with
user-configured VLANS called access-VLANS.

Use the access mode for applications in which information is collected from devices connected to the
MAP, such as cameras or PCs, and then forwarded to the RAP. The RAP then applies tags and forwards
traffic to a switch on the wired network.

* Trunk mode—This mode requires the user to configure a native VLAN and an allowed VLAN list (no
defaults). In this mode, both tagged and untagged packets are accepted. Untagged packets are accepted
and are tagged with the user-specified native VLAN. Tagged packets are accepted if they are tagged with
a VLAN in the allowed VLAN list.

+ Use the trunk mode for bridging applications such as forwarding traffic between two MAPs that reside
on separate buildings within a campus.

Ethernet VLAN tagging operates on Ethernet ports that are not used as backhauls.

)

Note In the controller releases prior to 7.2, the Root Access Point (RAP) native VLAN is forwarded out of Mesh
Access Point (MAP) Ethernet ports with Mesh Ethernet Bridging and VLAN Transparent enabled.

In the 7.2 and 7.4 releases, the Root Access Point (RAP) native VLAN is not forwarded out of Mesh Access
Point (MAP) Ethernet ports with Mesh Ethernet Bridging and VLAN Transparent enabled. This behavior is
changed starting 7.6, where the native VLAN is forwarded by the MAP when VLAN transparent is enabled.

This change in behavior increases reliability and minimizes the possibility of forwarding loops on Mesh
Backhauls.

VLAN Registration

To support a VLAN on a mesh access point, all the uplink mesh access points must also support the same
VLAN to allow segregation of traffic that belongs to different VLANs. The activity by which an mesh access
point communicates its requirements for a VLAN and gets response from a parent is known as VLAN
registration.
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Note VLAN registration occurs automatically. No user intervention is required.

VLAN registration is summarized below:

1. Whenever an Ethernet port on a mesh access point is configured with a VLAN, the port requests its parent
to support that VLAN.

2. If the parent is able to support the request, it creates a bridge group for the VLAN and propagates the
request to its parent. This propagation continues until the RAP is reached.

3. When the request reaches the RAP, it checks whether it is able to support the VLAN request. If yes, the
RAP creates a bridge group and a subinterface on its uplink Ethernet interface to support the VLAN
request.

4. Ifthe mesh access point is not able to support the VLAN request by its child, at any point, the mesh access
point replies with a negative response. This response is propagated to downstream mesh access points
until the mesh access point that requested the VLAN is reached.

5. Upon receiving negative response from its parent, the requesting mesh access point defers the configuration
ofthe VLAN. However, the configuration is stored for future attempts. Given the dynamic nature of mesh,
another parent and its uplink mesh access points might be able to support it in the case of roaming or a
CAPWAP reconnect.

Ethernet VLAN Tagging Guidelines
Follow these guidelines for Ethernet tagging:

* For security reasons, the Ethernet port on a mesh access point (RAP and MAP) is disabled by default. It
is enabled by configuring Ethernet bridging on the mesh access point port.

* Ethernet bridging must be enabled on all the mesh access points in the mesh network to allow Ethernet
VLAN tagging to operate.

* VLAN mode must be set as non-VLAN transparent (global mesh parameter). See the Configuring Global
Mesh Parameters (CLI) section. VLAN transparent is enabled by default. To set as non-VLAN transparent,
you must unselect the VLAN transparent option on the Wireless > Mesh page.

* VLAN tagging can only be configured on Ethernet interfaces as follows:

* On AP1500s, three of the four ports can be used as secondary Ethernet interfaces: port 0-PoE in,
port 1-PoE out, and port 3- fiber. Port 2 - cable cannot be configured as a secondary Ethernet
interface.

* In Ethernet VLAN tagging, port 0-PoE in on the RAP is used to connect to the trunk port of the
switch of the wired network. Port 1-PoE out on the MAP is used to connect to external devices such
as video cameras.

* Backhaul interfaces (802.11a radios) act as primary Ethernet interfaces. Backhauls function as trunks in
the network and carry all VLAN traffic between the wireless and wired network. No configuration of
primary Ethernet interfaces is required.

* For indoor mesh networks, the VLAN tagging feature functions as it does for outdoor mesh networks.
Any access port that is not acting as a backhaul is secondary and can be used for VLAN tagging.
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* VLAN tagging cannot be implemented on RAPs because the RAPs do not have a secondary Ethernet
port, and the primary port is used as a backhaul. However, VLAN tagging can be enabled on MAPs with
a single Ethernet port because the Ethernet port on a MAP does not function as a backhaul and is therefore
a secondary port.

* No configuration changes are applied to any Ethernet interface acting as a backhaul. A warning displays
if you attempt to modify the backhaul’s configuration. The configuration is only applied after the interface
is no longer acting as a backhaul.

* No configuration is required to support VLAN tagging on any 802.11a backhaul Ethernet interface within
the mesh network as follows:

* This includes the RAP uplink Ethernet port. The required configuration occurs automatically using
a registration mechanism.

* Any configuration changes to an 802.11a Ethernet link acting as a backhaul are ignored and a
warning results. When the Ethernet link no longer functions as a backhaul, the modified configuration
is applied.

* VLAN configuration is not allowed on port-02-cable modem port of AP1500s (wherever applicable).
VLANS can be configured on ports 0 (PoE-in), 1 (PoE-out), and 3 (fiber).

» Up to 16 VLANS are supported on each sector. The cumulative number of VLANSs supported by a RAP’s
children (MAP) cannot exceed 16.

* The switch port connected to the RAP must be a trunk:

* The trunk port on the switch and the RAP trunk port must match.

* The RAP must always connect to the native VLAN ID 1 on a switch. The RAP’s primary Ethernet
interface is by default the native VLAN of 1.

¢ The switch port in the wired network that is attached to the RAP (port 0—PoE in) must be configured
to accept tagged packets on its trunk port. The RAP forwards all tagged packets received from the
mesh network to the wired network.

* No VLAN:S, other than those destined for the mesh sector, should be configured on the switch trunk
port.

* A configured VLAN on a MAP Ethernet port cannot function as a Management VLAN.

* Configuration is effective only when a mesh access point is in the CAPWAP RUN state and
VLAN-Transparent mode is disabled.

* Whenever there roaming or a CAPWARP restart, an attempt is made to apply configuration again.

Enabling Ethernet VLAN Tagging (GUI)

You must enable Ethernet bridging before you can configure VLAN tagging.
To enable VLAN tagging on a RAP or MAP using the GUI, follow these steps:

Step 1 After enabling Ethernet bridging, choose Wireless > All APs.
Step 2 Click the AP name link of the mesh access point on which you want to enable VLAN tagging.
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Step 3
Step 4

Step 5
Step 6

On the details page, select the Mesh tab.
Select the Ethernet Bridging check box to enable the feature and click Apply.

An Ethernet Bridging section appears at the bottom of the page listing each of the four Ethernet ports of the mesh access
point.

* If configuring a MAP access port, click, for example, gigabitEthernetl (port 1-PoE out).
Select access from the mode drop-down list.
Enter a VLAN ID. The VLAN ID can be any value between 1 and 4095.
Click Apply.
Note VLAN ID 1 is not reserved as the default VLAN.

Note A maximum of 16 VLANS are supported across all of a RAP’s subordinate MAP.

If configuring a RAP or MAP frunk port, click gigabitEthernet0 (port 0-PoE in).
Select trunk from the mode drop-down list.

Specify a native VLAN ID for incoming traffic. The native VLAN ID can be any value between 1 and 4095. Do not
assign any value assigned to a user-VLAN (access).

Click Apply.

A trunk VLAN ID field and a summary of configured VLANs appears at the bottom of the screen. The trunk VLAN
ID field is for outgoing packets.

Specify a trunk VLAN ID for outgoing packets:

If forwarding untagged packets, do not change the default trunk VLAN ID value of zero. (MAP-to-MAP bridging,
campus environment)

If forwarding fagged packets, enter a VLAN ID (1 to 4095) that is not already assigned. (RAP to switch on wired
network).

Click Add to add the trunk VLAN ID to the allowed VLAN list. The newly added VLAN displays under the
Configured VLANS section on the page.

Note To remove a VLAN from the list, select the Remove option from the arrow drop-down list to the right of
the desired VLAN.

Click Apply.
Click Save Configuration to save your changes.

Configuring Ethernet VLAN Tagging (CLI)

To configure a MAP access port, enter this command:

config ap ethernet 1 mode access enable AP1500-MAP 50

where AP1500-MAP is the variable AP _name and 50 is the variable access_vian ID
To configure a RAP or MAP trunk port, enter this command:

config ap ethernet 0 mode trunk enable AP1500-MAP 60
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where AP1500-MAP is the variable AP_name and 60 is the variable native vian ID
To add a VLAN to the VLAN allowed list of the native VLAN, enter this command:
config ap ethernet 0 mode trunk add AP1500-MAP3 65

where AP1500-MAP 3 is the variable AP_name and 63 is the variable VLAN ID

Viewing Ethernet VLAN Tagging Configuration Details (CLI)

Procedure

* To view VLAN configuration details for Ethernet interfaces on a specific mesh access point (4P Name)
or all mesh access points (summary), enter this command:

show ap config ethernet ap-name
* To see if VLAN transparent mode is enabled or disabled, enter this command:

show mesh config

Workgroup Bridge Interoperability with Mesh Infrastructure

A workgroup bridge (WGB) is a small standalone unit that can provide a wireless infrastructure connection
for Ethernet-enabled devices. Devices that do not have a wireless client adapter to connect to the wireless
network can be connected to the WGB through the Ethernet port. The WGB is associated with the root AP
through the wireless interface, which means that wired clients get access to the wireless network.

A WGB is used to connect wired networks over a single wireless segment by informing the mesh access point
of all the clients that the WGB has on its wired segment via IAPP messages. The data packets for WGB clients
contain an additional MAC address in the 802.11 header (4 MAC headers, versus the normal 3 MAC data
headers). The additional MAC in the header is the address of the WGB itself. This additional MAC address
is used to route the packet to and from the clients.

WGB association is supported on all radios of every mesh access point.

In the current architecture, while an autonomous AP functions as a workgroup bridge, only one radio interface
is used for controller connectivity, Ethernet interface for wired client connectivity, and other radio interface

for wireless client connectivity. dotl1radio 1 (5 GHz) can be used to connect to a controller (using the mesh
infrastructure) and Ethernet interface for wired clients. dotl1radio 0 (2.4 GHz) can be used for wireless client
connectivity. Depending on the requirement, dotl1radio 1 or dotl1radio O can be used for client association

or controller connectivity.

With the 7.0 release, a wireless client on the second radio of the WGB is not dissociated by the WGB upon
losing its uplink to a wireless infrastructure or in a roaming scenario.

With two radios, one radio can be used for client access and the other radio can be used for accessing the
access points. Having two independent radios performing two independent functions provides you better
control and lowers the latency. Also, wireless clients on the second radio for the WGB do not get disassociated
by the WGB when an uplink is lost or in a roaming scenario. One radio has to be configured as a Root AP
(radio role) and the second radio has to be configured as a WGB (radio role).

Note

If one radio is configured as a WGB, then the second radio cannot be a WGB or a repeater.
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The following features are not supported for use with a WGB:

« Idle timeout

» Web authentication—If a WGB associates to a web-authentication WLAN, the WGB is added to the
exclusion list, and all of the WGB-wired clients are deleted (web-authentication WLAN is another name
for a guest WLAN).

* For wired clients behind the WGB, MAC filtering, link tests, and idle timeout

Configuring Workgroup Bridges

A workgroup bridge (WGB) is used to connect wired networks over a single wireless segment by informing
the mesh access point of all the clients that the WGB has on its wired segment via IAPP messages. In addition
to the IAPP control messages, the data packets for WGB clients contain an extra MAC address in the 802.11
header (4 MAC headers, versus the normal 3 MAC data headers). The extra MAC in the header is the address
of the workgroup bridge itself. This extra MAC address is used to route the packet to and from the clients.

WGB association is supported on both the 2.4-GHz (802.11b/g) and 5-GHz (802.11a) radios on all Cisco
APs.

Supported platforms are autonomous 1600, 1700, 2600, 2700, 3600, 3700, 1530, 1550, and 1570, which are
configured as WGBs can associate with a mesh access point. See the “Cisco Workgroup Bridges” section in
Cisco Wireless LAN Controller Configuration Guide for configuration steps at https://www.cisco.com/c/en/

us/support/wireless/8500-series-wireless-controllers/products-installation-and-configuration-guides-list.html

The supported WGB modes and capacities are as follows:

* The autonomous access points configured as WGBs must be running Cisco 10S release 12.4.25d-JA or
later.

A\

Note If your mesh access point has two radios, you can only configure workgroup
bridge mode on one of the radios. We recommend that you disable the second
radio. Workgroup bridge mode is not supported on access points with three radios.

* Client mode WGB (BSS) is supported; however, infrastructure WGB is not supported. The client mode
WGB is not able to trunk VLAN as in an infrastructure WGB.

* Multicast traffic is not reliably transmitted to WGB because no ACKs are returned by the client. Multicast
traffic is unicast to infrastructure WGB, and ACKs are received back.

* If one radio is configured as a WGB in a Cisco 10S access point, then the second radio cannot be a WGB
or a repeater.

* Mesh access points can support up to 200 clients including wireless clients, WGB, and wired clients
behind the associated WGB.

* A WGB cannot associate with mesh access points if the WLAN is configured with WPA1 (TKIP) +WPA2
(AES), and the corresponding WGB interface is configured with only one of these encryptions (either
WPAT or WPA2):
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Figure 37: WPA Security Settings for a WGB
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Figure 38: WPA-2 Security Settings for a WGB
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To view the status of a WGB client, follow these steps:

Step 1 Choose Monitor > Clients.
Step 2 On the client summary page, click on the MAC address of the client or search for the client using its MAC address.
Step 3 In the page that appears, note that the client type is identified as a WGB (far right).

Figure 39: Clients are Identified as a WGB
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Step 4 Click on the MAC address of the client to view configuration details:
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* For a wireless client, the page seen in Figure 40: Monitor > Clients > Detail Page (Wireless WGB Client),
on page 136 appears.

* For a wired client, the page seen in Figure 41: Monitor > Clients > Detail Page (Wired WGB Client), on
page 136 appears.

Figure 40: Monitor > Clients > Detail Page (Wireless WGB Client)

Logaut Ral-ash
il il
cisco MORMITOR,. WLANs  ZONTROLLER  WIRELESS
Monitar Clients » Detail <pack | mpply | UnkTest | Remave
Aummary cliznt Proprrties Al I'roprrtics
b Statistics -
b address PRS- RATE TR AF ddoress 0 1 194 Uiz 00
L # i)
IF Adcross 208 18R 200 256 AF Hame KRz 3iiz tadE e oo
F Wireless
Cligat Typs Wit Clisnt AF Trom HOZ s
WEE HAC Lcdress ab:Ld:agnE T g wLa Frofile WLANS
Uger fans Status Assoziated
Purt Samiber 24 A alion 10 u W
Interface TANEQEMErT COZ.11 authertipaten CIER TYIE
Vlan i n Reacan Sodi n
CUE Varsion Mot Supportsd Stabus Code u
EZZ Wersion Mot Supportzd CF Podlaale Hat Implzmentes
Fability Role Lozsl CF Pl Baguast Hot I-plamantsc
Foabilty Pesr 17 Sddress e Skart Preamsle Implenneniked
Poosy Hanagar Stala EI Faos Hul T plaiman e
FiFrar Mooz Ligabiz W channel sgilcy HaE JCplEmEnes
Fanzgement Frane T
Protectan he meou: 4
WEF State 'WEF Disable E
Securily Inlurmmalion 3
“[5

Figure 41: Monitor > Clients > Detail Page (Wired WGB Client)
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Guidelines for Configuration

Follow these guidelines when you configure:
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* We recommend using a 5-GHz radio for the uplink to Mesh AP infrastructure so you can take advantage
of a strong client access on two 5-GHz radios available on mesh access points. A 5-GHz band allows
more Effective Isotropic Radiated Power (EIRP) and is less polluted. In a two-radio WGB, configure
5-GHz radio (radio 1) mode as WGB. This radio will be used to access the mesh infrastructure. Configure
the second radio 2.4-GHz (radio 0) mode as Root for client access.

* On the Autonomous access points, only one SSID can be assigned to the native VLAN. You cannot have
multiple VLANSs in one SSID on the autonomous side. SSID to VLAN mapping should be unique because
this is the way to segregate traffic on different VLANS. In a unified architecture, multiple VLANS can
be assigned to one WLAN (SSID).

* Only one WLAN (SSID) for wireless association of the WGB to the access point infrastructure is
supported. This SSID should be configured as an infrastructure SSID and should be mapped to the native
VLAN.

* A dynamic interface should be created in the controller for each VLAN configured in the WGB.

* A second radio (2.4-GHz) on the access point should be configured for client access. You have to use
the same SSID on both radios and map to the native VLAN. If you create a separate SSID, then it is not
possible to map it to a native VLAN, due to the unique VLAN/SSID mapping requirements. If you try
to map the SSID to another VLAN, then you do not have multiple VLAN support for wireless clients.

+ All Layer 2 security types are supported for the WLANS (SSIDs) for wireless client association in WGB.

* This feature does not depend on the AP platform. On the controller side, both mesh and nonmesh APs
are supported.

* There is a limitation of 20 clients in the WGB. The 20-client limitation includes both wired and wireless
clients. If the WGB is talking to autonomous access points, then the client limit is very high.

* The controller treats the wireless and wired clients behind a WGB in the same manner. Features such as
MAC filtering and link test are not supported for wireless WGB clients from the controller.

* If required, you can run link tests for a WGB wireless client from an autonomous AP.
» Multiple VLANS for wireless clients associated to a WGB are not supported.

 Up to 16 multiple VLANSs are supported for wired clients behind a WGB from the 7.0 release and later
releases.

* Roaming is supported for wireless and wired clients behind a WGB. The wireless clients on the other
radio will not be dissociated by the WGB when an uplink is lost or in a roaming scenario.

We recommend that you configure radio 0 (2.4 GHz) as a Root (one of the mode of operations for Autonomous
AP) and radio 1 (5 GHz) as a WGB.

Configuration Example
When you configure from the CLI, the following are mandatory:
* dot11 SSID (security for a WLAN can be decided based on the requirement).

* Map the subinterfaces in both the radios to a single bridge group.
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N

Note A native VLAN is always mapped to bridge group 1 by default. For other VLANSs,
the bridge group number matches the VLAN number; for example, for VLAN
46, the bridge group is 46.

* Map the SSID to the radio interfaces and define the role of the radio interfaces.

In the following example, one SSID (WGBTEST) is used in both radios, and the SSID is the infrastructure
SSID mapped to NATIVE VLAN 51. All radio interfaces are mapped to bridge group -1.

weel#config t
WGB1 (config) #interface DotllRadiol.51
WGB1 (config-subif) #encapsulation dotlg 51 native
WGB1 (config-subif) tbridge-group !

WGB1 (config-subif) #exit

WGB1 (config) #interface DotllRadio0.51

WGB1 (config-subif) #encapsulation dotlqg 51 native
WGB1 (config-subif) #bridge—-group I

WGB1 (config-subif) #exit

WGB1 (config) #dotll ssid WGBTEST

WGB1 (config-ssid) #VLAN 51

WGB1 (config-ssid) #authentication open

WGB1 (config-ssid) #infrastructiure-ssid

WGB1 (config-ssid) #exit

WGB1 (config) #interface DotllRadiol

WGB1 (config-if) #ssid WGBTEST

WGB1 (config-if) #station-role workgroup-bridge
WGB1 (config-if) #exit

WGB1 (config) #interface DotllRadioO

WGB1 (config-if) #ssid WGBTEST

WGB1 (config-if) #station-role root

WGB1 (config-if) #exit

You can also use the GUI of an autonomous AP for configuration. From the GUI, subinterfaces are
automatically created after the VLAN is defined.
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Figure 42: SSID Configuration Page
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WGB Association Check

Both the WGB association to the controller and the wireless client association to WGB can be verified by
entering the show dot11 associations client command in autonomous AP.

wcB#show dotll associations client

802.11 Client Stations on DotllRadiol:

SSID [WGBTEST]

MAC Address IP Address Device Name Parent State

0024.130£.920e|209.165.200.225 LWAPP-Parent RAPSB - Assoc

From the controller, choose Monitor > Clients. The WGB and the wireless/wired client behind the WGB are
updated and the wireless/wired client are shown as the WGB client.

Figure 43: Updated WGB Clients
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B Link Test Result

Link Test Result

Figure 44: Updated WGB Clients
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Figure 46: Link Test Results
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A link test can also be run from the controller CLI using the following command:

-~
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(Cisco Controller) > linktest client mac-address

Link tests from the controller are only limited to the WGB, and they cannot be run beyond the WGB from
the controller to a wired or wireless client connected to the WGB. You can run link tests for the wireless client
connected to the WGB from the WGB itself using the following command:

ap#dotll dotllRadio 0 linktest target client-mac-address
Start linktest to 0040.96b8.d462, 100 512 byte packets

ap#
POOR (4% Time (msec)|Strength (dBm) SNR Quality Retries
lost)

In Out In Out In Out
Sent: 100 |[Avg. 22 -37 -83 48 3 Tot. 34 35
Lost to Max. 112 -34 -78 61 10 Max. 10 5
Tgt: 4
Lost to Min. O -40 -87 15 3
Src: 4
Rates (Src/Tgt) 24Mb 0/5 36Mb 25/0 48Mb 73/0 54Mb 2/91

Linktest Done in 24.464 msec

WGB Wired/Wireless Client

You can also use the following commands to know the summary of WGBs and clients associated with a Cisco
lightweight access point:

(Cisco Controller) > show wgb summary

Number Of WGBS. ..ttt ittt ittt it i 2

MAC Address| IP Address |AP Name Status WLAN Auth Protocol Clients
00:10:70:97:bck:eff 209.165.200.223 1240 Assoc 2 Yes 802.11la 2
00:1etke:27:5f:e4 209.165.200.224 ¢1240 Assoc 2 Yes 802.11a 5
(Cisco Controller) > show client summary

Number of Clients.......iuiiiiiiiiininininnennn 7

MAC Address|AP Name Status WLAN/Guest-Lar] Auth Protocol Port Wired
00:00:24:ca:a9:14 R14 Associated| 1 Yes N/A 29 No
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00:24:4:20:61: 34 R14 Associated|1 Yes 802.11a 29 No
00:24:4:20:61:f4 R14 Associated|1 Yes 802.11a 29 No
00:24:c4:20:61:f4 R14 Associated| 1 Yes 802.11a 29 No
00:24:c4:20:62:09 R14 Associated| 1 Yes 802.11a 29 No
00:24:4:a0:62:44 R14 Associated| 1 Yes 802.11a 29 No
00:24:c4:80:71:d4 R14 Associated| 1 Yes 802.11a 29 No

(Cisco Controller) > show wgb detail 00:le:be:27:5f:e2

Number of wired client(s): 5

MAC Address IP Address AP Name Mobility WLAN Auth
00:16:c7:5d:b4:8f] Unknown cl240 Local 2 No
00:21:91:f8:e9:a¢ 209.165.200.232| c1240 Local 2 Yes
00:21:55:04:07:05 209.165.200.234| c1240 Local 2 Yes
00:1e:58:31:c7:44 209.165.200.236| c1240 Local 2 Yes
00:23:04:9a:0b:12 Unknown cl240 Local 2 No

Client Roaming

High-speed roaming of Cisco Compatible Extension (CX), version 4 (v4) clients is supported at speeds up to
70 miles per hour in outdoor mesh deployments. An example application might be maintaining communication
with a terminal in an emergency vehicle as it moves within a mesh public network.

Three Cisco CX v4 Layer 2 client roaming enhancements are supported:

* Access point assisted roaming—Helps clients save scanning time. When a Cisco CX v4 client associates
to an access point, it sends an information packet to the new access point listing the characteristics of its
previous access point. Roaming time decreases when the client recognizes and uses an access point list
built by compiling all previous access points to which each client was associated and sent (unicast) to
the client immediately after association. The access point list contains the channels, BSSIDs of neighbor
access points that support the client’s current SSID(s), and time elapsed since disassociation.
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Enhanced neighbor list—Focuses on improving a Cisco CX v4 client’s roam experience and network
edge performance, especially when servicing voice applications. The access point provides its associated
client information about its neighbors using a neighbor-list update unicast message.

Roam reason report—Enables Cisco CX v4 clients to report the reason why they roamed to a new access
point. It also allows network administrators to build and monitor a roam history.

N

Note Client roaming is enabled by default. For more information, see the Enterprise
Mobility Design Guide at
http://www.cisco.com/en/US/docs/solutions/Enterprise/Mobility/emob4 1 dg/eMob4. 1.pdf

WGB Roaming Guidelines

Follow these guidelines for WGB roaming;:

Configuring a WGB for roaming—If a WGB is mobile, you can configure it to scan for a better radio
connection to a parent access point or bridge. Use the ap(config-if)#mobile station period 3 threshold
50 command to configure the workgroup bridge as a mobile station.

When you enable this setting, the WGB scans for a new parent association when it encounters a poor
Received Signal Strength Indicator (RSSI), excessive radio interference, or a high frame-loss percentage.
Using these criteria, a WGB configured as a mobile station searches for a new parent association and
roams to a new parent before it loses its current association. When the mobile station setting is disabled
(the default setting), a WGB does not search for a new association until it loses its current association.

Configuring a WGB for Limited Channel Scanning—In mobile environments such as railroads, a WGB
instead of scanning all the channels is restricted to scan only a set of limited channels to reduce the
hand-off delay when the WGB roams from one access point to another. By limiting the number of
channels, the WGB scans only those required channels; the mobile WGB achieves and maintains a
continuous wireless LAN connection with fast and smooth roaming. This limited channel set is configured
using the ap(config-if)#mobile station scan set of channels.

This command invokes scanning to all or specified channels. There is no limitation on the maximum
number of channels that can be configured. The maximum number of channels that can be configured
is restricted only by the number of channels that a radio can support. When executed, the WGB scans
only this limited channel set. This limited channel feature also affects the known channel list that the
WGB receives from the access point to which it is currently associated. Channels are added to the known
channel list only if they are also part of the limited channel set.

Configuration Example

When you configure from the CLI, the following are mandatory:

dotl1 SSID (security for a WLAN can be decided based on the requirement).

Map the subinterfaces in both the radios to a single bridge group.
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N

Note A native VLAN is always mapped to bridge group 1 by default. For other VLANSs,
the bridge group number matches the VLAN number; for example, for VLAN
46, the bridge group is 46.

* Map the SSID to the radio interfaces and define the role of the radio interfaces.

In the following example, one SSID (WGBTEST) is used in both radios, and the SSID is the infrastructure
SSID mapped to NATIVE VLAN 51. All radio interfaces are mapped to bridge group -1.

weel#config t
WGB1 (config) #interface DotllRadiol.51
WGB1 (config-subif) #encapsulation dotlg 51 native
WGB1 (config-subif) tbridge-group !

WGB1 (config-subif) #exit

WGB1 (config) #interface DotllRadio0.51

WGB1 (config-subif) #encapsulation dotlqg 51 native
WGB1 (config-subif) #bridge—-group I

WGB1 (config-subif) #exit

WGB1 (config) #dotll ssid WGBTEST

WGB1 (config-ssid) #VLAN 51

WGB1 (config-ssid) #authentication open

WGB1 (config-ssid) #infrastructiure-ssid

WGB1 (config-ssid) #exit

WGB1 (config) #interface DotllRadiol

WGB1 (config-if) #ssid WGBTEST

WGB1 (config-if) #station-role workgroup-bridge
WGB1 (config-if) #exit

WGB1 (config) #interface DotllRadioO

WGB1 (config-if) #ssid WGBTEST

WGB1 (config-if) #station-role root

WGB1 (config-if) #exit

You can also use the GUI of an autonomous AP for configuration. From the GUI, subinterfaces are
automatically created after the VLAN is defined.

Troubleshooting Tips

If a wireless client is not associated with a WGB, use the following steps to troubleshoot the problem:

1. Verify the client configuration and ensure that the client configuration is correct.

2. Check the show bridge command output in autonomous AP, and confirm that the AP is reading the client
MAC address from the right interface.

3. Confirm that the subinterfaces corresponding to specific VLANSs in different interfaces are mapped to the
same bridge group.

4. Ifrequired, clear the bridge entry using the clear bridge command (remember that this command will
remove all wired and wireless clients associated in a WGB and make them associate again).
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5. Check the show dot11 association command output and confirm that the WGB is associated with the
controller.

6. Ensure that the WGB has not exceeded its 20-client limitation.

In a normal scenario, if the show bridge and show dot11 association command outputs are as expected,
wireless client association should be successful.

Configuring Voice Parameters in Indoor Mesh Networks

\}

You can configure call admission control (CAC) and QoS on the controller to manage voice and video quality
on the mesh network.

The indoor mesh access points are 802.11¢ capable, and QoS is supported on the local 2.4 and 5-Ghz access
radio and the 2.4 and 5 Ghz access radio and the 2.4 and 5 Ghz backhaul radio. CAC is supported on the
backhaul and the CCXv4 clients (which provides CAC between the mesh access point and the client)

Note

Voice is supported only on indoor mesh networks. Voice is supported on a best-effort basis in the outdoors
in a mesh network.

Call Admission Control

Call Admission Control (CAC) enables a mesh access point to maintain controlled quality of service (QoS)
when the wireless LAN is experiencing congestion. The Wi-Fi Multimedia (WMM) protocol deployed in
CCXv3 ensures sufficient QoS as long as the wireless LAN is not congested. However, to maintain QoS under
differing network loads, CAC in CCXv4 or later is required.

Note

CAC is supported in Cisco Compatible Extensions (CCX) v4 or later. See Chapter 6 of the Cisco Wireless
LAN Controller Configuration Guide at
http://www.cisco.com/en/US/docs/wireless/controller/7.0/configuration/guide/c70sol.html

Two types of CAC are available for access points: bandwidth-based CAC and load-based CAC. All calls on
a mesh network are bandwidth-based, so mesh access points use only bandwidth-based CAC.

Bandwidth-based, or static CAC enables the client to specify how much bandwidth or shared medium time
is required to accept a new call. Each access point determines whether it is capable of accommodating a
particular call by looking at the bandwidth available and compares it against the bandwidth required for the
call. If there is not enough bandwidth available to maintain the maximum allowed number of calls with
acceptable quality, the mesh access point rejects the call.

Quality of Service and Differentiated Services Code Point Marking

Cisco supports 802.11e on the local access and on the backhaul. Mesh access points prioritize user traffic
based on classification, and therefore all user traffic is treated on a best-effort basis.

Resources available to users of the mesh vary, according to the location within the mesh, and a configuration
that provides a bandwidth limitation in one point of the network can result in an oversubscription in other
parts of the network.
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Similarly, limiting clients on their percentage of RF is not suitable for mesh clients. The limiting resource is
not the client WLAN, but the resources available on the mesh backhaul.

Similar to wired Ethernet networks, 802.11 WLANs employ Carrier Sense Multiple Access (CSMA), but
instead of using collision detection (CD), WLANSs use collision avoidance (CA), which means that instead
of each station trying to transmit as soon as the medium is free, WLAN devices will use a collision avoidance
mechanism to prevent multiple stations from transmitting at the same time.

The collision avoidance mechanism uses two values called CWmin and CWmax. CW stands for contention
window. The CW determines what additional amount of time an endpoint should wait, after the interframe
space (IFS), to attend to transmit a packet. Enhanced distributed coordination function (EDCF) is a model
that allows end devices that have delay-sensitive multimedia traffic to modify their CWmin and CWmax
values to allow for statically greater (and more frequent) access to the medium.

Cisco access points support EDCF-like QoS. This provides up to eight queues for QoS.
These queues can be allocated in several different ways, as follows:

* Based on TOS / DiffServ settings of packets
* Based on Layer 2 or Layer 3 access lists
» Based on VLAN

* Based on dynamic registration of devices (IP phones)

AP1500s, with Cisco controllers, provide a minimal integrated services capability at the controller, in which
client streams have maximum bandwidth limits, and a more robust differentiated services (diffServ) capability
based on the IP DSCP values and QoS WLAN overrides.

When the queue capacity has been reached, additional frames are dropped (tail drop).

Encapsulations

Several encapsulations are used by the mesh system. These encapsulations include CAPWAP control and
data between the controller and RAP, over the mesh backhaul, and between the mesh access point and its
client(s). The encapsulation of bridging traffic (noncontroller traffic from a LAN) over the backhaul is the
same as the encapsulation of CAPWAP data.

There are two encapsulations between the controller and the RAP. The first is for CAPWAP control, and the
second is for CAPWAP data. In the control instance, CAPWAP is used as a container for control information
and directives. In the instance of CAPWAP data, the entire packet, including the Ethernet and IP headers, is
sent in the CAPWAP container.
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For the backhaul, there is only one type of encapsulation, encapsulating mesh traffic. However, two types of
traffic are encapsulated: bridging traffic and CAPWAP control and data traffic. Both types of traffic are
encapsulated in a proprietary mesh header.

In the case of bridging traffic, the entire packet Ethernet frame is encapsulated in the mesh header.

All backhaul frames are treated identically, regardless of whether they are MAP to MAP, RAP to MAP, or
MAP to RAP.

Figure 48: Encapsulating Mesh Traffic
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Note

Mesh Data DTLS encryption is only supported on the wave 2 Mesh AP such as 1540 and 1560 models only.

Queuing on the Mesh Access Point

The mesh access point uses a high speed CPU to process ingress frames, Ethernet, and wireless on a first-come,
first-serve basis. These frames are queued for transmission to the appropriate output device, either Ethernet
or wireless. Egress frames can be destined for either the 802.11 client network, the 802.11 backhaul network,
or Ethernet.
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AP1500s support four FIFOs for wireless client transmissions. These FIFOs correspond to the 802.11e
platinum, gold, silver, and bronze queues, and obey the 802.11e transmission rules for those queues. The
FIFOs have a user configurable queue depth.

The backhaul (frames destined for another outdoor mesh access point) uses four FIFOs, although user traffic
is limited to gold, silver, and bronze. The platinum queue is used exclusively for CAPWAP control traffic
and voice, and has been reworked from the standard 802.11¢ parameters for CWmin, CWmax, and so on, to
provide more robust transmission but higher latencies.

The 802.11e parameters for CWmin, CWmax, and so on, for the gold queue have been reworked to provide
lower latency at the expense of slightly higher error rate and aggressiveness. The purpose of these changes is
to provide a channel that is more conducive to video applications.

Frames that are destined for Ethernet are queued as FIFO, up to the maximum available transmit buffer pool
(256 frames). There is support for a Layer 3 IP Differentiated Services Code Point (DSCP), so marking of
the packets is there as well.

In the controller to RAP path for the data traffic, the outer DSCP value is set to the DSCP value of the incoming
IP frame. If the interface is in tagged mode, the controller sets the 802.1Q VLAN ID and derives the 802.1p
UP (outer) from 802.1p UP incoming and the WLAN default priority ceiling. Frames with VLAN ID 0 are
not tagged.

Figure 49: Controller to RAP Path
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For CAPWAP control traffic the IP DSCP value is set to 46, and the 802.1p user priority is set to 7. Prior to
transmission of a wireless frame over the backhaul, regardless of node pairing (RAP/MAP) or direction, the
DSCP value in the outer header is used to determine a backhaul priority. The following sections describe the

mapping between the four backhaul queues the mesh access point uses and the DSCP values shown in Backhaul
Path QoS.

Table 11: Backhaul Path QoS

DSCP Value Backhaul Queue
2,4,6,81t023 Bronze

26,32 to 63 Gold

46 to 56 Platinum

All others including 0 Silver
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Note

The platinum backhaul queue is reserved for CAPWAP control traffic, IP control traffic, and voice packets.
DHCP, DNS, and ARP requests are also transmitted at the platinum QoS level. The mesh software inspects
each frame to determine whether it is a CAPWAP control or IP control frame in order to protect the platinum
queue from use by non-CAPWAP applications.

For a MAP to the client path, there are two different procedures, depending on whether the client is a WMM
client or a normal client. If the client is a WMM client, the DSCP value in the outer frame is examined, and
the 802.11e priority queue is used.

Table 12: MAP to Client Path QoS

DSCP Value Backhaul Queue
2,4,6,81t023 Bronze

26,32 to 45, 47 Gold

46, 48 to 63 Platinum

All others including 0 Silver

If the client is not a WMM client, the WLAN override (as configured at the controller) determines the 8§02.11e
queue (bronze, gold, platinum, or silver), on which the packet is transmitted.

For a client of a mesh access point, there are modifications made to incoming client frames in preparation for
transmission on the mesh backhaul or Ethernet. For WMM clients, a MAP illustrates the way in which the
outer DSCP value is set from an incoming WMM client frame.

Figure 50: MAP to RAP Path
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The minimum value of the incoming 802.11e user priority and the WLAN override priority is translated using
the information listed in Table 13: DSCP to Backhaul Queue Mapping, on page 149 to determine the DSCP
value of the IP frame. For example, if the incoming frame has as its value a priority indicating the gold priority,
but the WLAN is configured for the silver priority, the minimum priority of silver is used to determine the
DSCP value.

Table 13: DSCP to Backhaul Queue Mapping

DSCP Value 802.11e UP Backhaul Queue Packet Types

2,4,6,81t023 1,2 Bronze Lowest priority packets,
if any

26, 32 to 34 4,5 Gold Video packets
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DSCP Value 802.11e UP Backhaul Queue Packet Types

46 to 56 6,7 Platinum CAPWAP control,
AWPP, DHCP/DNS, ARP
packets, voice packets

All others including 0 0,3 Silver Best effort, CAPWAP
data packets

If there is no incoming WMM priority, the default WLAN priority is used to generate the DSCP value in the
outer header. If the frame is an originated CAPWAP control frame, the DSCP value of 46 is placed in the
outer header.

With the 5.2 code enhancements, DSCP information is preserved in an AWPP header.

All wired client traffic is restricted to a maximum 802.1p UP value of 5, except DHCP/DNS and ARP packets,
which go through the platinum queue.

The non-WMM wireless client traffic gets the default QoS priority of its WLAN. The WMM wireless client
traffic may have a maximum 802.11e value of 6, but it must be below the QoS profile configured for its
WLAN. If admission control is configured, WMM clients must use TSPEC signaling and get admitted by
CAC.

The CAPWAPP data traffic carries wireless client traffic and has the same priority and treatment as wireless
client traffic.

Now that the DSCP value is determined, the rules described earlier for the backhaul path from the RAP to
the MAP are used to further determine the backhaul queue on which the frame is transmitted. Frames transmitted
from the RAP to the controller are not tagged. The outer DSCP values are left intact, as they were first
constructed.

Bridging Backhaul Packets

Bridging services are treated a little differently from regular controller-based services. There is no outer DSCP
value in bridging packets because they are not CAPWAP encapsulated. Therefore, the DSCP value in the IP
header as it was received by the mesh access point is used to index into the table as described in the path from
the mesh access point to the mesh access point (backhaul).

Bridging Packets from and to a LAN

Packets received from a station on a LAN are not modified in any way. There is no override value for the
LAN priority. Therefore, the LAN must be properly secured in bridging mode. The only protection offered
to the mesh backhaul is that non-CAPWARP control frames that map to the platinum queue are demoted to the
gold queue.

Packets are transmitted to the LAN precisely as they are received on the Ethernet ingress at entry to the mesh.

The only way to integrate QoS between Ethernet ports on AP1500 and 802.11a is by tagging Ethernet packets
with DSCP. AP1500s take the Ethernet packet with DSCP and places it in the appropriate 802.11e queue.

AP1500s do not tag DSCP itself:

* On the ingress port, the AP1500 sees a DSCP tag, encapsulates the Ethernet frame, and applies the
corresponding 802.11e priority.

* On the egress port, the AP1500 decapsulates the Ethernet frame, and places it on the wire with an
untouched DSCP field.
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Ethernet devices, such as video cameras, should have the capability to mark the bits with DSCP value to take
advantage of QoS.

\}

Note QoS only is relevant when there is congestion on the network.

Guidelines For Using Voice on the Mesh Network

Follow these guidelines when you use voice on the mesh network:

* Voice is supported only on indoor mesh networks. For outdoors, voice is supported on a best-effort basis
on a mesh infrastructure.

» When voice is operating on a mesh network, calls must not traverse more than two hops. Each sector
must be configured to require no more than two hops for voice.

* RF considerations for voice networks are as follows:
* Coverage hole of 2 to 10 percent
* Cell coverage overlap of 15 to 20 percent
* Voice needs RSSI and SNR values that are at least 15 dB higher than data requirements
* RSSI of -67 dBm for all data rates should be the goal for 11b/g/n and 11a/n
* SNR should be 25 dB for the data rate used by client to connect to the AP
* Packet error rate (PER) should be configured for a value of one percent or less

* Channel with the lowest utilization (CU) must be used

* On the 802.11a/n/ac or 802.11b/g/n > Global parameters page, do the following:
* Enable dynamic target power control (DTPC).

* Disable all data rates less than 11 Mbps.

* On the 802.11a/n/ac or 802.11b/g/n > Voice parameters page, do the following:
* Load-based CAC must be disabled.

* Enable admission control (ACM) for CCXv4 or v5 clients that have WMM enabled. Otherwise,
bandwidth-based CAC does not operate properly.

* Set the maximum RF bandwidth to 50 percent.
* Set the reserved roaming bandwidth to 6 percent.

« Enable traffic stream metrics.

* On the 802.11a/n/ac or 802.11b/g/n > EDCA parameters page, you should do the following:

* Set the EDCA profile for the interface as voice optimized.
* Disable low latency MAC.
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* On the QoS > Profile page, you should do the following:

* Create a voice profile and select 802.1Q as the wired QoS protocol type.

* On the WLANs > Edit > QoS page, you should do the following:

* Select a QoS of platinum for voice and gold for video on the backhaul.

* Select allowed as the WMM policy.

* On the WLANs > Edit > QoS page, you should do the following:

* Select CCKM for authorization (auth) key management (mgmt) if you want to support fast roaming.

* On the x >y page, you should do the following:

* Disable voice active detection (VAD).

Enabling Mesh Multicast Containment for Video

You can use the controller CLI to configure three mesh multicast modes to manage video camera broadcasts
on all mesh access points. When enabled, these modes reduce unnecessary multicast transmissions within the
mesh network and conserve backhaul bandwidth.

Mesh multicast modes determine how bridging-enabled access points MAP and RAP send multicasts among
Ethernet LANs within a mesh network. Mesh multicast modes manage non-CAPWAP multicast traffic only.
CAPWAP multicast traffic is governed by a different mechanism.

The three mesh multicast modes are as follows:

* Regular mode—Data is multicast across the entire mesh network and all its segments by bridging-enabled
RAP and MAP.

* In-only mode—Multicast packets received from the Ethernet by a MAP are forwarded to the RAP’s
Ethernet network. No additional forwarding occurs, which ensures that non-CAPWAP multicasts received
by the RAP are not sent back to the MAP Ethernet networks within the mesh network (their point of
origin), and MAP to MAP multicasts do not occur because they are filtered out.

N

Note When an HSRP configuration is in operation on a mesh network, we recommend
the In-Out multicast mode be configured.

* In-out mode—The RAP and MAP both multicast but in a different manner:
¢ In-out mode is the default mode.

* If multicast packets are received at a MAP over Ethernet, they are sent to the RAP; however, they
are not sent to other MAP over Ethernet, and the MAP to MAP packets are filtered out of the
multicast.

* If multicast packets are received at a RAP over Ethernet, they are sent to all the MAPs and their
respective Ethernet networks. When the in-out mode is in operation, it is important to properly
partition your network to ensure that a multicast sent by one RAP is not received by another RAP
on the same Ethernet segment and then sent back into the network.
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N

Note 1f802.11b clients need to receive CAPWAP multicasts, then multicast must be
enabled globally on the controller as well as on the mesh network (using the
config network multicast global enable CLI command). If multicast does not
need to extend to 802.11b clients beyond the mesh network, the global multicast
parameter should be disabled (using the config network multicast global disable
CLI command).

\}

Note AP1540/1560 support only the "in-out" mode in the rel 8.5 and 8.6 . All other modes will be supported in a
future release.

(WLAN1) >config network multicast global enable
(WLAN1) >config mesh multicast ?

in-only Configure Mesh Multicast In Mode.
in-out Configure Mesh Multicast In-Out Mode.
regular Configure Mesh Multicast Regular Mode.

(WLAN1) >config mesh multicast in-out

Viewing the Voice Details for Mesh Networks (CLI)

Use the commands in this section to view details on voice and video calls on the mesh network:

Figure 51: Mesh Network Example

RAP 01

L
e

------- 802.11A p
----80241B/G  F

Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8 .



Connecting the Cisco Mesh Access Points to the Network |
. Viewing the Voice Details for Mesh Networks (CLI)

* To view the total number of voice calls and the bandwidth used for voice calls on each RAP, enter this
command:

show mesh cac summary

Information similar to the following appears:

AP Name Slot# Radio BW Used/Max Calls
SB_RAP1 0 11b/g 0/23437 0

1 1lla 0/23437 2
SB_MAP1 0 11b/g 0/23437 0

1 1lla 0/23437 0
SB_MAP2 0 11b/g 0/23437 0

1 1lla 0/23437 0
SB_MAP3 0 11b/g 0/23437 0

1 1lla 0/23437 0?

To view the mesh tree topology for the network and the bandwidth utilization (used/maximum available)
of voice calls and video links for each mesh access point and radio, enter this command:

show mesh cac bwused {voice | video} AP name

Information similar to the following appears:

AP Name Slot# Radio BW Used/Max
SB RAP1 0 11b/g 1016/23437
1 lla 3048/23437
|SB MAP1 0 11b/g 0/23437
1 lla 3048/23437
|| SB MAP2 0 11b/g 2032/23437
1 lla 3048/23437
1| SB MAP3 0 11b/g 0/23437
1 lla 0/23437

A\

Note The bars (]) to the left of the AP Name field indicate the number of hops that the
MAP is from its RAP.

N

Note  When the radio type is the same, the backhaul bandwidth utilization (bw used/max)
at each hop is identical. For example, mesh access points map1, map2, map3,
and rap! are all on the same radio backhaul (802.11a) and are using the same
bandwidth (3048). All of the calls are in the same interference domain. A call
placed anywhere in that domain affects the others.

* To view the mesh tree topology for the network and display the number of voice calls that are in progress
by mesh access point radio, enter this command:

show mesh cac access AP _name

Information similar to the following appears:

AP Name Slot# Radio Calls
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SB_RAP1 0 11b/g 0
1 1lla 0
[ SB_MAP1 0 11b/g 0
1 1lla 0
| SB_MAP2 0 11b/g 1
1 1la 0
||| SB_MAP3 0 11b/g 0
1 1la 0

N

Note Each call received by a mesh access point radio causes the appropriate calls
summary column to increment by one. For example, if a call is received on the
802.11b/g radio on map2, then a value of one is added to the existing value in
that radio’s calls column. In this case, the new call is the only active call on the
802.11b/g radio of map2. If one call is active when a new call is received, the
resulting value is two.

* To view the mesh tree topology for the network and display the voice calls that are in progress, enter
this command:

show mesh cac callpath AP _name

Information similar to the following appears:

AP Name Slot# Radio Calls
SB_RAP1 0 11b/g 0

1 1la 1
[ SB_MAP1 0 11b/g 0

1 1la 1
|| SB_MAP2 0 11b/g 1

1 1la 1
1] SB_MAP3 0 11b/g 0

1 1la 0

Y

Note The calls column for each mesh access point radio in a call path increments by
one. For example, for a call that initiates at map2 (show mesh cac call path
SB_MAP?2) and terminates at rap1 by way of map1, one call is added to the map2
802.11b/g and 802.11a radio calls column, one call to the map1 802.11a backhaul
radio calls column, and one call to the rap1 802.11a backhaul radio calls column.

To view the mesh tree topology of the network, the voice calls that are rejected at the mesh access point
radio due to insufficient bandwidth, and the corresponding mesh access point radio where the rejection
occurred, enter this command:

show mesh cac rejected AP _name

Information similar to the following appears:

AP Name Slot# Radio Calls
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SB_RAP1 0 11b/g 0
1 1lla 0
[ SB_MAP1 0 11b/g 0
1 1la 0
| SB_MAP2 0 11b/g 1
1 1la 0
||| SB_MAP3 0 11b/g 0
1 1la 0

N

Note Ifa call is rejected at the map2 802.11b/g radio, its calls column increments by
one.

* To view the number of bronze, silver, gold, platinum, and management queues active on the specified
access point, enter this command. The peak and average length of each queue are shown as well as the
overflow count.

show mesh queue-stats AP name

Information similar to the following appears:

Queue Type Overflows Peak length Average length

Silver 0 1 0.000
Gold 0 4 0.004
Platinum 0 4 0.001
Bronze 0 0 0.000
Management 0 0 0.000

Overflows—The total number of packets dropped due to queue overflow.
Peak Length—The peak number of packets waiting in the queue during the defined statistics time interval.

Average Length—The average number of packets waiting in the queue during the defined statistics time
interval.

Enabling Multicast on the Mesh Network (CLI)

)

Note * Cisco Aironet 1540 and 1560 Series Outdoor Access Points support in-out mode only.

* Cisco Aironet 1530, 1550, and 1570 Series Outdoor Access Points support all the modes.

Procedure

* To enable multicast mode on the mesh network to receive multicasts from beyond the mesh networks,
enter these commands:

config network multicast global enable

config mesh multicast {regular | in-only | in-out}
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* To enable multicast mode only the mesh network (multicasts do not need to extend to 802.11b clients
beyond the mesh network), enter these commands:

config network multicast global disable

config mesh multicast {regular | in-only | in-out}

\}

Note Multicast for mesh networks cannot be enabled using the controller GUI.

IGMP Snooping

IGMP snooping delivers improved RF usage through selective multicast forwarding and optimizes packet
forwarding in voice and video applications.

A mesh access point transmits multicast packets only if a client is associated with the mesh access point that
is subscribed to the multicast group. So, when IGMP snooping is enabled, only that multicast traffic relevant
to given hosts is forwarded.

To enable IGMP snooping on the controller, enter the following command:
configure network multicast igmp snooping enable

A client sends an IGMP join that travels through the mesh access point to the controller. The controller
intercepts the join and creates a table entry for the client in the multicast group. The controller then proxies
the IGMP join through the upstream switch or router.

You can query the status of the IGMP groups on a router by entering the following command:
router# show ip gmp groups

IGMP Connected Group Membership

Group Address Interface Uptime Expires Last Reporter

233.0.0.1 Vlanll9 3wld 00:01:52 10.1.1.130

For Layer 3 roaming, an IGMP query is sent to the client’s WLAN. The controller modifies the client’s
response before forwarding and changes the source IP address to the controller’s dynamic interface IP address.

The network hears the controller’s request for the multicast group and forwards the multicast to the new
controller.

For more information about video, see the following:

* Video Surveillance over Mesh Deployment Guide: http://www.cisco.com/en/US/tech/tk722/tk809/
technologies tech note09186a0080b02511.shtml

* Cisco Unified Wireless Network Solution: VideoStream Deployment Guide: http://www.cisco.com/en/
US/products/ps10315/products_tech note09186a0080b6e11e.shtml

Locally Significant Certificates for Mesh APs

Until the 7.0 release, mesh APs supported only the Manufactured Installed Certificate (MIC) to authenticate
and get authenticated by controllers to join the controller. You might have had to have your own public key
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infrastructure (PKI) to control CAs, to define policies, to define validity periods, to define restrictions and
usages on the certificates that are generated, and get these certificates installed on the APs and controllers.
After these customer-generated or locally significant certificates (LSCs) are present on the APs and controllers,
the devices start using these LSCs, to join, authenticate, and derive a session key. Cisco supported normal
APs from the 5.2 release and later releases and extended the support for mesh APs as well from the 7.0 release.

* Graceful fallback to MIC if APs are unable to join the controller with LSC certificates—Local APs try
to join a controller with an LSC for the number of times that are configured on the controller (the default
value is 3). After these trials, the AP deletes the LSC and tries to join a controller with an MIC.

Mesh APs try to join a controller with an LSC until its lonely timer expires and the AP reboots. The
lonely timer is set for 40 minutes. After the reboot, the AP tries to join a controller with an MIC. If the
AP is again not able to join a controller with an MIC in 40 minutes, the AP reboots and then tries to join
a controller with an LSC.

N

Note An LSC in mesh APs is not deleted. An LSC is deleted in mesh APs only when
the LSC is disabled on the controller, which causes the APs to reboot.

* Over the air provisioning of MAPs.

Guidelines for Configuration
Follow these guidelines when using LSCs for mesh APs:

* This feature does not remove any preexisting certificates from an AP. It is possible for an AP to have
both LSC and MIC certificates.

» After an AP is provisioned with an LSC, it does not read in its MIC certificate on boot-up. A change
from an LSC to an MIC will require the AP to reboot. APs do it for a fallback if they cannot be joined
with an LSC.

* Provisioning an LSC on an AP does not require an AP to turn off its radios, which is vital for mesh APs,
which may get provisioned over-the-air.

* Because mesh APs need a dotlx authentication, a CA and ID certificate is required to be installed on the
server in the controller.

*» LSC provisioning can happen over Ethernet and over-the-air in case of MAPs.You have to connect the
mesh AP to the controller through Ethernet and get the LSC certificate provisioned. After the LSC
becomes the default, an AP can be connected over-the-air to the controller using the LSC certificate.

Differences Between LSCs for Mesh APs and Normal APs

CAPWAP APs use LSC for DTLS setup during a JOIN irrespective of the AP mode. Mesh APs also use the
certificate for mesh security, which involves a dot1x authentication with the controller through the parent AP.
After the mesh APs are provisioned with an LSC, they need to use the LSC for this purpose because MIC
will not be read in.

Mesh APs use a statically configured dotlx profile to authenticate.

This profile is hardcoded to use "cisco" as the certificate issuer. This profile needs to be made configurable
so that vendor certificates can be used for mesh authentication (enter the config local-auth eap-profile
cert-issuer vendor "prfMaP1500LIEAuth93" command).
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You must enter the config mesh Isc enable/disable command to enable or disable an LSC for mesh APs.
This command will cause all the mesh APs to reboot.

Note An LSC on mesh is open for very specific Oil and Gas customers with the 7.0 release. Initially, it is a hidden
feature. The config mesh Isc enable/disable is a hidden command. Also, the config local-auth eap-profile
cert-issuer vendor "prfMaP1500LIEAuth93" command is a normal command, but the
"prfMaP1500LIEAuth93" profile is a hidden profile, and is not stored on the controller and is lost after the
controller reboot.

Certificate Verification Process in LSC AP

LSC-provisioned APs have both LSC and MIC certificates, but the LSC certificate will be the default one.
The verification process consists of the following two steps:

1. The controller sends the AP the MIC device certificate, which the AP verifies with the MIC CA.

2. The AP sends the LSC device certificate to the controller, which the controller verifies with the LSC CA.

Getting Certificates for LSC Feature

Step 1
Step 2

Step 3

Step 4

Step 5

To configure LSC, you must first gather and install the appropriate certificates on the controller. The following
steps show how to accomplish this using Microsoft 2003 Server as the CA server.

To get the certificates for LSC, follow these steps:

Go to the CA server (http://<ip address of caserver/crtsrv) and login.

Get the CA certificate as follows:

a) Click the Download a CA certificate link, certificate chain, or CRF.

b) Choose the encoding method as DER.

¢) Click the Download CA certificate link and use the save option to download the CA certificate on to your local
machine.

To use the certificate on the controller, convert the downloaded certificate to PEM format. You can convert this in a
Linux machine using the following command:

# openssl x509 -in <input.cer> -inform DER -out <output.cer> -outform PEM

Configure the CA certificate on the controller as follows:

a) Choose COMMANDS > Download File.

b) Choose the file type as Vendor CA Certificate from the File Type drop-down list.

¢) Update the rest of the fields with the information of the TFTP server where the certificate is located.
d) Click Download.

To install the Device certificate on the WLC, login to the CA server as mentioned in Step 1 and do the following:

a) Click the Request a certificate link.

b) Click the advanced certificate request link.

c) Click Create and submit a request to this CA link.

d) Go to the next screen and choose the Server Authentication Certificate from the Certificate Template drop-down list.
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Step 6

Step 7

Step 8
Step 9

e) Enter a valid name, email, company, department, city, state, and country/region. (Remember it in case you want the
cap method to check the username against its database of user credentials).

Note The e-mail is not used.

f) Enable Mark keys as exportable.
g) Click Submit.
h) Install the certificate on your laptop.

Convert the device certificate obtained in the Step 5. To get the certificate, go to your internet browser options and choose
exporting to a file. Follow the options from your browser to do this. You need to remember the password that you set
here.

To convert the certificate, use the following command in a Linux machine:

# openssl pkes12 -in <input.pfx> -out <output.cer>

On the controller GUI, choose Command > Download File. Choose Vendor Device Certificate from the File Type
drop-down list. Update the rest of the fields with the information of the TFTP server where the certificate is located and
the password you set in the previous step and click Download.

Reboot the controller so that the certificates can then be used.

You can check that the certificates were successfully installed on the controller using this command:

show local-auth certificates

Configuring a Locally Significant Certificate (CLI)

Step 1
Step 2

Step 3

Step 4
Step 5

To configure a locally significant certificate (LSC), follow these steps:

Enable LSC and provision the LSC CA certificate in the controller.

Enter the following command:

config local-auth eap-profile cert-issuer vendor prfMaP1500LIEAuth93

Turn on the feature by entering the following command:

config mesh Isc {enable | disable}

Connect the mesh AP through Ethernet and provision for an LSC certificate.
Let the mesh AP get a certificate and join the controller using the LSC certificate.
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Figure 52: Local Significant Certificate Page
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Figure 53: AP Policy Configuration
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LSC-Related Commands

The following commands are related to LSCs:

« config certificate Isc {enable | disable}

* enable—To enable an LSC on the system.

Entries 1 - 1 of 1

279073

* disable—To disable an LSC on the system. Use this keyword to remove the LSC device certificate
and send a message to an AP, to do the same and disable an LSC, so that subsequent joins could be
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made using the MIC/SSC. The removal of the LSC CA cert on the WLC should be done explicitly
by using the CLI to accommodate any AP that has not transitioned back to the MIC/SSC.

config certificate Isc ca-server url-path ip-address

Following is the example of the URL when using Microsoft 2003 server:

http:<ip address of CA>/sertsrv/mscep/mscep.dll

This command configures the URL to the CA server for getting the certificates. The URL contains either
the domain name or the IP address, port number (typically=80), and the CGI-PATH.

http://ipaddr:port/cgi-path

Only one CA server is allowed to be configured. The CA server has to be configured to provision an
LSC.

config certificate Isc ca-server delete
This command deletes the CA server configured on the controller.
config certificate Isc ca-cert {add | delete}

This command adds or deletes the LSC CA certificate into/from the controller's CA certificate database
as follows:

» add—AQueries the configured CA server for a CA certificate using the SSCEP getca operation, and
gets into the WLC and installs it permanently into the WLC database. If installed, this CA certificate
is used to validate the incoming LSC device certificate from the AP.

e delete—Deletes the LSC CA certificate from the WLC database.

config certificate Isc subject-params Country State City Orgn Dept Email

This command configures the parameters for the device certificate that will be created and installed on
the controller and the AP.

All of these strings have 64 bytes, except for the Country that has a maximum of 3 bytes. The Common
Name is automatically generated using its Ethernet MAC address. This should be given prior to the
creation of the controller device certificate request.

The above parameters are sent as an LWAPP payload to the AP, so that the AP can use these parameters
to generate the certReq. The CN is automatically generated on the AP using the current MIC/SSC
"Cxxxx-MacAddr" format, where xxxx is the product number.

config certificate Isc other-params keysize
The default keysize value is 2048 bits.
config certificate Isc ap-provision {enable | disable}

This command enables or disables the provisioning of the LSCs on the APs if the APs just joined using
the SSC/MIC. If enabled, all APs that join and do not have the LSC will get provisioned.

If disabled, no more automatic provisioning will be done. This command does not affect the APs, which
already have LSCs in them.

config certificate Isc ra-cert {add | delete}
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Controller GUI Security Settings .

We recommend this command when the CA server is a Cisco IOS CA server. The controller can use the
RA to encrypt the certificate requests and make communication more secure. RA certificates are not
currently supported by other external CA servers, such as MSFT.

» add—~Queries the configured CA server for an RA certificate using the SCEP operation and installs
it into the controller database. This keyword is used to get the certReq signed by the CA.

e delete—Deletes the LSC RA certificate from the WLC database.

config auth-list ap-policy Isc {enable | disable}

After getting the LSC, an AP tries to join the controller. Before the AP tries to join the controller, you
must mandatorily enter this command on the controller console. By default, the config auth-list ap-policy
Isc command is in the disabled state, and the APs are not allowed to join the controller using the LSC.

config auth-list ap-policy mic {enable | disable}

After getting the MIC, an AP tries to join the controller. Before the AP tries to join the controller, you
must mandatorily enter this command on the controller console. By default, the config auth-list ap-policy
mic command is in the enabled state. If an AP cannot join because of the enabled state, this log message
on the controller side is displayed: LSC/MIC AP is not allowed to join.

show certificate Isc summary

This command displays the LSC certificates installed on the WLC. It would be the CA certificate, device
certificate, and optionally, an RA certificate if the RA certificate has also been installed. It also indicates
if an LSC is enabled or not.

show certificate Isc ap-provision

This command displays the status of the provisioning of the AP, whether it is enabled or disabled, and
whether a provision list is present or not.

show certificate Isc ap-provision details

This command displays the list of MAC addresses present in the AP provisioning lists.

Controller GUI Security Settings

Although the settings are not directly related to the feature, it might help you in achieving the desired behavior
with respect to APs provisioned with an LSC.

Case 1—Local MAC Authorization and Local EAP Authentication
Add the MAC address of RAP/MAP to the controller MAC filter list.

Example:

(Cisco Controller) > config macfilter mac-delimiter colon
(Cisco Controller) > config macfilter add 00:0b:85:60:92:30 0 management

Case 2—External MAC Authorization and Local EAP authentication

Enter the following command on the WLC:

(Cisco Controller) > config mesh security rad-mac-filter enable
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or
Check only the external MAC filter authorization on the GUI page and follow these guidelines:
* Do not add the MAC address of the RAP/MAP to the controller MAC filter list.
* Configure the external radius server details on the WLC.
* Enter the config macfilter mac-delimiter colon command configuration on the WLC.

* Add the MAC address of the RAP/MAP in the external radius server in the following format:
User name: 11:22:33:44:55:66 Password : 11:22:33:44:55:66

Deployment Guidelines

» When using local authorization, the controller should be installed with the vendor's CA and device
certificate.

» When using an external AAA server, the controller should be installed with the vendor’s CA and device
certificate.

* Mesh security should be configured to use ‘vendor’ as the cert-issuer.

* MAPs cannot move from an LSC to an MIC when they fall back to a backup controller.

The config mesh Isc {enable | disable} command is required to enable or disable an LSC for mesh APs.
This command causes all the mesh APs to reboot.
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Checking the Health of the Network

This chapter describes how to check the health of a mesh network and contains the following sections:

» Show Mesh Commands, on page 165
* Viewing Mesh Statistics for a Mesh Access Point, on page 171
* Viewing Neighbor Statistics for a Mesh Access Point, on page 177

Show Mesh Commands

The show mesh commands are grouped under the following sections:

* Viewing General Mesh Network Details
* Viewing Mesh Access Point Details

* Viewing Global Mesh Parameter Settings
* Viewing Bridge Group Settings

*» Viewing VLAN Tagging Settings

* Viewing DFS Details

* Viewing Security Settings and Statistics

* Viewing GPS Status

Viewing General Mesh Network Details

To view general mesh network details, enter these commands:

* show mesh env {summary | AP_name}—Shows the temperature, heater status, and Ethernet status for
either all access points (summary) or a specific access point (AP_name). The access point name, role
(RootAP or MeshAP), and model are also shown.

* The temperature is shown in both Fahrenheit and Celsius.
* The heater status is ON or OFF.

 The Ethernet status is UP or DOWN.
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N

Note The battery status appears as N/A (not applicable) in the show mesh env AP_name
status display because it is not provided for access points.

(Cisco Controller) > show mesh env summary

AP Name Temperature (C/F) Heater Ethernet Battery
SB_RAP1 39/102 OFF UpDnNANA N/A
SB_MAP1 37/98 OFF DnDnNANA N/A
SB_MAP2 42/107 OFF DnDnNANA N/A
SB_MAP3 36/96 OFF DnDnNANA N/A

(Cisco Controller > show mesh env SB RAPI

AP NaAME . o ittt it i it ittt ie st teesaesneenennannnns SB_RAP1
AP Model . i ittt ittt e e e e et e e AIR-LAP1522AG-A-K9
N RooOtAP
JIESY 0] 1ot s ot 39 ¢, 102 F
Heater. .ottt i i e et i i it e e OFF
Backhaul. ...ttt e e e e GigabitEthernetO
GigabitEthernet0 Status.......... ..., UP

DUP LXK e ittt ettt e et ettt e ettt et FULL

1S ST 100

Rx Unicast Packets........oiiiiiiiiiinnna.. 988175

Rx Non-Unicast Packets..........oiiiiiia.. 8563

Tx Unicast Packets.........iiiiiiiiiiinnn. 106420

Tx Non-Unicast Packets..........cciiiiennn 17122
GigabitEthernetl Status............c.iiiiin.. DOWN
5 5 OFF
21 o= N/A

show mesh ap summary—Revised to show the CERT MAC field that shows a MAC address within
an AP certificate that can be used to assign a username for external authentication.

(Cisco Controller) > show mesh ap summary

AP Name AP Model BVI MAC CERT MAC Hop Bridge Group Name
R1 LAP1520 00:0b:85:63:8a:10 00:00:85:63:8a:10 0 vyl

R2 LAP1520 00:0b:85:7b:cl:e0 00:0b:85:7b:cl:el0 1 vl

H2 ATIR-LAP1522AG-A-K9 00:1la:a2:f£f:£9:00 00:1b:d4:a6:£4:60 1

Number of Mesh APS.. ...ttt i, 3

Number of RAP. ...ttt ittt it i e 2

Number of MAP. ...ttt it i it i e 1

show mesh path—Displays MAC addresses, access point roles, SNR ratios (dBs) for uplink and downlink
(SNRUp, SNRDown) and link SNR for a particular path.

(Cisco Controller) > show mesh path mesh-45-rapi
AP Name/Radio Mac Channel Snr-Up Snr-Down Link-Snr Flags State

mesh-45-rapl 165 15 18 16 0x86b UPDATED NEIGH PARENT BEACON
mesh-45-rapl is a Root AP.
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show mesh neighbor summary—Displays summary information about mesh neighbors. Neighbor
information includes MAC addresses, parent-child relationships, and uplink and downlink (SNRUp,
SNRDown).

(Cisco Controller) > show mesh neighbor summary api500:62:39:70
AP Name/Radio Mac Channel Snr-Up Snr-Down Link-Snr Flags State

mesh-45-rapl 165 15 18 16 0Ox86b UPDATED NEIGH PARENT BEACON
00:0B:85:80:ED:D0 149 5 6 5 0x1a60 NEED UPDATE BEACON DEFAULT
00:17:94:FE:C3:5F 149 7 0 0 0x860 BEACON

N

Note  After review of the show mesh commands above, you should be able to see the
relationships between the nodes of your network and verify the RF connectivity
by seeing the SNR values for every link.

show mesh ap tree—Displays mesh access points within a tree structure (hierarchy).

(Cisco Controller) > show mesh ap tree
R1(0,y1)

[-R2(1,y1)

[-R6(2,y1)

|-H2 (1,default)

Number Of Mesh APS. ...t iiiiietteeeneeeeeenannnn 4
Number Of RAP. ...ttt ittt ittt 1
Number Of MAP. ...ttt t ittt ettt 3

Viewing Mesh Access Point Details

To view a mesh access point’s configuration, enter these commands:

show ap config general Cisco_AP—Displays system specifications for a mesh access point.

(Cisco Controller) > show ap config general aps

Cisco AP Identifier........ ... 1

CiSCO AP NaAM . s ittt it it it et et etenenenenenenennnns AP5S

CoOUNEIry COdE. v ii ittt ittt ittt ittt e US - United States
Regulatory Domain allowed by Country............. 802.11bg:-AB 802.11a:-AB
AP COUNELY COQC. vttt ittt ittt iitttitnnaeeennnneens US - United States

AP Regulatory DOMain.....iiu i it ennennnn. 802.11bg:-A 802.11a:-N
Switch Port Number .............iiuiiuiiiiniininennnn 1

MAC AdAreSS . ittt it ittt ittt ittt it enenenenenens 00:13:80:60:48:3e

IP Address Configuration........... ... DHCP

I 2 Lo T = 3 1.100.163.133

Primary Cisco Switch Name............ ... 1-4404

Primary Cisco Switch IP Address.................. 2.2.2.2

Secondary Cisco Switch Name...........oiiin.n. 1-4404

Secondary Cisco Switch IP Address................ 2.2.2.2

Tertiary Cisco Switch Name............ ... ....... 2-4404

Tertiary Cisco Switch IP Address................. 1.1.1.4

show mesh astools stats [Cisco_AP]—Displays anti-stranding statistics for all outdoor mesh access
points or a specific mesh access point.

Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8 .



Checking the Health of the Network |
. Viewing Global Mesh Parameter Settings

(Cisco Controller) > show mesh astools stats
Total No of Aps stranded : O

> (Cisco Controller) > show mesh astools stats sb_mapl
Total No of Aps stranded : O

» show advanced backup-controller—Displays configured primary and secondary backup controllers.

(Cisco Controller) > show advanced backup-controller
AP primary Backup Controller ..............ocvu... controllerl 10.10.10.10
AP secondary Backup Controller ............... 0.0.0.0

* show advanced timer—Displays settings for system timers.

(Cisco Controller) > show advanced timer

Authentication Response Timeout (seconds)........ 10
Rogue Entry Timeout (seconds) .......eeiueeiueenenenn. 1300
AP Heart Beat Timeout (SeCONdsS) .. .vueeeeeeennnnnnn 30
AP Discovery Timeout (seconds) .......eeeeenwnenennn. 10
AP Primary Discovery Timeout (seconds)........... 120

* show ap slots—Displays slot information for mesh access points.

(Cisco Controller) > show ap slots

NUMDET Of AP S . ittt ittt ittt ittt tit et 3

AP Name Slots AP Model Slot0 Slotl Slot2 Slot3
R1 2 LAP1520 802.11A 802.11BG

H1 3 AIR-LAP1521AG-A-K9 802.11BG 802.11A 802.11A

H2 4 AIR-LAP1521AG-A-K9 802.11BG 802.11A 802.11A 802.11BRG

Viewing Global Mesh Parameter Settings

Use this command to obtain information on global mesh settings:

* show mesh config—Displays global mesh configuration settings.

(Cisco Controller) > show mesh config

Mesh RANGE . ¢ttt ittt ittt ettt ettt et e 12000
Backhaul with client access status............... disabled
Background Scanning State.........iiiiiiiiiii, enabled
Mesh Security

Security Mode. .ottt ittt EAP
External-Auth. ... ..ottt disabled
Use MAC Filter in External AAA server......... disabled
Force External Authentication................. disabled
Mesh Alarm Criteria

Max Hop Count......uuiiiiiiiiiiiiiiinieiennnnns 4
Recommended Max Children for MAP.............. 10
Recommended Max Children for RAP.............. 20

Low Link SNR. .ttt ittt ittt et ettt i e 12

High Link SNR. ..ttt ittt it ittt e it e 60

Max Association Number............ciuiiiuenin.n. 10
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Association Interval........iiiiiiiiinnennnn. 60 minutes
Parent Change NUMbEIrS.......iiiiiiiiennennnn. 3

Parent Change Interval..........ciuiiuiiuinnnnn. 60 minutes
Mesh Multicast Mode..... ..ttt inninnennnn. In-Out
Mesh Full SecCtor DES. ...t iiiiiitiiiinetiennnnenn enabled
Mesh Ethernet Bridging VLAN Transparent Mode..... enabled

Viewing Bridge Group Settings
Use these commands to view bridge group settings:
* show mesh forwarding table—Shows all configured bridges and their MAC table entries.

» show mesh forwarding interfaces—Displays bridge groups and the interfaces within each bridge group.
This command is useful for troubleshooting bridge group membership.

Viewing VLAN Tagging Settings
Use these commands to view VLAN tagging settings:

* show mesh forwarding VLAN mode—Shows the configured VLAN Transparent mode (enabled or
disabled).

» show mesh forwarding VLAN statistics—Displays statistics for the VLAN and the path.
* show mesh forwarding vlans—Displays supported VLANS.

» show mesh ethernet VLAN statistics—Displays statistics for the Ethernet interface.

Viewing DFS Details

Use this command to view DFS details:

* show mesh dfs history—Displays a history of radar detections by channels and resulting outages.

(Cisco Controller) > show mesh dfs history

apl520#show mesh dfs history

Channel 100 detects radar and is unusable (Time Elapsed: 18 day(s), 22 hour(s), 10
minute(s), 24 second(s)).

Channel is set to 136 (Time Elapsed: 18 day(s), 22 hour(s), 10 minute(s), 24 second(s)) .
Channel 136 detects radar and is unusable (Time Elapsed: 18 day(s), 22 hour(s), 9

minute(s), 14 second(s)).

Channel is set to 161 (Time Elapsed: 18 day(s), 22 hour(s), 9 minute(s), 14 second(s)).
Channel 100 becomes usable (Time Elapsed: 18 day(s), 21 hour(s), 40 minute(s), 24
second(s)) .

Channel 136 becomes usable (Time Elapsed: 18 day(s), 21 hour(s), 39 minute(s), 14
second(s)) .

Channel 64 detects radar and is unusable (Time Elapsed: 0 day(s), 1 hour(s), 20 minute(s),
52 second(s)) .

Channel 104 detects radar and is unusable (Time Elapsed: 0 day(s), 0 hour(s), 47

minute(s), 6 second(s)).

Channel is set to 120 (Time Elapsed: 0 day(s), 0 hour(s), 47 minute(s), 6 second(s)).

show mesh dfs channel channel number—Displays a history of radar detections and outages for a
specified channel.
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(Cisco Controller) > show mesh dfs channel 104

apl520#show mesh dfs channel 104

Channel 104 is available

Time elapsed since radar last detected: 0 day(s), 0 hour(s), 48 minute(s), 11 second(s).

Viewing Security Settings and Statistics

Use this command to view security settings and statistics:

* show mesh security-stats AP _name—Shows packet error statistics and a count of failures, timeouts,
and successes with respect to associations and authentications as well as reassociations and
reauthentications for the specified access point and its child.

(Cisco Controller) > show mesh security-stats ap417

AP MAC : 00:0B:85:5F:FA:F0
Packet/Error Statistics:

Tx Packets 14, Rx Packets 19, Rx Error Packets 0
Parent-Side Statistics:

Unknown Association Requests 0
Invalid Association Requests 0
Unknown Re-Authentication Requests 0
Invalid Re-Authentication Requests 0
Unknown Re-Association Requests 0
Invalid Re-Association Requests 0
Unknown Re-Association Requests 0
Invalid Re-Association Requests 0
Child-Side Statistics:

Association Failures 0

Association Timeouts 0

Association Successes 0
Authentication Failures 0
Authentication Timeouts 0
Authentication Successes 0
Re-Association Failures 0
Re-Association Timeouts 0
Re-Association Successes 0
Re-Authentication Failures 0
Re-Authentication Timeouts 0
Re-Authentication Successes 0

Viewing GPS Status

Procedure
* See location summary of all APs by entering this command:

show ap gps location summary
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(5ite5_AMC_@2) =show ap gps location summary

AP Name GPS Present Latitude Longitude Altitude
location Age

S]JC24-RAP-EAST NO N/A N/A N/A
SJC21-RAP-NORTH NOD N/A N/A N/A
5JC21-RAP-50UTH NO N/A N/A N/A
Site5_21-17 NO N/A N/A N/A
5JC22-RO0OF-MAP NO N/A N/A N/A
Site5_21-28 NO N/A N/A N/A
SJC-24-RAP-WEST ¥YES 37.42034194 -121.91973098 25.19 meters
days, @@ h @@ m 19 s

Site5_24-82 YES 37.41978399 -121.92851996 18.80 meters
days, @8 h @@ m 12 s

Site5_22-38 NO N/A N/A N/A
Site5_23-208 NO N/A N/A N/A
Site5_25-18 ND N/A N/A N/A
Site5_22-15 NO N/A N/A N/A
Site5_25-85 NO N/A N/A N/A

* See a location summary of all mesh APs by entering this command:
show mesh gps location summary

* See the location information for a particular mesh AP by entering this command:

show mesh gps location ap-name

Viewing Mesh Statistics for a Mesh Access Point

This section describes how to use the controller GUI or CLI to view mesh statistics for specific mesh access
points.

\}

Note  You can modify the Statistics Timer interval setting on the All APs > Details page of the controller GUI.

Viewing Mesh Statistics for a Mesh Access Point (GUI)

Step 1 Choose Wireless > Access Points > All APs to open the All APs page.

Step 2 To view statistics for a specific mesh access point, hover the mouse over the blue drop-down arrow for the desired mesh
access point and choose Statistics. The All APs > 4P Name > Statistics page for the selected mesh access point appears.

This page shows the role of the mesh access point in the mesh network, the name of the bridge group to which the mesh
access point belongs, the backhaul interface on which the access point operates, and the number of the physical switch
port. It also displays a variety of mesh statistics for this mesh access point.
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Table 14: Mesh Access Point Statistics
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Statistics

Parameter

Description

Mesh Node Stats

Malformed Neighbor Packets

The number of malformed packets
received from the neighbor. Examples
of malformed packets include malicious
floods of traffic such as malformed or
short DNS packets and malformed DNS
replies.

Poor Neighbor SNR Reporting

The number of times the signal-to-noise
ratio falls below 12 dB on the backhaul
link.

Excluded Packets

The number of packets received from
excluded neighbor mesh access points.

Insufficient Memory Reporting

The number of insufficient memory
conditions.

Rx Neighbor Requests

The number of broadcast and unicast
requests received from the neighbor
mesh access points.

Rx Neighbor Responses

The number of responses received from
the neighbor mesh access points.

Tx Neighbor Requests

The number of unicast and broadcast
requests sent to the neighbor mesh
access points.

Tx Neighbor Responses

The number of responses sent to the
neighbor mesh access points.

Parent Changes Count

The number of times a mesh access
point (child) moves to another parent.

Neighbor Timeouts Count

The number of neighbor timeouts.
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Statistics

Parameter

Description

Queue Stats

Gold Queue

The average and peak number of
packets waiting in the gold (video)
queue during the defined statistics time
interval.

Silver Queue

The average and peak number of
packets waiting in the silver (best
effort) queue during the defined
statistics time interval.

Platinum Queue

The average and peak number of
packets waiting in the platinum (voice)
queue during the defined statistics time
interval.

Bronze Queue

The average and peak number of
packets waiting in the bronze
(background) queue during the defined
statistics time interval.

Management Queue

The average and peak number of
packets waiting in the management
queue during the defined statistics time
interval.
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Statistics

Parameter

Description

Mesh Node Security Stats

Transmitted Packets

The number of packets transmitted
during security negotiations by the
selected mesh access point.

Received Packets

The number of packets received during
security negotiations by the selected
mesh access point.

Association Request Failures

The number of association request
failures that occur between the selected
mesh access point and its parent.

Association Request Timeouts

The number of association request
timeouts that occur between the
selected mesh access point and its
parent.

Association Requests Successful

The number of successful association
requests that occur between the selected
mesh access point and its parent.

Authentication Request Failures

The number of failed authentication
requests that occur between the selected
mesh access point and its parent.

Authentication Request Timeouts

The number of authentication request
timeouts that occur between the
selected mesh access point and its
parent.

Authentication Requests Successful

The number of successful
authentication requests between the
selected mesh access point and its
parent.

Reassociation Request Failures

The number of failed reassociation
requests between the selected mesh
access point and its parent.

Reassociation Request Timeouts

The number of reassociation request
timeouts between the selected mesh
access point and its parent.

Reassociation Requests Successful

The number of successful reassociation
requests between the selected mesh
access point and its parent.

Reauthentication Request Failures

The number of failed reauthentication
requests between the selected mesh
access point and its parent.

Reauthentication Request Timeouts
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Statistics

Parameter

Description

The number of reauthentication request
timeouts that occur between the
selected mesh access point and its
parent.

Reauthentication Requests Successful

The number of successful
reauthentication requests that occur
between the selected mesh access point
and its parent.

Unknown Association Requests

The number of unknown association
requests received by the parent mesh
access point from its child. The
unknown association requests often
occur when a child is an unknown
neighbor mesh access point.

Invalid Association Requests

The number of invalid association
requests received by the parent mesh
access point from the selected child
mesh access point. This state may occur
when the selected child is a valid
neighbor but is not in a state that allows
association.
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Parameter

Description

Mesh Node Security Stats
(continued)

Unknown Reauthentication Requests

The number of unknown
reauthentication requests received by
the parent mesh access point node from
its child. This state may occur when a
child mesh access point is an unknown
neighbor.

Invalid Reauthentication Requests

The number of invalid reauthentication
requests received by the parent mesh
access point from a child. This state
may occur when a child is a valid
neighbor but is not in a proper state for
reauthentication.

Unknown Reassociation Requests

The number of unknown reassociation
requests received by the parent mesh
access point from a child. This state
may occur when a child mesh access
point is an unknown neighbor.

Invalid Reassociation Requests

The number of invalid reassociation
requests received by the parent mesh
access point from a child. This state
may occur when a child is a valid
neighbor but is not in a proper state for
reassociation.

Viewing Mesh Statistics for an Mesh Access Point (CLI)

Use these commands to view mesh statistics for a specific mesh access point using the controller CLI:

» To view packet error statistics, a count of failures, timeouts, and successes with respect to associations
and authentications, and reassociations and reauthentications for a specific mesh access point, enter this

command:

show mesh security-stats AP _name

Information similar to the following appears:

AP MAC : 00:0B:85:5F:FA:F0
Packet/Error Statistics:

x Packets 14,

Rx Packets 19, Rx Error Packets 0

Parent-Side Statistics:

Unknown Association Requests 0
Invalid Association Requests 0
Unknown Re-Authentication Requests 0
Invalid Re-Authentication Requests 0
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Unknown Re-Association Requests
Invalid Re-Association Requests
Unknown Re-Association Requests
Invalid Re-Association Requests

o O O O

Child-Side Statistics:
Association Failures O
Association Timeouts 0
Association Successes 0
Authentication Failures 0
Authentication Timeouts 0
Authentication Successes 0
Re-Association Failures 0
Re-Association Timeouts 0
Re-Association Successes 0
Re-Authentication Failures 0
Re-Authentication Timeouts 0
Re-Authentication Successes 0

To view the number of packets in the queue by type, enter this command:
show mesh queue-stats AP _name

Information similar to the following appears:

Queue Type Overflows Peak length Average length

Silver 0 1 0.000
Gold 0 4 0.004
Platinum 0 4 0.001
Bronze 0 0 0.000
Management O 0 0.000

Overflows—The total number of packets dropped due to queue overflow.
Peak Length—The peak number of packets waiting in the queue during the defined statistics time interval.

Average Length—The average number of packets waiting in the queue during the defined statistics time
interval.

Viewing Neighbor Statistics for a Mesh Access Point

This section describes how to use the controller GUI or CLI to view neighbor statistics for a selected mesh
access point. It also describes how to run a link test between the selected mesh access point and its parent.

Viewing Neighbor Statistics for a Mesh Access Point (GUI)

Step 1
Step 2

Choose Wireless > Access Points > All APs to open the All APs page.

To view neighbor statistics for a specific mesh access point, hover the mouse over the blue drop-down arrow for the
desired mesh access point and choose Neighbor Information. The All APs > Access Point Name > Neighbor Info page
for the selected mesh access point appears.
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Step 3

Step 4

Step 5

This page lists the parent, children, and neighbors of the mesh access point. It provides each mesh access point’s name
and radio MAC address.

To perform a link test between the mesh access point and its parent or children, follow these steps:

a) Hover the mouse over the blue drop-down arrow of the parent or desired child and choose LinkTest. A pop-up
window appears.

b) Click Submit to start the link test. The link test results appear on the Mesh > LinkTest Results page.

¢) Click Back to return to the All APs > Access Point Name > Neighbor Info page.

To view the details for any of the mesh access points on this page, follow these steps:

a) Hover the mouse over the blue drop-down arrow for the desired mesh access point and choose Details. The All APs
> Access Point Name > Link Details > Neighbor Name page appears.

b) Click Back to return to the All APs > Access Point Name > Neighbor Info page.

To view statistics for any of the mesh access points on this page, follow these steps:

a) Hover the mouse over the blue drop-down arrow for the desired mesh access point and choose Stats. The All APs >
Access Point Name > Mesh Neighbor Stats page appears.

b) Click Back to return to the All APs > Access Point Name > Neighbor Info page.

Viewing the Neighbor Statistics for a Mesh Access Point (CLI)

Use these commands to view neighbor statistics for a specific mesh access point using the controller CLI.
* To view the mesh neighbors for a specific mesh access point, enter this command:
show mesh neigh {detail | summary} AP Name

Information similar to the following appears when you request a summary display:

AP Name/Radio Mac Channel Snr-Up Snr-Down Link-Snr Flags State

mesh-45-rapl 165 15 18 16 Ox86b UPDATED NEIGH PARENT BEACON
00:0B:85:80:ED:DO 149 5 6 5 Ox1la60 NEED UPDATE BEACON DEFAULT
00:17:94:FE:C3:5F 149 7 0 0 0x860 BEACON

To view the channel and signal-to-noise ratio (SNR) details for a link between a mesh access point and
its neighbor, enter this command:

show mesh path AP Name

Information similar to the following appears:

AP Name/Radio Mac Channel Snr-Up Snr-Down Link-Snr Flags State

mesh-45-rapl 165 15 18 16 0x86b UPDATED NEIGH PARENT BEACON
mesh-45-rapl is a Root AP.

To view the percentage of packet errors for packets transmitted by the neighbor mesh access point, enter
this command:

show mesh per-stats 4P Name

Information similar to the following appears:
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Neighbor MAC Address 00:0B:85:5F:FA:F0

Total Packets transmitted: 104833

Total Packets transmitted successfully: 104833
Total Packets retried for transmission: 33028

Neighbor MAC Address 00:0B:85:80:ED:D0O
Total Packets transmitted: O

Total Packets transmitted successfully: 0O
Total Packets retried for transmission: 0

Neighbor MAC Address 00:17:94:FE:C3:5F
Total Packets transmitted: O

Total Packets transmitted successfully: 0O
Total Packets retried for transmission: 0O

N

Note  Packet error rate percentage = 1 — (number of successfully transmitted
packets/number of total packets transmitted).
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CHAPTER 8

Troubleshooting Mesh Access Points

This chapter describes troubleshooting information and contains the following section:

* Installation and Connections, on page 181

Installation and Connections

Step 1 Connect the mesh access point that you want to be the RAP to the controller.
Step 2 Deploy the radios (MAP) at the desired locations.
Step 3 On the controller CLI, enter the show mesh ap summary command to see all MAPs and RAPs on the controller.

Figure 54: Show Mesh AP Summary Page

{Cisco Controller) =show mesh ap Summary

AP Name AP Model BVI WAC CERT WAL Hop Bridge Group Mame Enhanced Feature Set
1532MAPZ=DalsyChained AIR=-CAF1532E=A=KS Acide:35:46: 12072 dcide:35c4b:T2i72 @ default N/A
1532RAPL AIR-CAP1S3IZE-A-KI dctdez35:46: 712164 Ac:de:35:46:72:64 B default N/A
1532MAP1 ATR-CAP1532E-A-KS dczdez35:46: Thide dcide:35:d46:71l:d4e 1 default H/A
1524PSRAPL AIR-LAP1S24P5-A-K9 B0:22:be:41:23:008 PR:22:be:41:23:88 @ MESHDEMO1 N/ A
152 2MAP2 ATR-LAPLSZ22AG-A-KS B@:22:he:d2:Te:BB DB:22:be:42:fe:dd 1 MESHDEMO1 N/ A
Number of MESh APS. ccconsaaanssssssssssnsansnanns 3

Number of RAPS.ossssassannnsnn T T 2

Nusber of MAPE..cavssnrsrnuissnnssnnasnnansnnviny 1

Number of FlexsBridge APS......coovssssnsvnnnanas &

Number of Flex+Bridge RAPS. .cccvsssnsnsnnsnnnnnns b |

Number of Flex+Bridge MAPS....svvasaessnnsnnnsnns 1

Step 4 On the controller GUI, click Wireless to see the mesh access point (RAP and MAP) summary.
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Figure 55: All APs Summary Page

All APs

Search by AP MAL Search

Operational Certific:

AP Manme AP MAL AP Up Tinne Admin Status  Status AP Mode Type

iMeshRapl 00:19:30:76:32:72 0d, 2Z2hz2dm25s Enable REG Local MIC

HIRAPL OD:1d:71:0d:e1:00 0d, 2Z2h1Z2m 37 s Enable REG Bridge MIC

HIM& 00:1d:71:0d:d5:00 0d,22h05m D45 Enable REG Bridge |

HIMAPL 00:1d:7L:0cifdi00 0d, 2Z2h o4 mdg s Enable REG Bridge MIC

HIM&RZ 00:1d:FL:0e:f0:00 Nd,22hkh02m 533 Erable REG Bridge MIC

HERAP] 00i:1le:14:45:43:00 0d,05h3Smads Enable REG Bridge MIC 5
HPMAPL OD:1b:dd:a7:78:00 0d, 2Zhodm25s Enable REG Bridge MIC E

Step 5 Click AP Name to see the details page and then select the Interfaces tab to see the active radio interfaces.

The radio slot in use, radio type, subband in use, and operational status (UP or DOWN) are summarized.
* All APs supports 2 radio slots: slot 0—2.4 GHz and slot 1—5 GHz.

If you have more than one controller connected to the same mesh network, then you must specify the name of the
primary controller using global configuration for every mesh access point or specify the primary controller on every
node, otherwise the least loaded controller is the preferred controller. If the mesh access points were previously
connected to a controller, they already have learned a controller’s name.

After configuring the controller name, the mesh access point reboots.

Step 6 Click Wireless > AP Name to check the mesh access point’s primary controller on the AP details page.

Debug Commands

The following two commands are very helpful to see the messages being exchanged between mesh access
points and the controller.

(Cisco Controller) > debug capwap events enable
(Cisco Controller) > debug disable-all

You can use the debug command to see the flow of packet exchanges that occur between the mesh access
point and the controller. The mesh access point initiates the discovery process. An exchange of credentials
takes place during the join phase to authenticate that the mesh access point is allowed to join the mesh network.

Upon a successful join completion, the mesh access point sends a CAPWAP configuration request. The
controller responds with a configuration response. When a Configure Response is received from the controller,
the mesh access point evaluates each configuration element and then implements them.

Remote Debug Commands

You can log on to the mesh access point console for debugging either through a direct connection to the AP
console port or through the remote debug feature on the controller.
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To invoke remote debug on the controller, enter the following commands:

(Cisco Controller) > debug ap enable ap-name
(Cisco Controller) > debug ap command command ap-name

AP Console Access

AP1500s have a console port. A console cable is not shipped with the mesh access point. For the 1550 series
access points, console ports are easily accessible and you need not open the access point box.

The AP1500s have console access security embedded in the code to prevent unauthorized access on the console
port and provide enhanced security.

The login ID and password for console access are configured from the controller. You can use the following
commands to push the username/password combination to the specified mesh access point or all access points:

<Cisco Controller> config ap username cisco password cisco ?

all Configures the Username/Password for all connected APs.
<Cisco AP> Enter the name of the Cisco AP.

<Cisco Controller> config ap username cisco password cisco all

You must verify whether the username/password pushed from the controller is used as user-id and password
on the mesh access point. It is a nonvolatile setting. Once set, a login ID and password are saved in the private
configuration of the mesh access point.

Once you have a successful login, the trap is sent to the Cisco Prime Infrastructure. If a user fails to log on
three times consecutively, login failure traps are sent to the controller and Cisco Prime Infrastructure.

Caution

A mesh access point must be reset to the factory default settings before moving from one location to another.

Hardware Reset Set to Factory Defaults

oS R e S gl;ar configuration on this AP and reset it to factory

Reset AP Now Clear Config 12

z0a711

Cable Modem Serial Port Access From an AP

Commands can be sent to the cable modem from the privileged mode of the CLI. Use the command to take
a text string and send it to the cable modem UART interface. The cable modem interprets the text string as
one of its own commands. The cable modem response is captured and displayed on the Cisco IOS console.
Up to 9600 characters are displayed from the cable modem. Any text that is greater than 4800 characters is
truncated.

The modem commands are only operational on mesh APs that have devices connected to the UART port
originally intended for the cable modem. If the commands are used on a mesh AP that does not have a cable
modem (or any other device connected to the UART), the commands are accepted, however, but they do not
produce any returned output. No errors are explicitly flagged.
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Enter the following command from the privileged mode of the MAP:
ap¢send cmodem timeout-value modem-command

The modem command is any command or text to send to the cable modem. The range of timeout value is 1
to 300 seconds. However, if the captured data equals 9600 characters, any text beyond that is truncated and
the response, irrespective of the timeout value and is immediately displayed on the AP console.

Figure 56: Cable Modem Console Access Command

279050
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Figure 57: Cable Modem Console Access Command

RAP-CH-Ni1f#zend cmodem l=

e Time

[ener _hal]

[forwarder] ; n [pingHelper]
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Caution  The question mark (?) and the exclamation point (!) should not be used in the send ecmodem command. These
characters have immediate interpreted use in the Cisco IOS CLI. Therefore, they cannot be sent to the modem.

Enabling the Cable Modem Console Port

By default, the Cable Modem console port is disabled. This is to prevent users from accessing the console
through their residential cable modem. In the AP1572IC, AP1572EC, and AP1552C model, the cable modem
console is connected directly to the access point. The console port is required for signaling between the AP
and the cable modem. There are two methods to enable the cable modem console port, either through SNMP
or by adding the command to the configuration .cm file on the CMTS.

\}

Note For the AP1572EC, AP15721IC, AP1552C, and AP1552CU, the cable modem must be enabled.

* Enable the cable modem console port through SNMP by entering this command to the IP address of the
cable modem:

Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.8 .



Troubleshooting Mesh Access Points |

. Mesh Access Point CLI Commands

snmpset —-c private IP ADDRESS cmConsoleMode.0 i N

Using the OID, enter this command:

snmpset —-c private IP ADDRESS
1.3.6.1.4.1.1429.77.1.4.7.0 i N

Where IP_ ADDRESS is any IPv4 address and N is an integer, 2 to enable read-write, 1 for read-only,
or 0 to disable.

Example:

snmpset -c private 209.165.200.224 cmConsoleMode.0 1 2

Enable the cable modem console port through the configuration file. The configuration file (with a .cm
extension) is loaded into the cable modem head end. It is pushed to the cable modem as part of the join
process. Enter the following line to the cable modem configuration file:

SA-CM-MIB: :cmConsoleMode.0 = INTEGER: readWrite (2)

Using the OID, enter this line:

SA-CM-MIB: :cmConsoleMode.0 = INTEGER: readWrite (2)

Resetting the AP1572xC/AP1552C Through the Cable Modem

An AP can be reset by entering an SNMP command to the Cable Modem, which resides inside the access
point. For this feature to work, you must enable the cable modem console port.

Reset the AP by entering this snmpset command:

Snmpset -v2c -c public IP ADDRESS 1.3.6.1.4.1.1429.77.1.3.17.0 1 1

Where the IP ADDRESS is the IPv4 address of the cable modem.

Mesh Access Point CLI Commands

You can enter these commands directly on the mesh access point using the AP console port or you can use
the remote debug feature from the controller:
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Mesh Access Point Debug Commands

You can enter these commands directly on the mesh access point using the AP console port or you can use
the remote debug feature from the controller.

* debug mesh ethernet bridging—Debugs Ethernet bridging.

* debug mesh ethernet config—Debugs access and trunk port configuration associated with VLAN
tagging.

* debug mesh ethernet registration—Debugs the VLAN registration protocol. This command is associated
with VLAN tagging.

* debug mesh forwarding table—Debugs the forwarding table containing bridge groups.

* debugs mesh forwarding packet bridge-group—Debugs the bridge group configuration.

Defining Mesh Access Point Role

By default, AP1500s are shipped with a radio role set to MAP. You must reconfigure a mesh access point to
act as a RAP.

Backhaul Algorithm

A backhaul is used to create only the wireless connection between mesh access points.
The backhaul interface by default is 802.11a. You cannot change the backhaul interface to 802.11b/g.
The "auto" data rate is selected by default for AP1500s.

The backhaul algorithm has been designed to fight against stranded mesh access point conditions. This
algorithm also adds a high-level of resiliency for each mesh node.

The algorithm can be summarized as follows:

» A MAP always sets the Ethernet port as the primary backhaul if it is UP; otherwise, it is the 802.11a
radio (this feature gives the network administrator the ability to configure it as a RAP the first time and
recover it in-house). For fast convergence of the network, we recommend that you do not connect any
Ethernet device to the MAP for its initial joining to the mesh network.

» A MAP failing to connect to a WLAN controller on an Ethernet port that is UP, sets the 802.11a radio
as the primary backhaul. Failing to find a neighbor or failing to connect to a WLAN controller via any
neighbor on the 802.11a radio causes the primary backhaul to be UP on the Ethernet port again. A
MAP gives preference to the parent which has the same BGN.

* A MAP connected to a controller over an Ethernet port does not build a mesh topology (unlike a RAP).
* A RAP always sets the Ethernet port as the primary backhaul.

» If the Ethernet port on a RAP is DOWN, or a RAP fails to connect to a controller on an Ethernet port
that is UP, the 802.11a radio is set as the primary backhaul. Failing to find a neighbor or failing to
connect to a controller via any neighbor on the 802.11a radio makes the RAP go to the SCAN state after
15 minutes and starts with the Ethernet port first.
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Keeping the roles of mesh nodes distinct using the above algorithm greatly helps to avoid a mesh access point
from being in an unknown state and becoming stranded in a live network.

Passive Beaconing (Anti-Stranding)

When enabled, passive beaconing allows a stranded mesh access point to broadcast its debug messages
over-the-air using a 802.11b/g radio. A neighboring mesh access point that is listening to the stranded mesh
access point and has a connection to a controller, can pass those messages to the controller over CAPWAP.
Passive beaconing prevents a mesh access point that has no wired connection from being stranded.

Debug logs can also be sent as distress beacons on a nonbackhaul radio so that a neighboring mesh access
point can be dedicated to listen for the beacons.

The following steps are automatically initiated at the controller when a mesh access point loses its connection
to the controller:

* Identifies the MAC address of a stranded mesh access point
* Finds a nearby neighbor that is CAPWAP connected
* Sends commands through remote debug

* Cycles channels to follow the mesh access point

You only have to know the MAC address of the stranded AP to make use of this feature.

A mesh access point is considered stranded if it goes through a lonely timer reboot. When the lonely timer
reboot is triggered, the mesh access point, which is now stranded, enables passive beaconing, the anti-stranding
feature.

This feature can be divided into three parts:
» Strand detection by stranded mesh access point
* Beacons sent out by stranded mesh access point
* Latch the 802.11b radio to a channel (1,6,11)
* Enable debugs
* Broadcast the standard debug messages as distress beacons

« Send Latest Crash info file

* Receive beacons (neighboring mesh access point with remote debugging enabled)

Deployed mesh access points constantly look for stranded mesh access points. Periodically, mesh access
points send a list of stranded mesh access points and SNR information to the controller. The controller maintains
a list of the stranded mesh access points within its network.

When the debug mesh astools troubleshoot mac-addr start command is entered, the controller runs through
the list to find the MAC address of the stranded mesh access point.

A message is sent to the best neighbor to start listening to the stranded access point. The listening mesh access
point gets the distress beacons from the stranded mesh access point and sends it to the controller.

Once a mesh access point takes the role of a listener, it does not purge the stranded mesh access point from
its internal list until it stops listening to the stranded mesh access point. While a stranded mesh access point
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is being debugged, if a neighbor of that mesh access point reports a better SNR to the controller than the
current listener by some percentage, then the listener of the stranded mesh access point is changed to the new
listener (with better SNR) immediately.

End-user commands are as follows:

+ config mesh astools [enable | disable]—Enables or disables the astools on the mesh access points. If
disabled, APs no longer sends a stranded AP list to the controller.

* show mesh astools stats—Shows the list of stranded APs and their listeners if they have any.

* debug mesh astools troubleshoot mac-addr start—Sends a message to the best neighbor of the mac-addr
to start listening.

* debug mesh astools troubleshoot mac-addr stop—Sends a message to the best neighbor of the mac-addr
to stop listening.

* clear mesh stranded [all | mac of b/g radio]l—Clears stranded AP entries.

The controller console is swamped with debug messages from stranded APs for 30 minutes.

Misconfiguration of the Mesh Access Point IP Address

Although most Layer 3 networks are deployed using DHCP IP address management, some network
administrators might prefer the manual IP address management and allocating IP addresses statically to each
mesh node. Manual mesh access point IP address management can be a nightmare for large networks, but it
might make sense in small to medium size networks (such as 10 to 100 mesh nodes) because the number of
mesh nodes are relatively small compared to client hosts.

Statically configuring the IP address on a mesh node has the possibility of putting a MAP on a wrong network,
such as a subnet or VLAN. This mistake could prevent a mesh access point from successfully resolving the
IP gateway and failing to discover a WLAN controller. In such a scenario, the mesh access point falls back
to its DHCP mechanism and automatically attempts to find a DHCP server and obtains an IP address from it.
This fallback mechanism prevents a mesh node from being potentially stranded from a wrongly configured
static IP address and allows it to obtain a correct address from a DHCP server on the network.

When you are manually allocating IP addresses, we recommend that you make IP addressing changes from
the furthest mesh access point child first and then work your way back to the RAP. This recommendation also
applies if you relocate equipment. For example, if you uninstall a mesh access point and redeploy it in another
physical location of the mesh network that has a different addressed subnet.

Another option is to take a controller in Layer 2 mode with a RAP to the location with the misconfigured
MAP. Set the bridge group name on the RAP to match the MAP that needs the configuration change. Add
the MAP’s MAC address to the controller. When the misconfigured MAP comes up in the mesh access point
summary detail, configure it with an IP address.

Misconfiguration of DHCP

Despite the DHCP fallback mechanism, there is still a possibility that a mesh access point can become stranded,
if any of the following conditions exist:

* There is no DHCP server on the network.

* There is a DHCP server on the network, but it does not offer an IP address to the AP, or if it gives a
wrong IP address to the AP (for example, on a wrong VLAN or subnet).
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These conditions can strand a mesh access point that is configured with or without a wrong static IP address
or with DHCP. Therefore, you must ensure that when a mesh access point is unable to connect after exhausting
all DHCP discovery attempts or DHCP retry counts or IP gateway resolution retry counts, it attempts to find
a controller in Layer 2 mode. In other words, a mesh access point attempts to discover a controller in Layer
3 mode first and in this mode, attempts with both static IP (if configured) or DHCP (if possible). The AP then
attempts to discover a controller in Layer 2 mode. After finishing a number of Layer 3 and Layer 2 mode
attempts, the mesh access point changes its parent node and re-attempts DHCP discovery. Additionally, the
software exclusion-lists notes the parent node through which it was unable to obtain the correct IP address.

Identifying the Node Exclusion Algorithm

Depending on the mesh network design, a node might find another node “best” according to its routing metric
(even recursively true), yet it is unable to provide the node with a connection to the correct controller or correct
network. It is the typical honeypot access point scenario caused by either misplacement, provisioning, design
of the network, or by the dynamic nature of an RF environment exhibiting conditions that optimize the AWPP
routing metric for a particular link in a persistent or transient manner. Such conditions are generally difficult
to recover from in most networks and could blackhole or sinkhole a node completely, taking it out from the
network. Possible symptoms include, but are not limited to the following:

* A node connects to the honeypot but cannot resolve the IP gateway when configured with the static IP
address, or cannot obtain the correct IP address from the DHCP server, or cannot connect to a WLAN
controller.

* A node ping-pongs between a few honeypots or circles between many honeypots (in worst-case scenarios).

Cisco mesh software resolves this difficult scenario by using a sophisticated node exclusion-listing algorithm.
This node exclusion-listing algorithm uses an exponential backoff and advance technique much like the TCP
sliding window or 802.11 MAC.

The basic idea relies on the following five steps:
1. Honeypot detection—The honeypots are first detected via the following steps:
A parent node is set by the AWPP module by:
* A static IP attempt in CAPWAP module.
* A DHCP attempt in the DHCP module.
* A CAPWAP attempt to find and connect to a controller fails.
2. Honeypot conviction—When a honeypot is detected, it is placed in a exclusion-list database with its

conviction period to remain on the list. The default is 32 minutes. Other nodes are then attempted as
parents in the following order, falling back to the next, upon failing the current mechanism:

* On the same channel.
* Across different channels (first with its own bridgegroupname and then with default).
* Another cycle, by clearing conviction of all current exclusion-list entries.

* Rebooting the AP.

3. Nonhoneypot credit—It is often possible that a node is not a really a honeypot, but appears to be due to
some transient back-end condition, such as the following:
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» The DHCP server is either not up-and-running yet, has failed temporarily, or requires a reboot.
» The WLAN controller is either not up-and-running yet, has failed temporarily, or requires a reboot.

* The Ethernet cable on the RAP was accidentally disconnected.

Such nonhoneypots must be credited properly from their serving times so that a node can come back
to them as soon as possible.

4. Honeypot expiration—Upon expiration, an exclusion-list node must be removed from the exclusion-list
database and return to a normal state for future consideration by AWPP.

5. Honeypot reporting—Honeypots are reported to the controller via an LWAPP mesh neighbor message to
the controller, which shows these on the Bridging Information page. A message is also displayed the
first-time an exclusion-listed neighbor is seen. In a subsequent software release, an SNMP trap is generated
on the controller for this condition so that Cisco Prime Infrastructure can record the occurrence.

Figure 58: Excluded Neighbor
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Because many nodes might be attempting to join or rejoin the network after an expected or unexpected event,
a hold-off time of 16 minutes is implemented, which means that no nodes are exclusion-listed during this
period of time after system initialization.

This exponential backoff and advance algorithm is unique and has the following properties:

« It allows a node to correctly identify the parent nodes whether it is a true honeypot or is just experiencing
temporary outage conditions.

* It credits the good parent nodes according to the time it has enabled a node to stay connected with the
network. The crediting requires less and less time to bring the exclusion-list conviction period to be very
low for real transient conditions and not so low for transient to moderate outages.

* It has a built-in hysteresis for encountering the initial condition issue where many nodes try to discover
each other only to find that those nodes are not really meant to be in the same network.

* It has a built-in memory for nodes that can appear as neighbors sporadically so they are not accidentally
considered as parents if they were, or are supposed to be, on the exclusion-list database.

The node exclusion-listing algorithm guards the mesh network against serious stranding. It integrates into
AWPP in such a way that a node can quickly reconverge and find the correct network.
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Throughput Analysis

Throughput depends on packet error rate and hop count.

Capacity and throughput are orthogonal concepts. Throughput is one user's experience at node N and the total
area capacity is calculated over the entire sector of N-nodes and is based on the number of ingress and egress
RAP, assuming separate noninterfering channels.

For example, 4 RAPs at 10 Mbps each deliver 40 Mbps total capacity. So, one user at 2 hops out, logically
under each RAP, could get 5 Mbps each of TPUT, but consume 40 Mbps of the backhaul capacity.

With the Cisco Mesh solution, the per-hop latency is less than 10 msecs, and the typical latency numbers per
hop range from 1 to 3 msecs. Overall jitter is also less than 3 msecs.

Throughput depends on the type of traffic being passed through the network: User Datagram Protocol (UDP)
or Transmission Control Protocol (TCP). UDP sends a packet over Ethernet with a source and destination
address and a UDP protocol header. It does not expect an acknowledgement (ACK). There is no assurance
that the packet is delivered at the application layer.

TCP is similar to UDP but it is a reliable packet delivery mechanism. There are packet acknowledgments and
a sliding window technique is used to allow the sender to transmit multiple packets before waiting for an
ACK. There is a maximum amount of data the client transmits (called a TCP socket buffer window) before
it stops sending data. Sequence numbers track packets sent and ensure that they arrive in the correct order.
TCP uses cumulative ACKs and the receiver reports how much of the current stream has been received. An
ACK might cover any number of packets, up to the TCP window size.

TCP uses slow start and multiplicative decrease to respond to network congestion or packet loss. When a
packet is lost, the TCP window is cut in half and the back-off retransmission timer is increased exponentially.
Wireless is subject to packet loss due to interference issues and TCP reacts to this packet loss. A slow start
recovery algorithm is also used to avoid swamping a connection when recovering from packet loss. The effect
of these algorithms in a lossy network environment is to lessen the overall throughput of a traffic stream.

By default, the maximum segment size (MSS) of TCP is 1460 bytes, which results in a 1500-byte IP datagram.
TCP fragments any data packet that is larger than 1460 bytes, which can cause at least a 30-percent throughput
drop.
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CHAPTER 9

Managing Mesh Access Points with Cisco Prime
Infrastructure

Cisco Prime Infrastructure is a complete platform for enterprise-wide WLAN systems management. It provides
a wide range of tools for visualizing and controlling the mesh, including histograms of signal-to-noise ratio,
mesh detail information, mesh access point neighbor and link information, seven-day temporal link information,
and tools to identify and avoid RF interference.

This section addresses the following Prime Infrastructure monitoring capabilities:

For complete details on Mesh Configuration and Monitioring on the Cisco Prime Infrustracture please the PI
Users Guide at the link below. https://www.cisco.com/c/en/us/td/docs/net_ mgmt/prime/infrastructure/3-2/
user/guide/bk CiscoPrimelnfrastructure 3 2 0 UserGuide.pdf
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